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Dashboard Builder
About this document

Dashboard Builder is a BusinessObjects Dashboard and Analytics application
that helps you manage and track your company's performance using analytics
and dashboards, as well as schedule the refresh of metrics, sets, control
charts, Predictive models and analytics.
This documentation helps you to:
• Learn about analytics and dashboards
• Create a dashboard or analytic
• Schedule a refresh
Related Topics

• What is Dashboard Builder?
• Dashboard and analytic applications
• What is an analytic?
• Dashboards
• Creating a corporate dashboard
• Creating an analytic
• Adding a scheduled task in Scheduler

About this document
The Dashboard Builder User Guide provides information on creating analytics
and dashboards using Dashboard Builder, a Dashboard and Analytics
application.
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Dashboard Builder is the Dashboard and Analytics application that allows
you to create dashboards that provide visibility to your business activities
across your organization. Dashboard Builder offers dashboard management
capabilities to help your organization monitor and understand business
activities.
Dashboards can include the following:
• Analytics
• Web Intelligence, Xcelsius and Desktop Intelligence documents
• Crystal Reports
• Adobe Reader PDF documents
• Microsoft Excel spreadsheets
• Microsoft Word documents
• Text files
• Rich text (rtf) files
• Microsoft Powerpoint presentations
• Hyperlinks
You can create, customize and view the following types of dashboards:
•

Corporate dashboards
Corporate dashboards contain analytics created either via InfoView or in
the corporate dashboards menu for public viewing. A corporate dashboard
can have several tabs and sub tabs.

•

Personal dashboard tabs in "My Dashboard"
My Dashboard stores your personal dashboard tabs, which can contain
personal analytics and corporate analytics whose parameters you can to
some extent modify for your view only. A personal dashboard can contain
one or more tabs.

Note:

You cannot copy My Dashboard tabs into corporate dashboards, nor can
you copy corporate dashboard tabs or sub tabs into My Dashboard. However,
you can use the same analytics and objects in all of them.
Related Topics

• Creating a corporate dashboard
• My Dashboard
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My Dashboard
"My Dashboard" is your location in which to build personal dashboard tabs
that offer strategic information at a glance. You can:
• structure "My Dashboard" to follow any management or process
methodology.
• include corporate dashboard analytics to which you have access.

Corporate Dashboards
Corporate dashboards share vital information across a large community or
to specific groups of people. Corporate dashboards can be easily adapted
to fit management and information-sharing philosophies.
Are corporate dashboards secure?

Some ways to control access to data in a corporate dashboard:
•

•
•

At the folder level: Corporate dashboards are stored in the InfoView "Public
Folders". Administrators can limit access to a folder in the folder's access
settings or in account settings for individual users or user groups.
Via user rights: Only those with specific edit rights can edit corporate
dashboards.
Access to universe data: In Designer, you set security access rights to
the entire universe or sections of the universe.

To print a dashboard
Tip:

To print a dashboard containing lots of objects, it is recommended that you
change the printer settings to Landscape for the best appearance.
1. In a dashboard, click Print Preview.
The print preview panel appears, with print options and a preview of the
dashboard tab or tabs that will print.
2. In the print preview panel, select one of the following options:
• Current Tab, to print just the tab you are currently viewing. This is the
default option.
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•

All Tabs, to print all of the tabs and sub tabs in the dashboard you
are currently viewing

3. Click Print.
Each dashboard tab will be printed on one page.
Note:

The content of the dashboard will be adjusted to fit into one page, therefore
items can appear smaller.
The print preview will reset the dashboard view to the default view. For
example, a dashboard with a speedometer loads the data for the slice
California for year 2007 by default. The user goes ahead and changes
the slice to Texas and moves the slider to year 2005. If the user clicks
Print Preview, the data of Texas for year 2005 will not be loaded. The
data of California in the year 2007 loads. The user can choose to
change the slice to Texas in the print page and click Print.

Configuring dashboards
Creating a corporate dashboard
A good dashboard can inform and motivate, as well as define strategies.
1. Gather the following information:
• A list of the information that you want the dashboard or dashboard tab
to transmit. If you are creating a corporate dashboard, analyze your
audience to determine the information they need. If you have a lot of
information, consider creating categories of information and creating
a tab in the dashboard for each category.
• A list of the content that you want to use. Analytics can include
speedometer gauges, strategy maps, Web Intelligence or Desktop
Intelligence Reports or Crystal Reports.
• A rough sketch of how you want to organize analytics on the dashboard
tabs and sub tabs. More information is not always best, and a cluttered,
crowded dashboard is counter-productive.
• A list of data security issues for corporate dashboards: What data is
appropriate for your audience? How much detail do you want for them
to see?
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2. Do one of the following:
• In InfoView, do one of the following create a corporate dashboard:
• Click Open > Dashboard and Analytics then the new link under
"Corporate Dashboards".
• Click Dashboards > Create Corporate Dashboard.
• Click Document List > New > Corporate Dashboard.
Note:

Anyone who has access to corporate dashboards can see the changes
you make.
3. Type a name for the corporate dashboard.
4. Specify the folder in which you want to save the dashboard.
Save personal dashboards to your personal folders and corporate
dashboards to a folder in "Public Folders".
5.
6.
7.
8.

Select a category.
Click OK.
To edit the dashboard, click Edit dashboard.
Click one of the following:
• Save to apply the new definition or changes you made.
• Cancel to cancel any changes entered and return to the previously
saved version.
• Exit Edit Mode to leave the edit mode. If you did not save your
changes, the modifications made since the last Save action are
cancelled.

Related Topics

• Configuring a dashboard tab or sub tab
• My Dashboard
• Corporate Dashboards
• Adding tabs and sub tabs to dashboards
• Dashboard properties

Configuring a dashboard tab or sub tab
The following process applies to:
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•
•

"Corporate Dashboards" tabs and sub tabs
"My Dashboard" tabs

1. In My Dashboard or Corporate Dashboards, select the dashboard tab or
sub tab that you want to edit.
2. Click Edit Dashboard.
The edit toolbars for the dashboard objects and the Analytic Toolbox
appear.
Note:

You can only edit corporate dashboards if you have the appropriate edit
rights, or if the corporate dashboard is one that you created. If you edit
a corporate dashboard, the changes are visible to everyone viewing it.
3. To configure the properties click the arrow next to the dashboard, tab or
sub tab title and select Properties.
4. Select the layout style.
The "Analytic Toolbox" appears.
5. In the "Analytic Toolbox", select and drag analytic objects to the layout
area. Resize and fit them according to the preferred dashboard design.
Note:

Analytics that you drag into and edit in the dashboard tabs are saved on
the Central Management Server (CMS) as part of the dashboard. Analytics
created via InfoView using Dashboard Builder are saved as independent
InfoObjects on the CMS.
6. Add tabs or sub tabs to the dashboard as necessary.
7. Click one of the following:
• Save to apply the new definition or changes you made to the
dashboard.
• Cancel to cancel any changes entered in the dashboard and return
to the previously saved version.
• Exit Edit Mode to leave the edit mode. If you did not save your
changes, this action cancels the modifications made since the last
Save action.
Related Topics

• Adding tabs and sub tabs to dashboards
• Modifying the layout in a dashboard
• Creating a corporate dashboard
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• The analytic toolbox in the dashboard edit mode and in the Compound
analytic
• Dashboard properties

Adding tabs and sub tabs to dashboards
You can add as many tabs to a personal dashboard and add as many tabs
and sub tabs to corporate dashboards as you need.
This process applies to tabs in "My Dashboard" and tabs and sub tabs
"Corporate Dashboards".
1. In "My Dashboard" or a corporate dashboard, click Edit Dashboard.
2. Do one of the following:
• To create a "My Dashboard" tab, click Add a new tab.
• To create a "Corporate Dashboards" tab or sub tab, click Add a new
tab.
A cursor appears.
3. Type a name and press Enter.
You can change the name at any time in edit mode by clicking the arrow
next to the tab name and selecting Rename.
4. Configure the tab or sub tab.
5. Click Save to save your edits.
6. If you are done modifying the dashboard, click Exit Edit Mode.
Related Topics

• Configuring a dashboard tab or sub tab

Modifying the layout in a dashboard
This process applies to dashboard tabs and sub tabs in My Dashboard and
Corporate Dashboards.
•

In the dashboard you are editing, select the layout style:
• To place objects on a dashboard without using any specific layout
format, select the "Freeform" layout.
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•
•

To use a pre-defined layout, select the "Template" layout. You can
select column, row, or a mixed column/row layout.
To construct a column-structured dashboard, select the "Docking"
layout.

Note:

When you change the layout of a dashboard that contains analytics, the
analytics are rearranged to fit the new layout mode.
Related Topics

• Configuring a dashboard tab or sub tab
• Configuring the display options of a dashboard analytic
• Working with a dashboard or Compound analytic in Freeform layout mode
• Modifying a dashboard in Template layout mode

Working with a dashboard or Compound analytic in Freeform
layout mode
The "Freeform" layout mode allows you to place objects in a dashboard tab
or sub tab or Compound analytic without using any specific layout format.
In the "Freeform" mode, you can use the grid options to align objects.
1. In the dashboard or Compound analytic edit mode, select Freeform from
the "Layout" list.
The "Analytic Toolbox" appears on a blank layout area. Click Toolbox to
deactivate or activate the "Analytic Toolbox".
Note:

If you switch to "Freeform" from another layout mode, any objects on the
layout area remain in their original positions.
2. To activate a grid, select from the "Grid size" dropdown list one of the
following grid sizes:
• Small
• Medium
• Large
When you select a grid size, grid lines appear on the layout area. If you
do not want a grid, select None.
3. Activate Snap to grid to make objects in the layout area adhere to the
grid lines.
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4. To select objects, drag them from the "Analytic Toolbox" to the layout
area.
You can resize and move the objects.
5. When you are done working on the layout, do the following:
• If you are creating a dashboard tab or sub tab, click Save.
Note:

If at any time during the process you decide that you do not want to
keep the dashboard changes as of the last save action, click Cancel.
The dashboard appears in view mode without the modifications.
•

If you are creating a Compound analytic, click OK.

Related Topics

• Expanded toolbar actions on analytics
• Adding analytics to dashboards
• The analytic toolbox in the dashboard edit mode and in the Compound
analytic
• Adding tabs and sub tabs to dashboards
• Configuring the display options of a dashboard analytic
• Compound analytic

Modifying a dashboard in Template layout mode
The Template layout mode offers several layout formats for dashboard
objects.
1. In the dashboard edit mode, select Template from the "Layout" list.
2. Select a template from the "Predefined Templates" list.
Note:

Switching to "Template" from another mode affects the dashboard in the
following manner:
• When you switch from "Freeform" mode, the objects, if they are not
in any particular order, are separated into columns. When you select
a template, the dashboard objects are moved to fit rows and columns
in the template you select.
• If you switch from "Docking" mode and select a template, the
dashboard objects shift to fit the cells in the template.
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•

•

If you have more than objects than available placeholders in the
selected predefined template, the extra analytics are appended to the
bottom of the dashboard.
Empty spots can occur when you switch to a template, or between
templates. Rearrange the analytics as necessary.

3. To have the dashboard rows adjust to the height of the browser window
when it is enlarged or reduced in size, activate Scale height.
4. To have the dashboard columns adjust to the width of the browser window
as it is enlarged or reduced in size, activate Scale width.
Note:

Scale width and Scale height are only available in Template mode.
5. If you want to split an empty cell in two, click one of the following icons
from the cell toolbar:
Option

Description

"Split component
vertically"

If you select this option, the cell splits into cells that are
side by side.

"Split component
horizontally"

If you select this option, the cell splits to have one cell
above the other.

Note:

The options are only available in Template mode.
6. When you are done working on the dashboard, click Save.
Note:

If at any time during the process, you decide that you do not want to keep
the dashboard changes as of the last save action, click Cancel. The
dashboard reverts to the last saved version of the dashboard.
Related Topics

• The analytic toolbox in the dashboard edit mode and in the Compound
analytic
• Working with a dashboard or Compound analytic in Freeform layout mode
• Configuring the display options of a dashboard analytic
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Configuring the display options of a dashboard analytic
1. Select a dashboard tab or sub tab and click Edit Dashboard.
2. In the title bar of the dashboard analytic you want to edit, click the "edit"
icon.
3. Select the Layout tab.
4. Choose from the following options:
Option

Description

A window inside Activate this option to have the analytic appear as an
of a tab
object in the tab.
A link, so only Activate this option to have the analytic appear as a
the name is visi- linked object that when you click it appears full size.
ble
When you select this option, the Show window
border and Show expanded bar options are unavailable.
Note:

When you click on the link in a dashboard that contains a Viewer analytic, the link's destination opens
in the Viewer.

Show window
border

Activate this option to add a border around an analytic.

Show expanded Activate this option so that the title of the dashboard
bar
object becomes an active link that, when clicked,
enlarges the analytic object to full browser screen.

5. Click OK to save your configuration and return to the dashboard layout.
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Renaming a dashboard tab or sub tab
1. From My Dashboard or Corporate Dashboards, select the tab or sub tab
that you want to edit.
2. Click Edit Dashboard.
3. Click the arrow next to the title that you want to change.
4. Select Rename.
The name field is activated.
5. Type the new name and press Enter.
6. When you have finished changing the dashboard, click Save > Exit Edit
Mode.

Moving dashboard tabs and sub tabs
1. From My Dashboard or Corporate Dashboards, select the dashboard or
dashboard page that you want to edit.
2. Click Edit Dashboard.
3. Select the dashboard tab or sub tab and drag it to the new location.
Note:

To move a Corporate Dashboard sub tab to another tab, drag and drop
it on the dashboard tab.
4. When you have finished making changes, click Save > Exit Edit Mode.

Copying a corporate dashboard, tab or sub tab
To create a corporate dashboard tab configuration similar to an existing one,
you can save time by making a copy of the existing dashboard, and then
renaming and modifying the copy.
For example, you can create a standard corporate dashboard welcome tab
that includes the corporate logo, document lists, and some common
indicators.
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Note:

When you copy a corporate dashboard tabs and sub tabs, all of the analytics
in it are also copied. The sub tab hierarchy in a copied tab is also duplicated.
1. Select from "Corporate Dashboards" the dashboard, tab or sub tab that
you want to copy.
2. Click Edit Dashboard.
3. Click the arrow next to the title of the tab you want to copy, and select
Copy.
A copy of the object appears to the right of the existing objects with the
title appended with an edition number. For example, if you make a copy
of the 'Sales' tab, the title of the copy is 'Sales(1)'.
4. Optionally, rename the item
5. When you have finished changing the dashboard, click Save > Exit Edit
Mode.
Note:

You can recreate a dashboard tab using dashboard objects in the "Existing
Analytics" category in the analytic toolbox. Select the item, and then drag
and drop it in the dashboard layout.
Related Topics

• Renaming a dashboard tab or sub tab
• The analytic toolbox in the dashboard edit mode and in the Compound
analytic

Deleting a dashboard, tab or sub tab
This procedure applies to your "My Dashboard" tabs and "Corporate
Dashboards" dashboards, tabs and sub tabs.
1. From My Dashboard or Corporate Dashboards, select the item that you
want to delete.
2. Click Edit Dashboard.
3. Click the arrow next to the item's title and select Delete.
4. In the confirmation panel, click Yes.
The item disappears.
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5. When you have finished changing your dashboard, click Save > Exit Edit
Mode.

The analytic toolbox in the dashboard edit mode and
in the Compound analytic
The "Analytic Toolbox" offers the following analytic categories from which
you can drag and drop analytics onto your dashboard tabs and sub tabs and
Compound analytic layout:
•

"Analytic Catalog"
This category contains pre-defined analytics that you can apply to your
data.

•

"Analytics Services"
This category contains Dashboard Builder interface components.

•

"Corporate Analytics"
This category contains analytics used in the dashboards in your Corporate
Documents list, organized in folders and categories.

•

"Existing Analytics"
This category contains all analytics displayed in corporate dashboards,
organized by dashboard.
Note:

You cannot copy corporate dashboards into My Dashboard tabs.
•

"List of Analytics"
This category contains the analytics that you saved to your personal and
corporate list files, and that are in your InfoView Inbox.

•

"New Analytic"
This category contains the list of pre-defined analytic templates that you
can customize to display your data.

Tip:

Enlarge or reduce the size of the toolbox using the lower right-hand corner.
To activate or deactivate the toolbox, click Toolbox in the dashboard menu
bar.
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Related Topics

• Compound analytic
• Creating a corporate dashboard

Dashboard properties
To display the properties menu for a dashboard, tab or sub tab in the
dashboard edit mode, click the arrow next to the dashboard name, tab or
sub tab title. Configure the following properties:
•

the help URL
Type or copy in the text box the default help URL.
By default, the dashboard home tab opens the Dashboard Builder online
help.

•

Style sheet
You can select a style sheet for a dashboard. You set the default option
in the InfoView preferences.
Note:

Dashboard's inherit their style from the style sheet selected in the InfoView
preferences. Corporate dashboard sub tabs inherit their style from their
parent corporate dashboard tabs.

Analytics in dashboards
Analytics and dashboards
In Dashboard and Analytics, analytics are documents into which you insert
the data that you want to view via a dashboard. Analytics can be based on
Web Intelligence, Crystal Report or Desktop Intelligence queries, or display
metric, goal, or universe data.
There are two methods you can use to work with analytics in dashboards:
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•

•

Create an analytic via InfoView, save it to a public or private folder on the
Central Management Server, schedule its refresh in Dashboard Builder
> Scheduler, and then insert it into one or more dashboards.
Create an analytic in a dashboard, whereupon it is saved as an embedded
object in the dashboard.
Note:

You can use Web Intelligence, Crystal Report or Desktop Intelligence
reports and modify their queries from within a dashboard, however you
cannot create actual queries in dashboards.
The information displayed by analytics in dashboards is protected at the data
source.
To modify an analytic in dashboard edit mode, click the edit icon on the
analytic toolbar.
Related Topics

• Configuring the Web Intelligence report appearance in a dashboard
• Configuring the Crystal Report appearance in a dashboard

Adding analytics to dashboards
A dashboard is composed tabs that contain analytics. These analytics provide
key information. You can add to dashboards analytics saved on the Central
Management Server (CMS) or embedded in other dashboards.
1. Do one of the following:
• In My Dashboard, open an existing tab or create a tab.
• In Corporate Dashboards, open an existing dashboard or create a
dashboard tab or sub tab.
2. Click Edit Dashboard.
3. In the "Analytics Toolbox", navigate to the analytic you want to add:
• If you want to insert an analytic from the CMS, select it from the "List
of Analytics", "Corporate Analytics" or "Existing Analytics" categories.
• If you want to insert a new analytic and customize it via the dashboard,
select it from the "Analytics Catalog" or "New Analytics" categories.
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Note:

Analytics selected from these categories and configured within a
dashboard are saved as embedded objects in the dashboard, not as
independent InfoObjects on the CMS. Embedded objects are always
refreshed on open. It is more efficient to use InfoObjects on which you
have scheduled a refresh. See the section on Scheduler in the
Dashboard Builder documentation.
4. Resize and move the analytic as necessary in the dashboard.
5. When you have finished changing the dashboard, click Save > Exit Edit
Mode.
Note:

To quickly add a CMS analytic to a new or existing My Dashboard page,
click Add to My Dashboard in the analytic view mode.
Related Topics

• The analytic toolbox in the dashboard edit mode and in the Compound
analytic
• Analytics and dashboards

Expanded toolbar actions on analytics
When you click the analytic's title in a dashboard or view an analytic directly
from the personal or corporate folders, the analytic expands to fit the full
page, and the expanded toolbar appears.
Note:

Access to the expanded toolbar can be activated and deactivated in the
analytic edit mode.
You can perform the following actions on analytics:
• Add to My Dashboard
Click this link to add the analytic to a My Dashboard tab.
•

Edit
Click this link to enter the analytic edit mode.
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Note:

When you edit an analytic that is stored on the Central Management
Server, you are editing all occurrences of the analytic in all dashboards
in which it appears.
•

Save
Click this link to save the analytic.
Note:

Embedded dashboard analytics cannot use this action. Because they
were created directly in the dashboard, they are only populated with data
when the dashboard is opened and only saved as part of the dashboard.
•

Save As
Click Save As to save the analytic for the first time, or to save it to a
different location.

Configuring the Crystal Report appearance in a
dashboard
You can apply the following options to a Crystal Report on a dashboard:
Category

Viewer

28

Option

Effect on the report

Parts Viewer

Only the first part of the report is
visible.

Page Viewer

The entire report appears in the
default viewer.

%

You can view by 25%, 50% or
100%
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Category

Option

Effect on the report

Custom zoom level

If you select the Custom Zoom
Level option, specify a zoom level.

On Demand

The report content is refreshed
when the report is opened.

Last Instance

The report data is from the last instance that the report was opened.

Latest Instance By
User

The report data is from the last instance that the report was opened
for a specific user.

Default Report Part

The report opens to the home object that you defined in the Report
Part Viewer.

Zoom level

Report content

The report opens to the report part
that you specify.
Locate the information for this option in the report's "Report Options"
dialog box.

Report part
settings

Specific Report Part
The Object Name option is the
• Object Name
name of the report object that you
• Data Context
want to use as the destination object.

To set the Data Context option,
enter the data context that you want
to use in the destination object.
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For information on report parts and the Report Part Viewer, see the Crystal
Reports documentation.

Configuring the Web Intelligence report appearance
in a dashboard
You can control how a Web Intelligence report appears in a dashboard. Once
you have dragged and dropped a report onto a dashboard, you can configure
the view of the entire report or just one part of the report.
• To select a part of the Web Intelligence report right-click the part and
select Select this report part. While viewing the report part, you can edit
its view by clicking the Edit icon.
• To unselect a report part, right-click the part and select Unselect this
report part.
The entire report appears.
You can apply the following options:
Option

Effect on the report

The report is displayed with a toolbar that includes all
Display full report options. For information on these options, see the Web
Intelligence documentation.

Display report in
compact mode

Display specific
report part

The report is displayed with a compact toolbar, the
options of which are determined by the user's rights.
This saves space in the display of your report.
If you have selected a report part, this option is activated by default, and the part's ID appears in the text box.
You can use this ID in other applications.
Note:

This option is not valid for the full report display.
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Using a Navigation List on a dashboard tab
A Navigation List analytic when used with the Viewer analytic allows you to
maximize the space on a dashboard tab by acting as an active 'table of
contents'.
1. In the dashboard edit mode, click Toolbox to activate the "Analytic
Toolbox".
2. From the "New Analytic" category, drag Navigation List to the dashboard
layout area.
3. From the "New Analytic" category, drag Viewer to the dashboard layout
area and resize as necessary using the lower, right-hand corner resize
icon.
4. Drag an analytic from any category in the "Analytic Toolbox" to the
Navigation List.
Remember:

If you are editing the dashboard in "Docking" mode, hold down the control
button to use the mouse for dragging and dropping objects into the
Navigation List.
When you select an item in the navigation list, it appears in the viewer.
5. In the Navigation List title bar, click the edit icon.
The content and layout panel appears.
6. In the "Content" tab:
• Optionally, create folders in which to organize the analytics.
• Organize Navigation List items.
• Edit the properties of the Navigation List items, including analytic
properties.
• Delete items from the Navigation List.
• Change the name of an item.
7. In the "Layout" tab, type a title and description, and select the display
options and style sheet.
8. Click OK to save the content and layout configuration.
For information on configuring analytic properties, see the Dashboard
Builder documentation.
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Related Topics

• The Viewer analytic in dashboards
• Configuring the display options of a dashboard analytic

The Viewer analytic in dashboards
By default objects called from an analytic link open to occupy the full
dashboard space. The Viewer analytic offers a way to display, in the size
you determine, objects called from analytics via analytic links that use
openAnalytic variables.
For example, in a dashboard tab that contains a Viewer, when you select in
a Metric Tree a box title that contains a link, the destination analytic appears
in the Viewer. This allows you to see the Metric Tree itself and the destination
analytic side by side.
In another example, you created a Web Intelligence report and you want to
select linked items in the report, and have the linked document appear in
the Viewer.
The Viewer analytic is particularly useful with the Navigation List analytic.
You use the Navigation List as a 'table of contents' and the Viewer as the
viewing portlet. This saves you dashboard space.
You find the Viewer analytic in the dashboard edit mode, in Toolbox > New
Analytic. To add it to a dashboard, drag Viewer to the dashboard layout
area and resize as necessary using the lower, right-hand corner resize icon.
Related Topics

• Using a Navigation List on a dashboard tab
• OpenAnalytic variables used in goal, metric and universe query analytics
• Configuring the box title in a Metric Tree analytic

Sending information to the Viewer analytic in a dashboard using
openAnalytic
Using the openAnalytic syntax, you can send information from the following
documents saved on the Central Management Server (CMS) to a Viewer
analytic on a dashboard:
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•
•
•
•
•

Web Intelligence reports
Crystal Reports
Text analytic
Desktop Intelligence reports
Web page analytic

Sample syntax:
<a href='http://[WEB APPLICATION LOCATION]
aa-open-inlist.jsp?url=openAnalytic.jsp?
DocumentName=text+analytic&RepositoryType=C
&RepositoryName=PM&DocumentExt=afd
&DocumentId=AQ74dXHxW59HlHvZivNsypI&mode=full
' target='hiddenFrame'>[LINK NAME IN DASHBOARD]</a>
The key items in the sample are aa-open-inlist.jsp and target='hid
denframe'.
1. In a text editor, copy and paste the sample syntax.
2. Replace [WEB APPLICATION LOCATION] with the web application
location after http://.
For example: http://<server>:<port>/PerformanceManage
ment/jsp
3. Enter the correct information after the variables.
4. Replace [LINK NAME IN DASHBOARD] with the name of the link as you
want it to appear.
5. Copy and paste the text in the following location:
• For a Web Intelligence, Crystal Report or Desktop Intelligence report,
copy the text in the cell of the query and then run a report.
• For a Text analytic, go to the edit mode and paste the text in the "Enter
text or HTML to display" text box and select html. Save the analytic
in the public folders.
• For a Web page analytic, go to the edit mode and in the "Content" tab
paste the text in the "Enter the web page URL" text box and click OK.
In the "Layout" tab, select from the "Display as" section A link, so
only the name is visible.
6. In InfoView, go to Dashboards > Create Corporate Dashboard.
7. Enter the title, select a public folder, and click OK.
8. Click Dashboards > Organize Corporate Dashboards, and select your
dashboard.

SAP BusinessObjects Dashboard Builder User Guide

33

2

2

Dashboards
Analytics in dashboards

9. Click Edit Dashboard.
10. From the "Analytic Toolbox", expand the "Corporate Analytics" list to find
your report, and drag it to the dashboard layout.
11. From the "Analytic Toolbox", expand the "New Analytic" list, and drag the
"Viewer" analytic from the list to the dashboard layout.
12. Click Save, then Exit Edit Mode.
Click on any linked item in the report and the destination appears in the
viewer.

Content linking in dashboards
Content linking allows you to send information from an Xcelsius analytic, the
source, to the following target analytics in a dashboard:
• Xcelsius analytics
Xcelsius analytics defined as target analytics receive information from
the source analytic and utilize this information as an input to variables
defined in the Xcelsius model.
•

Web Intelligence, Crystal, and Desktop Intelligence Reports
When the user interacts with an Xcelsius analytic defined as the source
analytic, the dynamic values are passed automatically to the prompts in
the Crystal, Web Intelligence, or Desktop Intelligence Reports selected
as the target analytics within the Dashboard Builder tab or sub tab.
Note:

If you link to a report that contains no prompts, the target analytic is not
affected by a content link, so the data will not change.
The content linking in a dashboard can be configured in the edit mode from
the edit panel of a source or target document, or from the Content Linking
link on the dashboard toolbar.

To set a content link between analytics in a dashboard
You must set up dynamic communication between Xcelsius, Web Intelligence,
Crystal, and Desktop Intelligence Report analytics that are placed on a
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Dashboard Builder tab or sub tab. Crystal and Desktop Intelligence report
analytics are placed on a Dashboard Builder tab or sub tab. At run time, a
source Xcelsius analytic sends information to target Xcelsius and Web
Intelligence, Crystal and Desktop Intelligence Report analytics. Targets use
the information sent by the source analytic as parameter values. These
parameter values are used as input for prompts in the case of Web
Intelligence, Desktop Intelligence, or Crystal Reports, or in the data
spreadsheet range of an Xcelsius model.
Remember:

An Xcelsius analytic used as a source document has to be configured with
a Portal Provider Connection. An Xcelsius analytic used as a target document
has to be configured with the Portal Consumer Connection. For more
information on configuring Portal Connections in an Xcelsius analytic, consult
the Xcelsius User documentation.
To facilitate dynamic communication between an Xcelsius source and other
target analytics (except Xcelsius targets), the designer must use the FSCom
mand component. The command text name of the FSCommand component
must be set to queryparams. The designer will construct the information in
the parameters section as opendocument syntax. This information is sent
by the XCelsius source to the target analytics (Web Intelligence, Crystal, and
Desktop Intelligence reports), and is substituted as prompt values.
1. In the dashboard edit mode from the Analytic Toolbox, drag the source
Xcelsius analytic to the dashboard layout.
2. Drag one or more target analytics to the dashboard layout.
Note:

The following target analytics use content linking:
• Xcelsius analytics
• Crystal Reports
• Web Intelligence Reports
• Desktop Intelligence Reports
3. Do one of the following:
• From the dashboard toolbar, click Content Linking.
The Content Linking panel appears, with a dropdown list from which
you select the source analytic.
•

From an analytic edit toolbar, click the edit icon, and select the Content
Linking tab.
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The content linking tab appears with the analytic automatically selected
as the source analytic.
4. If the source analytic is not already selected, choose one from the
dropdown list.
The Target Analytics list changes to list the analytics to which the source
analytic can link.
5. Select the target analytics.
6. Click OK.
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The data in an analytic can come from a metric, goal, or a universe-based,
Web Intelligence, Desktop Intelligence, Crystal Reports or Xcelsius query.
You create and add analytics to your dashboards to display data in a
meaningful and efficient manner.
Business Objects offers you pre-built analytic templates delivered with its
Dashboard and Analytics applications.

Analytics based on a single metric or goal
You can create the following analytics using a single metric or goal:
• Gauge
• Interactive Metric Trend
• Pareto Chart

What is a universe query?
Universe queries map to data from relational and OLAP data sources, and
can include goals from other data sources via a universe, and show, in
addition to metrics, goals and tolerance levels.
For information on customizing universes from which to create query-based
metrics, see the Designer documentation.

Data for universe queries
Analytics can use data obtained from querying any Business Objects universe
that has been exported in Designer.
Universes for these types of queries do not have to be imported in Dashboard
and Analytics Setup.
Any security conditions created to these universes in Designer are carried
over when you create an analytic. Objects with security restrictions in the
universe, for example, are not visible in the Query Panel.
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Defining a universe query for an analytic
1. In the data selection section of the analytic edit panel, select Define
Query.
2. In the "Define query" panel, select the universe on which you want to
base your query.
If you do not see your universe listed, click Refresh List. If it still does
not appear, click Search and migrate to it.
3. Select a universe object and click >> to add it to the "Result Objects" list
box.
Filters are automatically added to the "Query Filters" list box. To remove
items from the list box, click <<.
4. Click OK to save.
The analytic edit panel reappears.
Related Topics

• Defining the display data for a universe query in the Bubble, Pie and Radar
analytics
• Configuring a Gauge analytic using a metric, goal or universe query
• Configuring a Bubble Chart analytic
• Configuring a Pie Chart analytic
• Configuring a Radar Chart analytic
• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries
• Configuring a Pareto Chart analytic
• Configuring the Metric Tree analytic properties

Defining a filter for analytics that use universe
queries
Before you can do the following steps, you need to be in the analytic edit
panel, have selected Universe Query from the "Select Data to Display" list,
and defined the universe query.
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A filter refines the list of data displayed. This is useful when the universe you
are querying contains a lot of data.
1. To add a filter to the analytic, click Add under "Analytic Filter".
If you are editing an existing filter, select it in the "Analytic Filter" list box,
and click Edit.
2. In the "Filter Creation" panel, select a dimension from the "Result Object"
list.
3. Select a dimension from the "Secured Dimension" list.
4. Select Use all slices when displaying this analytic to allow all users
to see all slices associated with the metric.
If you do not want users to see the slices, select Display nothing.
5. Click OK.
The filter appears in the "Analytic Filter" list box.
To delete a filter, select it in the "Analytic Filter" list box and click Remove.
Related Topics

• Defining a universe query for an analytic
• Defining the display data for a universe query in the Bubble, Pie and Radar
analytics

Defining the display data for a universe query in the
Bubble, Pie and Radar analytics
Before you can do the following steps, you need to be in the analytic edit
panel, have selected Universe Query from the "Select Data to Display" list,
and defined the universe query.
1. If you are configuring:
• a Pie chart, select the measure you want to display.
• a bubble or radar chart, select one primary measure and one or more
secondary measures.
2. Select a dimension from the "Dimension for X-axis and slider" list.
3. Select a dimension for the slice list.
4. Optionally, add filters.
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Related Topics

• Defining a filter for analytics that use universe queries
• Configuring a Bubble Chart analytic
• Configuring a Pie Chart analytic
• Configuring a Radar Chart analytic

Analytic display modes
The display formats are:
•
•
•
•

SVG – Scalable Vector Graphics format. This format is less interactive
than the applet.
Applet – The Java Applet allows interactive editing of the analytic.
Flash – Macromedia Flash provides a more interactive interface, and a
zero footprint.
HTML – The HTML display allows you to provide accessibility for
508-compliant analytics.

The display modes for the analytics are shown in the following table.
Analytic

SVG

Applet

Flash

HTML

Alerts

X

Bubble chart

X

Control chart

X

Curve fitting

X

Frequency histogram

X

Gauge

X

Goal

X

X

X

Goal subscriptions

X

Goal-based influencer detail
Individual list

DHTML

X
X
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Analytic

SVG

Influencer detail

X

Influencer gains chart

X

Interactive metric trend

X

Key influencers

X

Applet

Lag plot

Flash

HTML

X

X

X

Map

X

Membership

X

Metric forecaster

X

X
X

Metric list

X

Metric tree

X

Metrics overview

X

X

Migration

X

X

Model gains chart

X

Multi-set same time events

X

X

Navigation list

X

Normal probability

X

Pareto

X

Pie chart

X

Profiler
Radar chart
Scorecard
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Analytic

SVG

Applet

Smoothing

Flash

HTML

DHTML

X

Strategy Map

X

Text

X

Variable profile box plot

X

Visual data counts

X

X

Web page

X

Creating an analytic
You create analytics to visualize performance levels and trends on specific
data. The data can originate from single metrics or goals, Predictive models,
sets stored on the Performance Manager repository or ad hoc queries on a
universe.
You can create analytics in the following ways:
•
•
•

via InfoView
via Dashboard Builder
Create an analytic directly in a dashboard, whereupon it is saved as an
embedded object in the dashboard.
Note:

You can use Web Intelligence, Crystal Report or Desktop Intelligence
reports and modify their queries from within a dashboard, however you
cannot create actual queries in dashboards.
Related Topics

• What is an analytic?
• Creating an analytic via InfoView
• Creating an analytic via Dashboard Builder
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Creating an analytic via Dashboard Builder
You create analytics from within Dashboard Builder on the Create New
Analytic page.
1. In InfoView, go to Open > Dashboard and Analytics > Dashboard
Builder > Create New Analytic.
The analytic types are listed by category.
2. Select a category.
The analytics in the selected category appear on the right.
3. Select an analytic.
For information on configuring a specific analytic, refer to its section in
the Dashboard and Analytics documentation.
Related Topics

• Saving an analytic as a document
• Emailing an analytic
• Adding analytics to dashboards

Creating an analytic via InfoView
You can create analytics directly in InfoView.
1. On the InfoView home page, go to Document List > New > Analytic.
The analytic types are listed by category.
2. Select a category.
The analytics in the selected category appear on the right.
3. Select an analytic.
For information on configuring a specific analytic, refer to its section in
the Dashboard Builder documentation.
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Creating an analytic based on an existing analytic
You can edit an existing analytic based on universe queries, metrics, and
goals to select a different data source and save it as a new analytic.
Note:

You cannot change the data source of analytics based on Web Intelligence,
Crystal Reports, or Desktop Intelligence queries. Instead, you edit the query
to create an analytic. The process to edit queries is located in the
documentation for Web Intelligence, Crystal Reports, or Desktop Intelligence
.
1. Select the analytic on which you want to base the new analytic.
2. Click Edit.
The analytic's edit panel appears. See the information on configuring the
analytic in the "Analytics Catalog" in the Dashboard and Analytics
documentation.

Data sources for analytics
Choosing the right data for an analytic is critical. The data you select depends
on the business question you want to answer, type of analytic you choose,
and what data is available to you.
The data can be:
•

a metric created in Designer
A metric is defined using objects in a universe created using Designer
and stored in the Central Mangement Server. Metric definitions are stored
in the Performance Manager repository.

•

a universe query created in Dashboard Builder or Performance Manager
A universe query uses filtered data exported from a specific universe.

•

a predictive model or model-based metric created in Predictive Analysis.
For information on performance models, see the Predictive Analysis
documentation.

•

a goal created in Performance Manager
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For more information, see the Performance Manager documentation. For
example, in a Gauge analytic, you can display goal data returned from
prompt values.
Related Topics

• What is a metric?
• What is a goal?
• What is a universe query?

Editing an analytic
This section shows you how to:
• Add analytics to dashboards
• Save analytics as documents
• Email analytics
• Delete an analytic from an InfoView folder
• Save an analytic to a folder
• Create an analytic based on an existing analytic
• Linking analytics to documents or other analytics
For information on editing a particular analytic, check the Analytics Catalog
section in the Dashboard Builder documentation.
Related Topics

• Adding analytics to dashboards
• Saving an analytic as a document
• Emailing an analytic
• Deleting an analytic from an InfoView folder
• Saving an analytic to a folder
• Creating an analytic based on an existing analytic
• Linking to multiple documents from an analytic based on a goal, metric or
universe query
• Linking from a goal, metric or universe query-based analytic to a document
or analytic
• Linking analytics and documents
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Linking analytics and documents
Adding links to analytics allows end users navigate from an analytic to other
analytics or documents that provide information for further analysis.
Linking to analytics that use a single goal, metric, or universe-based query

You can link to one or multiple documents and you can include prompt
parameters in links. Adding prompt parameters means that the data displayed
on the target analytic or document is dynamically generated according to
the values displayed on the first analytic. You can link to:
• a single analytic or document
• multiple analytics and documents
Related Topics

• Linking from a goal, metric or universe query-based analytic to a document
or analytic
• Linking to multiple documents from an analytic based on a goal, metric or
universe query

Linking from goal, universe query and
metric-based analytics
Linking to multiple documents from an analytic
based on a goal, metric or universe query
You can create links to multiple documents from a goal or metric-based
analytic. This is particularly useful for analytic drill down.
1. How you access the options for linking analytics to other documents,
depends on whether you are creating a new analytic or editing an existing
analytic.
• If you are creating an analytic, do one of the following in InfoView:
• Go to Open > Dashboard Builder > Create New Analytic.
• Go to Document List > New > Analytic.
•

If you are editing an analytic, select the analytic, then click Edit.
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2. Expand Navigation.
3. The next step depends on whether you want:
• If you want to link the title of the analytic to multiple documents, click
Multiple Links below "Use Legend/Title as hyperlink to go to".
• If you want to provide data point navigation, so that users can click a
metric result and then view a filtered document that shows other results
for that specific time period, click Multiple Links below "Use data
point as hyperlink to go to".
The Edit Navigation Link dialog box appears.
4. Click Add, then click Browse to select the document or, if you want to
link to a web page, type the URL into the text box.
5. You can add several links to documents here.
6. Click Update, then click OK.
The link to the multiple documents appears.
For example:
Drill Down Group Level||openAnalytic.jsp?Document
Name=Drill+Down+Group+Level&RepositoryType=C&Reposito
ryName=Feature Examples&DocumentExt=rpt&DocumentId=AW
bJOJEYvvVMnbtXEQ2An0s&sContentType=OnDe
mand&mode=full||TotalSales.rpt||openAnalytic.jsp?Docu
mentName=TotalSales.rpt&RepositoryType=C&Repository
Name=Feature Samples&DocumentExt=rpt&DocumentId=AdLEd
dSQNTlDhMiLiHoD7II&sContentType=OnDe
mand&mode=full||Business Objects||http://www.busines
sobjects.com
In this example the multiple link is created to:
• Drill Down Group Level
• TotalSales report
• www.businessobjects.com
The syntax of the links is as follows:
name1||URL||name2||URL||name3||URL
7. To check the links, click OK.
The analytic appears.
8. Place your cursor on a data point or the title.

48

SAP BusinessObjects Dashboard Builder User Guide

Using analytics for analysis
Linking from goal, universe query and metric-based analytics

If the links are defined correctly, a popup menu appears with list of
destination documents.
9. Click the destination document of your choice.
Note:

When linking from goal and predictive analytics you must enter the link
manually.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics
• Using variables for dynamic links to documents

Linking from a goal, metric or universe query-based
analytic to a document or analytic
Adding links to analytics allows end users navigate from an analytic to other
analytics or documents that provide information for further analysis.
You can include prompt parameters in links. Adding prompt parameters
means that the data displayed on the target analytic or document is
dynamically generated according to the values displayed on the first analytic.
1. How you access the options for linking analytics to other documents
depends on whether you are creating an analytic or editing an existing
analytic:
• If you are creating an analytic, do one of the following in InfoView:
• Go to Open > Dashboard Builder > Create New Analytic.
• Go to New > Analytic.
•

If you are editing an analytic, select the analytic, then click Edit.

2. Expand Navigation.
3. The next step depends on whether you want to link the title or data points
to a destination document:
• If you want to link the title of the analytic to multiple documents, click
Browse below "Use Legend/Title as hyperlink to go to".
• If you want to provide data point navigation, so that users can click a
metric result to view a filtered document that shows other results for
that specific time period, click the Browse below "Use data point as
hyperlink to go to".
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The "Edit Navigation Link Menu" dialog box appears.
4. Click Add, then Browse to select the document or, if you want to link to
a web page, type the URL into the text box.
Note:

When linking from goal and predictive analytics you must enter the link
manually.
5. Click Update, then click OK.
The URL to the document appears in the URL box. The URL reads as
follows:
openAnalytic.jsp?DocumentName=<FILE_NAME>
&RepositoryType= C&RepositoryName=<REPOSITORY_NAME>
&DocumentExt=<EXTN>& DocumentId=<DOCID>
&sContentType=OnDemand&mode=full
6. To check the links, click OK.
The analytic appears.
7. Place your cursor on a data point or the title.
8. When your cursor turns into a hand sign, click the data point or title.
The destination document appears.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics
• Linking to multiple documents from an analytic based on a goal, metric or
universe query
• Using variables for dynamic links to documents
• Using variables for dynamic links to documents

Using variables for dynamic links to documents
You can include variables in the links to documents so that the destination
document is filtered by the values for a specific metric, dimension, goal or
set.
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Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables used in goal, metric and universe query
analytics
The following table gives a description of each variable you can use when
used in creating links between analytics.
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Variable

Description

$METRIC_ID$

Metric ID

$METRIC_NAME$

Metric Name

$SUBJECT_ID$

Subject ID

$SUBJECT_NAME$

Subject name

$SET_ID$

Set ID

$SET_NAME$

Set Name

$SET2_ID$

2nd Set ID (when metric based on two sets)

$SET2_NAME$

2nd Set Name (when metric based on two sets)

$POPULATION_ID$

Population ID

$POPULATION_NAME$

Population Name

$DIM_ID$

Dimension ID

$DIM_NAME$

Dimension Name

$DIM2_ID$

2nd Dimension ID
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Variable

Description

$DIM2_NAME$

2nd Dimension Name

$GOAL_NAME$

Name of goal associated with analytics

$GOAL_ID$

ID of goal associated with analytics

$SLICE_CODE$

Value of the slice (code)

$SLICE_NAME$

Value of the slice (name)

$CONDITION_ID$

Class Id from the source universe

$MEASURE_NAME$

Measure Name

$MIN_SLICE$

First slice of the dimension used for x-axis (QOU)

$MAX_SLICE$

Last slice of the dimension used for x-axis (QOU)

$CURRENT_SLICE$

Current slice of the dimension used for x-axis
(QOU)

$BEGIN_DATE$

Begin Date of the displayed period

$END_DATE$

End Date of the displayed period

$CURRENT_DATE$

Current period (corresponds to a data point in a
trend)

$MAP_CODE$

Code for the current region displayed

$MAP_NAME$

Name of current region displayed

$MAP_LONGNAME$

Long name of current region displayed

$MODEL_ID$

Model ID

$INFLUENCER_ID$

Influencer ID

$INFLUENCER_NAME$

Influencer Name
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OpenAnalytic variables for Goal variance and Pareto analytics
Pareto analytic

You can only use the $METRIC_ID$ variable to link from a Pareto analytic.
Goal variance analytics

You can use the following variables to link from Goal Variance analytics:
• $CONDITION_ ID$
• $CONDITION_ NAME$
• $DIM_ID$
• $DIM_ NAME$
• $GOAL_ ID$
• $MEASURE_ NAME$
• $METRIC_ ID$
• $METRIC_ NAME$
• $POPULATION_ ID$
• $POPULATION_ NAME$
• $SET_ ID$
• $SET_ NAME$
• $SET2_ ID$
• $SET2_ NAME$
• $SLICE_ CODE$
• $SLICE_ NAME$
• $SUBJECT_ ID$
• $SUBJECT_ NAME$
• $USER$
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics
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OpenAnalytic variables for Map analytics
This table shows which variables can be used to link from Map analytics that
use metrics or a universe query.
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Map analytic using metrics

Map analytic using a universe query

Variable
Title link

Map item
link

Title link

Map item link

X

X

X

X

$METRIC_ NAME$ X

X

X

X

$SUBJECT_ ID$

X

X

X

X

$SUBJECT_
NAME$

X

X

X

X

$SET_ID$

X

X

X

X

$SET_ NAME$

X

X

X

X

$SET2_ID$

X

X

X

X

$SET2_ NAME$

X

X

X

X

$POPULATION_
ID$

X

X

X

X

$POPULATION_
NAME$

X

X

X

X

$DIM_ID$

X

X

X

X

$DIM_NAME$

X

X

X

X

$METRIC_ ID$

$GOAL_NAME$
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Map analytic using metrics

Map analytic using a universe query

Variable
Title link

Map item
link

$GOAL_ID$

Title link

Map item link

X

X

$SLICE_CODE$

X

X

X

$SLICE_NAME$

X

X

X

$CONDITION_ ID$ X

X

X

X

$CONDITION_
NAME$

X

X

X

X

$MEASURE_
NAME$

X

X

X

X

$BEGIN_DATE$

X

X

$END_DATE$

X

X

X

X

X

X

X

X

$MAP_CODE$
$MAP_NAME$

X

$MAP_ LONGNAME$
$USER$

X
X

X

X
X

X

Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Metric List and Strategy Map analytics
This table shows which variables can be used to link from Metric Lists and
Strategy Maps analytics (only when based on goals, metrics or universe
queries).
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Metric List

Strategy Map

Title link

Attached analytic

$METRIC_NAME$

X

X

$SUBJECT_ID$

X

X

$SUBJECT_ NAME$

X

X

$SET_ID$

X

X

$SET_NAME$

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ ID$

X

X

$POPULATION_ NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$GOAL_NAME$

X

X

$SLICE_CODE$

X

X

$SLICE_NAME$

X

X

$CONDITION_ID$

X

X

$CONDITION_ NAME$

X

X

$MEASURE_ NAME$

X

X

$USER$

X

X

Variable
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Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Metric Tree and Metrics Overview analytics
This table shows which variables can be used to link from Metric Trees and
Metrics Overview analytics.
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Metric Tree
Variable

Metrics Overview

Attached Analyt- Set Name
ic
Link

Datapoint
Link

$METRIC_ID$

X

$METRIC_NAME$

X

X

$SUBJECT_ ID$

X

X

$SUBJECT_ NAME$

X

X

X

$SET_ID$

X

X

X

$SET_NAME$

X

X

X

$POPULATION _ID$

X

X

$POPULATION _NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$GOAL_NAME$

X
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Metric Tree
Variable

Metrics Overview

Attached Analyt- Set Name
ic
Link

Datapoint
Link

$GOAL_ID$

X

$SLICE_ CODE$

X

X

$SLICE_ NAME$

X

X

$CONDITION _ID$

X

X

$CONDITION _NAME$

X

X

$MEASURE _NAME$

X

X

$BEGIN_DATE$

X

$END_DATE$

X

$CURRENT _DATE$

X

$USER$

X

X

X

Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for most volatile metrics and Set Membership analytics
This table shows which variables can be used to link from most volatile
metrics and set membership analytics.
Most Volatile Metrics

Set Membership

Analytic Link

Datapoint

Datapoint

$METRIC_ID$

X

X

$METRIC_NAME$

X

X

Variable
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Most Volatile Metrics

Set Membership

Analytic Link

Datapoint

Datapoint

$SUBJECT_ID$

X

X

X

$SUBJECT_NAME$

X

X

X

$SET_ID$

X

X

X

$SET_NAME$

X

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ID$

X

X

$POPULATION_NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$SLICE_CODE$

X

X

$SLICE_NAME$

X

X

$CONDITION_ID$

X

X

$CONDITION_NAME$

X

X

$MEASURE_NAME$

X

X

$BEGIN_DATE$

X

X

$END_DATE$

X

X

$CURRENT_DATE$

X

X

$USER$

X

X

Variable

X
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Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Key Influencers analytics
The following variables can be used to link from Key Influencers analytics:
•
•
•

$MODEL_ID$
$INFLUENCER_ID$
$INFLUENCER_NAME$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for the Metric Forecaster analytic
The following variables can be used to link to Metric Forecaster analytic:
•
•
•

$METRIC_ ID$
$BEGIN_ DATE$
$END_ DATE$

OpenAnalytic variables for the Interactive Metric Trend analytic
This table shows the variables can be used to link from Interactive Metric
Trends based on goals, metrics or universe queries.
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Variable

Legend

Datapoint

$METRIC_ID$

X

X

$METRIC_NAME$

X

X

$SUBJECT_ ID$

X

X
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Variable

Legend

Datapoint

$SUBJECT_ NAME$

X

X

$SET_ID$

X

X

$SET_NAME$

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ ID$

X

X

$POPULATION_ NAME$

X

X

$DIM_ID$

X

X

$DIM_ NAME$

X

X

$SLICE_ CODE$

X

X

$SLICE_ NAME$

X

X

$CONDITION_ ID$

X

X

$CONDITION_ NAME$

X

X

$MEASURE_ NAME$

X

X

$MIN_ SLICE$

X

X

$MAX_ SLICE$

X

X

$CURRENT_ SLICE$

X

$USER$

X

X

$BEGIN_DATE$

X

X

$CURRENT_DATE$
$END_DATE$

X
X

X
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Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for a Migration analytic
The following variables can be used to link from a datapoint in the Migration
analytic for set analysis:
•
•
•
•
•

$SUBJECT_ID$
$SUBJECT_ NAME$
$SET_ID$
$SET_NAME$
$USER$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Gauge analytics
This table shows which variables can be used to link from Gauges.
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Variable

Metric

$METRIC_ ID$

X

$METRIC_ NAME$

X

$SUBJECT_ ID$

X

$SUBJECT_ NAME$

X

$SET_ID$

X

$SET_NAME$

X
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Variable

Metric

Universe query

$SET2_ID$

X

$SET2_NAME$

X

$POPULATION _ID$

X

$POPULATION _NAME$

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$DIM2_ID$

X

$DIM2_NAME$

X

$GOAL_NAME$

X

$GOAL_ID$

X

$SLICE_ CODE$

X

$SLICE_ NAME$

X

$CONDITION _ID$

X

$CONDITION _NAME$

X

$MEASURE _NAME$

X

X

X

$MIN_SLICE$

X

$MAX_SLICE$

X

$CURRENT _SLICE$

X

$BEGIN_DATE$

X

$END_DATE$

X

$CURRENT _DATE$

X
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Variable

Metric

$USER$

X

Universe query

OpenAnalytic variables for the Pie, Bubble and Radar Charts
The following table shows which variables can be used to link from the Pie,
Bubble and Radar charts:
Variable

Pie Chart

Bubble Chart

$METRIC_ ID$

X

X

$METRIC_ NAME$ X

X

Radar Chart

$GOAL_ ID$

X

$GOAL_ NAME$

X

$BEGIN_ DATE$

X

X

X

$END_ DATE$

X

X

X

$CURRENT_
DATE$

X

X

X

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Data Exploration analytics
The following variables can be used to link from the Data Exploration
analytics, which include Lag Plot, Frequency Histogram, Normal Probability
Plot, Smoothing and Curve Fitting :
• $METRIC_ID$
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•
•
•
•

$METRIC_NAME$
$BEGIN_DATE$
$END_DATE$
$CURRENT_DATE$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

nbPrompts
nbPrompts is a parameter used in customized links between analytics and
documents stored on the Central Management Server in which prompts are
allowed, including analytics, Crystal Reports, Desktop Intelligence and Web
Intelligence documents. Using nbPrompts, you can fill the prompt(s) in the
target document with openAnalytic variables.

nbPrompts syntax in links from goal and metric-based analytics
The following are examples of nbPrompts syntax:
openanalytic.jsp?...&mode=full&nbPrompts=1
&[analytic_prompt_name]=$METRIC_NAME$
openanalytic.jsp?...&mode=full&nbPrompts=3
&[analytic_prompt1]=$METRIC_NAME$&[analytic_prompt2]=
$BEGIN_DATE$&[analytic_prompt3]=$END_DATE$
where openanalytic.jsp?...&mode=full is automatically included in
the address when you select the target document, and you add the remaining
text using the following syntax:
&nbPrompts=[#]&[analytic_prompt_name]=
$METRIC_NAME$
where you replace [#] with the number of prompts, and for each prompt you
add the string &[analytic_prompt_name]=$METRIC_NAME$, where
[analytic_prompt_name] is replaced with the name of the prompt in the
analytic or document.
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Using openDocument in dashboards and analytics
The openDocument.jsp uses the "opendoc" context to open objects from a
document or dashboard in InfoView.
Use the following syntax:
/OpenDocument/opendoc/
openDocument.jsp?iDocID=vscmMCXk
&sIDType=CUID&sType=null&sInstance=Last
where vscmMCXk is the ID of the dashboard.
Note:

Use relative instead of absolute links to documents in InfoView, in the case
where you plan to migrate servers.
To use openDocument to open a dashboard from a document or dashboard:
/OpenDocument/opendoc/openDocument.jsp?
iDocID=vscmMCXk&sIDType=CUID&sType=null
To use openDocument to open an analytic from a document or dashboard:
/OpenDocument/opendoc/openDocument.jsp?
iDocID=vscmMCXk&sIDType=CUID&sType=null
Example: sInstance in openDocument syntax

Use the parameter sInstance=Last with the OpenDocument function to
retrieve the last instance of a Web Intelligence or Desktop Intelligence
report. You must specify the fully-qualified URL of the target document for
the parameter to take effect.
Note:

sInstance=Last has no effect in the OpenAnalytic function.

URL reporting using openDocument
URL reporting using openDocument provides URL access to multiple
document types by passing a URL string to a BusinessObjects Enterprise
server. openDocument provides commands to control how reports are
generated and displayed.
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You can use openDocument in BusinessObjects Enterprise to create
cross-system links to and from the following document types:
•

.wid: Web Intelligence documents

•

.rep: Desktop Intelligence documents

•

.rpt: Crystal reports

•

.car: OLAP Intelligence reports

Structuring an openDocument URL
The next sections explain how to use the openDocument function, and how
to construct the URL.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

The URL is constructed using the parameters listed in openDocument
parameter overview
Joining parameters

Join parameters with the ampersand (&). Do not place spaces around the
ampersand. For example: sType=wid&sDocName=Sales2003
The ampersand is always required between parameters.
Spaces and special characters in parameter values

Because some browsers cannot interpret spaces, the parameters of the link
cannot contain spaces or other special characters that require URL encoding.
To avoid the misinterpretation of special characters, you can define a
URLEncoded string in the source database to replace the special character

SAP BusinessObjects Dashboard Builder User Guide

67

3

3

Using analytics for analysis
Linking from goal, universe query and metric-based analytics

with an escape sequence. This will allow the database to ignore the special
character and correctly interpret the parameter value. Note that certain
RDBMS have functions that allow you to replace one special character with
another.
By creating an escape sequence for the plus sign (+), you can instruct the
database to interpret the plus sign as a space. In this case, a document title
Sales Report for 2003 would be specified in the DocName parameter as:
&sDocName=Sales+Report+for+2003&
This syntax prevents the database from misinterpreting the spaces in the
title.
Trailing spaces in parameter values

Trim trailing spaces at the end of parameter values and prompt names. Do
not replace them with a plus sign (+). The viewer may not know whether to
interpret the plus sign (+) as part of the prompt name or as a space. For
example, if the prompt name displays:
Select a City:_
(where _ represents a space), enter the following text in the link:
lsSSelect+a+City:=Paris
where the spaces within the prompt name are replaced with the plus sign,
and the trailing space is trimmed off.
For details on prompt parameters of the link, refer to openDocument
parameter overview .
Capitalization

All of the openDocument parameters are case sensitive.
Link length limit

The encoded URL cannot exceed 2083 total characters.
Parameter values in links to sub-reports

You cannot pass parameter values to a sub-report of a target Crystal report.
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Using the lsS parameter with OLAP Intelligence reports
If the target document is an OLAP Intelligence report (.car) you can use the
IsS parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.
Example: Opening a report to a specific page

If 23CAA3C1-8DBB-4CF3BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F is the URL-encoded
unique name for the page parameter in the OLAP Intelligence report, you
would use the following URL to open the OLAP Intelligence report to page
2:
http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&iDocID=440&lsS23CAA3C18DBB-4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F=2

Example: Opening a cube parameter

If 8401682C-9B1D-4850-8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62
is the URL-encoded unique name for the cube parameter opening the
warehouse cube in the catalogue FoodMart 2000 on MSAS, you would use
the following URL to open this cube parameter:
http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsS8401682C-9B1D-48508B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62=CATALOG%3DFood
Mart%202000,CUBE%3Dwarehouse&iDocID=616

Using the lsM parameter with OLAP Intelligence reports
If the target document is an OLAP Intelligence report (.car) you can use the
IsM parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.
As was the case for the lsS parameter, lsM parameters are also passed in
as a URL-encoded string using the unique name of the parameter set up in
the OLAP Intelligence report.
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Example: Opening a report

http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsMADC216EA-D9A5-42B5AE%2C21%2C84%2CA9%2CF9%2C6E%2C31%2C7=[%5BCus
tomers%5D.%5BCountry%5D.%26%5BMexico%5D],[%5BCus
tomers%5D.%5BCountry%5D.%26%5BCanada%5D]&iDocID=544
This is a memberset parameter opening up a report with Customers >
Country > Mexico and Customers > Country > Canada in the view.

openDocument parameter overview
This section provides a brief overview of openDocument and includes a list
of available parameters. Details about the available parameters, their specific
uses, and relevant examples are also provided.
Note:

The document containing the openDocument link is called the parent
document, and it resides on the parent system. The document to which the
link points is called the target document, and it resides on the target system.
Table 3-10: Platform Parameters
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Parameter

Description

iDocID

Document identifier.

sDocName

Document name.

sIDType

Crystal object type.

sKind

The file type of target Desktop Intelligence
document.
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Parameter

Description

sPath

The name of the folder and subfolder containing the target document.

sType

The file type of target document or report.

token

A valid logon token for the current CMS session.

Table 3-11: Input Parameters

Parameter

Description

lsC

Specifies a contextual prompt if there is an
ambiguity during SQL generation (Business
Objects and Web Intelligence documents only).

lsM[NAME]

Specifies multiple values for a prompt,
[NAME] is the text of the prompt

lsR[NAME]

Specifies a range of values for a prompt,
[NAME] is the text of the prompt.

lsS[NAME]

Specifies a value for a single prompt. [NAME]
is the text of the prompt.

sInstance

Indicates which specific instance of the target
report to open.
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Parameter

Description

sPartContext

In Crystal Reports, a report part is associated
to a data context.

sRefresh

Indicates whether a refresh should be forced
when the target document or report is opened.

sReportMode

For Crystal targets only, indicates whether
the link should open the full target report or
just the report part specified in sReportPart.

sReportName

Indicates which report to open if target document is multi-report.

sReportPart

Indicates which specific part of the target report to open.

Table 3-12: Output Parameters

72

Parameter

Description

NAII

Forces the display of the prompt selection
page.

sOutputFormat

Indicates the format in which the target document is opened.

sViewer

Indicates the selected report viewer (CR &
CA only).

SAP BusinessObjects Dashboard Builder User Guide

Using analytics for analysis
Linking from goal, universe query and metric-based analytics

Parameter

Description

sWindow

Indicates whether the target report will open
in the current browser window or whether a
new window will be launched.

openDocument platform parameters
This section details the openDocument platform parameters that are available
and gives examples on how to use the commands.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

iDocID
Syntax

Description

Mandatory? Values

iDocID

Document identifier.

Yes*

Document identifier (InfoObjectID).
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Note:

*One of sDocName or iDocID is mandatory.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDocID=2010
Note:

To obtain the document ID, navigate to the document within the Central
Management Console (CMC). The properties page for the document
contains the document ID and the CUID. Use this value for the iDocID
parameter.

sDocName
Syntax

Description

Mandatory? Values

Document name without
extension
If multiple documents
Yes*
have the same name,
specify the correct document with iDocID.

sDocName

Document name.

Note:

*One of sDocName or iDocID is mandatory.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+200
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sIDType
Syntax

Description

Central Management
Server (CMS) object
identifier type.

sIDType

Mandatory? Values

Yes*

•
•
•
•
•

CUID
GUID
RUID
ParentID
InfoObjectID (default)

Note:

*Only mandatory if the target is a Crystal report or OLAP Intelligence report
(sType=rpt or sType=car) in an Object Package. Otherwise, use sPath
and sDocName.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?iDocID=2010&sIDType=CUID

sKind
Syntax

Description

Mandatory? Values

sKind

The file type of target
Desktop Intelligence doc- Yes*
ument.

•

FullClient

Note:

*Only mandatory if the target is a Desktop Intelligence document. Otherwise,
use sType.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sKind=FullClient

sPath
Syntax

Description

Mandatory? Values

sPath

The name of the folder
and subfolder containing Yes*
the target document.

Folder and/or subfolder:
[folder],[subfold
er]

Note:

*Only mandatory if a value is specified for sDocName and is not unique.
sPath is used only with subfolders of the Public Folders folder. If your
document is outside of the Public Folders folder, for example in the My
Favorites folder, use the iDocID parameter instead of sPath and
sDocName.
Do not add [Public+Folders] to the path; start with the name of the first
subfolder within Public Folders.
Public Folders
folder 1
folder 1.1
folder 1.1.1
If your document were in folder 1.1.1, you would set sPath to: [fold
er+1],[folder+1.1],[folder+1.1.1].
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2005
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sType
Syntax

Description

The file type of target
document or report.

sType

Mandatory? Values

Yes

•

wid

•

rpt

•

car

Note:

This parameter is ignored for agnostic documents.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid

token
Syntax

Description

Mandatory? Values

token

A valid logon token for
No
the current CMS session.

The logon token for the
current CMS session.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=Sales+in+2003&token=<lo
gonToken>

openDocument input parameters
This section details the openDocument input parameters that are available
and gives examples on how to use the commands.
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An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

lsC
Syntax

lsC

Description

Mandatory? Values

Specifies a contextual
prompt if there is an ambiguity during SQL generation (Business Objects
and Web Intelligence
No
documents only).
Note:

Not supported by OLAP
Intelligence
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsC=Sales

lsM[NAME]
Syntax

Description

Mandatory? Values

•

Multiple prompt values, separated by a
comma. If the target is
a Crystal report, each
value must be enclosed in square
brackets. If the target
is a OLAP Intelligence
report, use the MDX
WITH clause.

•

no_value (only for
optional parameters)

Specifies multiple values
for a prompt. [NAME] is No
the text of the prompt.

lsM[NAME]

Note:

•

•

•

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter
value will be applied.
The character ? is a reserved prompt value for Web Intelligence
documents in an openDocument URL. Setting the prompt value to
lsM[NAME]=? in the URL forces the "Prompts" dialog box to appear for
that particular prompt.
For information on using this parameter with OLAP reports, see Using
the lsM parameter with OLAP Intelligence reports .
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=rpt&sDocName=SalesReport&lsMSe
lect+Cities=[Paris],[London]

lsR[NAME]
Syntax

Description

Mandatory? Values

•

A range of values for
the prompt, separated
by a double period (..).
If the target is a Crystal report, the range
must be enclosed in
square brackets
and/or parentheses
(use a square bracket
next to a value to include it in the range,
and parentheses to
exclude it).

•

no_value (only for
optional parameters)

Specifies a range of values for a prompt. [NAME]
is the text of the prompt.
lsR[NAME]

Note:

No

Not supported by OLAP
Intelligence

Note:

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter value
will be applied.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=rpt&sDocName=SalesReport&lsRTime+Pe
riod:=[2000..2004)

lsS[NAME]
Syntax

Description

Mandatory? Values

lsS[NAME]

Specifies a value for a
single prompt. [NAME] is No
the text of the prompt.

•

A single prompt value.

•

no_value (only for
optional parameters)

Note:

•

•

•

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter
value will be applied.
The character ? is a reserved prompt value for Web Intelligence
documents in an openDocument URL. Setting the prompt value to
lsS[NAME]=? in the URL forces the "Prompts" dialog box to appear for
that particular prompt.
For information on using this parameter with OLAP reports, see Using
the lsS parameter with OLAP Intelligence reports.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsSSelect+a+City=Paris
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sInstance
Syntax

Description

Mandatory? Values

Indicates which specific
instance of the target re- No
port to open.

sInstance

•

User (Link to latest
instance owned by
current user)

•

Last (Link to latest
instance for report)

•

Param (Link to latest
instance of report with
matching parameter
values)

Note:

Use this parameter in combination with sDocName.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1&sInstance=User

sPartContext
Syntax

Description

Mandatory? Values

sPartContext

In Crystal Reports, a report part is associated to Yes*
a data context.

Data context of the report
part.

Note:

*Only mandatory if a value is specified for sReportPart.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2005&sReportPart=Part1&sPartContext=0-40
Note:

The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

sRefresh
Syntax

Description

Mandatory? Values

sRefresh

Indicates whether a refresh should be forced
No
when the target document or report is opened.

•

Y (forces the document’s refresh)

•

N (note that the refresh on open feature
overrides this value)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&sRefresh=Y
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sReportMode
Syntax

Description

Mandatory? Values

sReportMode

For Crystal targets only,
indicates whether the link
should open the full tarNo
get report or just the report part specified in
sReportPart.

•

Full

•

Part

Note:

Defaults to Full if this parameter is not specified. Only applies if a value is
specified for sReportPart.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1&sReportMode=Part

sReportName
Syntax

Description

Mandatory? Values

sReportName

Indicates which report to
open if target document No
is multi-report.

Report name for Web Intelligence documents,
sub-report for Crystal Reports, pages for OLAP
Intelligence reports.

Note:

Defaults to the first report if this parameter is not specified.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=Sales+in+2003&sReport
Name=First+Report+Tab

sReportPart
Syntax

Description

Mandatory? Values

sReportPart

Indicates which specific
part of the target report to No
open.

Name of the report part.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1
Note:

The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

openDocument output parameters
This section details the openDocument output parameters that are available
and gives examples on how to use the commands.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
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•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

NAII
Syntax

Description

Mandatory? Values
•

Forces the display of the
prompt selection page.
Note:

NAII

No

Only supported by Web
Intelligence documents.

Y (prompt values that
are passed with lsS,
lsM, or lsR in the
URL are applied and
not displayed in the
"Prompts" dialog box)

Note:

•

•

NAII=Y raises the "Prompts" dialog box for any values not specified in
the URL. Prompts created with default values are still displayed in the
"Prompts" dialog box.
If all prompt values are specified in the URL, the prompt window does
not appear even if NAII=Y is specified.

Example:

This example assumes there are two prompts in the Web Intelligence
document: Year and Country. NAII=Y forces the "Prompts" dialog box
to appear and allows the user to specify a value for the Country prompt.
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The Year prompt is already set to a value of FY1999 in the URL using the
lsS parameter and therefore is not prompted for.
http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsSYear=FY1999&NAII=Y&sRefresh=Y

sOutputFormat
Syntax

Description

sOutputFormat

Indicates the format in
which the target document is opened.

Mandatory? Values

No

•
•
•
•

H (HTML)
P (PDF)
E (Excel)
W (Word)

Note:

Defaults to HTML if this parameter is not specified.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sOutputFormat=E
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sViewer
Syntax

Description

Mandatory? Values

•
•
sViewer

Indicates the viewer that
is used to view the docu- No
ment.

•
•

html
part (Crystal reports
only)
actx (Crystal reports
only)
java (Crystal reports
only)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sViewer=html

Example:
Note:
In order to use parameters in the URL with the ActiveX viewer, :connect
must be appended to the URL, followed by the parameters.

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sViewer=actx:connect&IsMCountry=[Thai
land],[Norway]
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sWindow
Syntax

Description

Mandatory? Values

sWindow

Indicates whether the
target report will open in
the current browser win- No
dow or whether a new
window will be launched.

•

Same (current browser
window)

•

New (new browser
window is launched)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&sWindow=New

Contextual report linking
The openDocument feature allows you to create contextual links between
Crystal reports, OLAP Intelligence reports and Web Intelligence documents.
To do this, you construct a URL using the openDocument syntax and then
insert the URL into a Crystal report, OLAP Intelligence report or Web
Intelligence document.
Contextual report linking allows report designers to specify associations for
documents residing in either a Crystal Reports environment (unmanaged)
or a BusinessObjects Enterprise environment (managed). Once these
associations are created, users follow the resulting navigational paths
embedded in the linked documents.
This feature enables you to invoke Business Objects and Web Intelligence
documents from Crystal Reports and vice versa. This feature relies on
functionality that allows the user to do the following:
•

Link Web Intelligence or Business Objects documents within the document
domain.

•

Link report objects in Crystal Reports.

SAP BusinessObjects Dashboard Builder User Guide

89

3

3

Using analytics for analysis
Linking from goal, universe query and metric-based analytics

To insert a link into a Crystal report
You can use openDocument to create hyperlinks in Crystal Reports. To
create a link to another report or document, use the Hyperlink Tab of the
field Format Editor.
1. Open the source report in Crystal Reports.
2. Right-click the field in which you want to insert the openDocument link
and select Format from the shortcut menu.
3. In the Format Editor, select the Hyperlink tab.
4. Select A website on the Internet.
5. In the “Hyperlink information ? area, leave the Website Address field
empty and click the Format Formula Editor button.
6. Enter the openDocument link in the following format:
"http://[openDocument parameters]"+{Article_lookup.Fam
ily_name}
Where [openDocument parameters] are described in openDocument
parameter overview , and the {Article_lookup.Family_name} enables the
report to pass context-dependent data.
Note:

Test your link in a browser window before inserting it into a report or
document.
7. Click Save and Close to leave the Formula Workshop.
8. Click OK in the Formula Editor to save the link.

To create a link to another report or document from an OLAP Intelligence
report
You can use openDocument to create hyperlinks in OLAP Intelligence reports.
1.
2.
3.
4.
5.
6.
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Open the source report in the OLAP Intelligence designer.
On the Tools menu, select Action Manager .
Click New to create a new action.
Enter an action name.
Select the area to which the action (the link) will apply.
Enter the openDocument link using the parameters and syntax described
in this document.
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Tip:

Test your link in a browser window before inserting it into a report or
document.
7.
8.
9.
10.
11.
12.
13.

Click OK to save the link.
Close the Action Manager dialog box.
Create an Analysis Button on the source report.
Right-click the Analysis Button.
In the drop-down menu, select Properties and then Edit .
Select Launch an action .
Select the action that corresponds to the openDocument link created in
steps 3 through 6.
14. Click OK .

Creating links in Web Intelligence documents
You can define objects in a universe that allow Web Intelligence and
BusinessObjects users to create reports whose returned values include links
to other reports and documents.
When these reports are exported to the repository, users can click returned
values displayed as hyperlinks to open another related document stored in
the document domain of the repository.You create these links using the
openDocument function in the definition of an object in Designer.
More information

For full information on creating links in Web Intelligence reports, see the
Building Reports Using the WebIntelligence Java Report Panel guide.
You enable report linking in a universe by creating an object (the link object)
whose returned values are the same as the values used as input to a prompt
in an existing report (the target report).
The openDocument function allows the values for the link object to be
returned as hyperlinks. When the user clicks the hyperlink, its value is used
as the prompt input for the target report.
You can create documents using the link object as you would with any other
object. Users can then click the hyperlinks to access more detailed documents
related to the link object.
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To create a link object, use the openDocument function in the object’s Select
statement. The Select statement for a link object follows this order:
'<a href="http://<servername>:<port>/OpenDocument/<plat
formSpecific>?sDocName=<document name>&sType=<document
type>&iDocID=<document id>&lsS<prompt message>='+object
SELECT+'">'+object SELECT+'</a>'
The concatenation operator (+) applies for Microsoft Access databases. Use
the operator appropriate to your target RDBMS.
For more details on the Select statement, creating link objects, and using
link objects in InfoView, refer to the Designer’s Guide.

Sending information to the Viewer analytic in a
dashboard using openAnalytic
Using the openAnalytic syntax, you can send information from the following
documents saved on the Central Management Server (CMS) to a Viewer
analytic on a dashboard:
• Web Intelligence reports
• Crystal Reports
• Text analytic
• Desktop Intelligence reports
• Web page analytic
Sample syntax:
<a href='http://[WEB APPLICATION LOCATION]
aa-open-inlist.jsp?url=openAnalytic.jsp?
DocumentName=text+analytic&RepositoryType=C
&RepositoryName=PM&DocumentExt=afd
&DocumentId=AQ74dXHxW59HlHvZivNsypI&mode=full
' target='hiddenFrame'>[LINK NAME IN DASHBOARD]</a>
The key items in the sample are aa-open-inlist.jsp and target='hid
denframe'.
1. In a text editor, copy and paste the sample syntax.
2. Replace [WEB APPLICATION LOCATION] with the web application
location after http://.
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For example: http://<server>:<port>/PerformanceManage
ment/jsp
3. Enter the correct information after the variables.
4. Replace [LINK NAME IN DASHBOARD] with the name of the link as you
want it to appear.
5. Copy and paste the text in the following location:
• For a Web Intelligence, Crystal Report or Desktop Intelligence report,
copy the text in the cell of the query and then run a report.
• For a Text analytic, go to the edit mode and paste the text in the "Enter
text or HTML to display" text box and select html. Save the analytic
in the public folders.
• For a Web page analytic, go to the edit mode and in the "Content" tab
paste the text in the "Enter the web page URL" text box and click OK.
In the "Layout" tab, select from the "Display as" section A link, so
only the name is visible.
6. In InfoView, go to Dashboards > Create Corporate Dashboard.
7. Enter the title, select a public folder, and click OK.
8. Click Dashboards > Organize Corporate Dashboards, and select your
dashboard.
9. Click Edit Dashboard.
10. From the "Analytic Toolbox", expand the "Corporate Analytics" list to find
your report, and drag it to the dashboard layout.
11. From the "Analytic Toolbox", expand the "New Analytic" list, and drag the
"Viewer" analytic from the list to the dashboard layout.
12. Click Save, then Exit Edit Mode.
Click on any linked item in the report and the destination appears in the
viewer.

Emailing an analytic
You can email analytics to other Dashboard and Analytics users.
Note:

You cannot email an analytic from a dashboard.
1. Open the analytic, then click Email.
2. From the list, select the format of the email:
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• CSV
• HTML
An empty email message appears with the analytic attached.
3. Enter the email address, a message in necessary, and send the email.
Related Topics

• Downloading an analytic

Downloading an analytic
You can download the following analytics as CSV or HTML:
Analytic

CSV

Control Chart

X

Gauge

X

Goal-based Influencer Detail

X

Individual List

X

Influencer Detail

X

Influencer Gains Chart

X

Interactive Metric Trend

X

Key Influencers

X

Metric Forecaster

X

Model Gains Chart

X

Variable Profile Box Plot

X

Related Topics

• Expanded toolbar actions on analytics
• Emailing an analytic
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Deleting an analytic from an InfoView
folder
You can delete analytics you have saved to corporate or personal folders.
Note:

When you delete an analytic that is referenced by a dashboard, an error
message appears in the dashboard indicating that the document no longer
exists in the system.
1. From InfoView, select the folder that contains the analytic.
2. Select the analytic you want to delete by checking the box next to its
name.
3. Click the delete button in the toolbar.

Saving an analytic to a folder
You can save analytics to "My Folders" or "Public Folder"s in InfoView.
1. With the analytic open, click Save or Save As.
The "Save an Analytic" page appears.
2. In the "Title" field, enter the title of the metric tree.
3. In the "Description" field, enter a description.
The description appears next to the title of the analytic once it is saved
in InfoView. The description is optional.
4. In the "Keywords" field, type keywords useful to search for the document
in InfoView.
This step is optional.
5. Click the drop down arrow next to "Display Mode" and select the file format
you want for the metric tree.
6. Select whether you want the analytic to be refreshed "Manually" or "When
Opened".
7. Choose whether you want to overwrite a previous version of the same
analytic or whether you want to retain the older version.
8. Browse to where you want to save the analytic.
9. Click OK.
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The analytic is saved in InfoView.

Saving an analytic as a document
Using the "Download" option in the analytic's edit mode, certain analytics
can be saved in Comma Separated Values (CSV) or an HTML format that
complies with Section 508 of the U.S. disabilities act.
The following analytics can be downloaded:
Analytic

CSV

Control chart

X

Gauge

X

Goal-based influencer detail

X

Individual list

X

Influencer detail

X

Influencer gains chart

X

Interactive metric trend
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X

Key influencers

X

Metric forecaster

X

Model gains chart

X

Variable profile box plot

X
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Analytics that can be created in
Dashboard Builder
Dashboard Builder Analytics
Interactive Metric Trend analytic based on goals, metrics and
universe queries
Interactive Metric Trend
The Interactive Metric Trend analytic shows trends using lines and bars. You
can use the following types of data:
• a universe query
• a single goal or metric
You use the Interactive Metric Trend analytic with both sliced and
non-sliced metrics. It allows you to view the all value (the global slice)
and the sliced view (if you have the appropriate rights to view individual
slices and the global slice). The Interactive Metric Trend analytic also
allows you to filter individual dimension values. When you add a sliced
metric to the analytic in the metric selection screen, a slice filter is
available.
Related Topics

• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries
• What is a universe query?

Configuring an Interactive Metric Trend analytic using on goals, metrics and
universe queries
Note:

The user interface for this analytic has been modified to comply with the
Section 508 guidelines.
1. In the Interactive Metric Trend edit panel, select the data you want to
display:
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•

Performance Data
When you select this option, you can select metrics and a default goal
type.

•

Top Metrics
Use Top Metrics when you want to focus on a certain number of
metrics based on their rating. When you select the option, you need
to specify the top X amount of metrics. If necessary, assign a variant
level and type. For example, you can choose to have the top 5 metrics
having an increase in absolute value.

•

Sets Data
If you have Set Analysis installed, then you can select Sets Data, and
choose either Single Set or a cross set type to refine the data.

•

Goals Only
Use this option If you only want to list goal trends.

•

Universe Query
Select this option to define a query on a universe.

2. To specify a color for a metric, select it in the metric list and click Color.
The color box appears.
3. To include slices for a metric, select the metric, then click Slices.
Note:

The global value of the dimension associated to the metric is displayed
instead of a slice, if the individual slices do not have security rights
associated to them for specific users.
4. To define a time window, select one of the following options and specify
the dates or periods:
• All
• Between
• From
• Until
• Last Period
5. Select a slice, then click OK.
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Note:

If you do not have access to the selected slice, the following message
appears when you try to view the analytic: "You do not have access to
this metric."
6. Optionally, configure links to other analytics.
7. Set the graph and legend properties.
8. Customize the columns and tooltips.
Related Topics

• What is a universe query?
• Interactive Metric Trend
• Defining a universe query for an analytic
• Linking the Interactive Metric Trend analytic to other analytics or documents
• Graph and legend properties for Interactive Metric Trend analytics
• Customizing columns in Interactive Metric Trend and Metric List analytics
• Interactive Metric Trend analytic formats
• Customizing the tooltip in the Gauge, Interactive Metric Trend and Metric
List analytics

Linking the Interactive Metric Trend analytic to other analytics or
documents
You use a link to drill from a data point to a detailed report. You can pass
the period (begin and end date) as you click a data point on the Interactive
Metric Trend analytic.
1. In the analytic's edit panel, expand Navigation and Legend Options.
2. The next step depends on what type of analytic or document you want
to link to:
• If you want to link to a metric tree select Provide Link To Metric Tree.
• If you want to link the title of the analytic to a single document, click
Browse below "Use Legend/Title as hyperlink to go to" and then
browse to the document ,or click Multiple Links to create links to
more than one document.
• If you want to provide data point navigation, so that users can click on
a metric result and then view a filtered document that shows other
results for that specific time period, click Browse below "Use data
point as hyperlink to go to" and then browse to the document, or click
Multiple Links to create links to more than one document.
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Related Topics

• Using variables for dynamic links to documents
• Linking analytics and documents

Interactive Metric Trend analytic formats
You can create Interactive Metric Trend analytics in two formats:
•
•

the Snapshot (SVG Viewer) – this is useful if you want to print the analytic
the interactive view – this is useful if you want to perform online analysis
of the data displayed on the analytic interactively

Note:

This topic is for Interactive Metric Trend analytics based on metrics, goals
and universe queries.

Configuring the Interactive Metric Trend display modes
• In the analytic's edit panel, expand Display Mode.
Option

Description

Hide Selected
Metrics panel

Click to hide the metrics panel.
The Selected Metrics Panel lists the selected metrics with related data.

Hide Graph Options Panel
Hide Start
Hide End
Hide Percent
Change
Hide Change

Click to hide the graph options panel.
Click to hide the Start column in the trend table.
Click to hide the End column in the trend table.
Click to hide the % Change column in the trend table.
Click to hide the Change column in the trend table.

Related Topics

• Linking the Interactive Metric Trend analytic to other analytics or documents
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• Graph and legend properties for Interactive Metric Trend analytics
• Graph options on the Interactive Metric Trend chart

Graph and legend properties for Interactive Metric Trend analytics
You can set the following graph and legend properties for Interactive Metric
Trend analytics:
•
•
•

the percentage change you want to show for the selected metrics
the type of chart you want (for example, lines, bars and so on)
the title you want to appear on the Interactive Metric Trend

Note:

This topic is for Interactive Metric Trend analytics based on metrics, goals
and universe queries.
Related Topics

• Interactive Metric Trend analytic formats
• Linking the Interactive Metric Trend analytic to other analytics or documents

Setting graph and legend properties in an Interactive Metric Trend analytic
that is based on a goal, metric or universe query
1. In the analytic's edit panel, expand Graph and Legend.
2. From the "Metric Type" list box, select one of the following:
• Raw
• % of origin
• % Change of origin
• Change
• % change
• Current vs prior
• Cumulative sum
• Month to date
• Quarter to date
• Year to date
3. When you have widely variant data, select Logarithmic Scale. If you do
not, the initial appearance of the graph will be of little value as the scale
will cause most of the graph to be skewed.
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4. Select Show GYR zones in background if you want to use the Interactive
Metric Trend to navigate and display the goal information at the same
time.
This option can only be applied when there is only one metric being
displayed. To see this option associated with a goal for a specific metric,
you have to use the goal type of this goal.
5. From the "Compare to" list box, select a value.
6. From the "Chart Type" list box, select the type of chart you want to display.
7. Define minimum and maximum values for the Y axis scale using Manually
defined, from X to X.
8. In the "Title" section, do one of the following:
• Activate Use Metric/Goal Name if you want the title of the analytic to
display the name of the first metric or goal it displays.
• Activate Display Text and type a title.
9. If you want a legend on the chart, activate Show Legend.
10. If you want for slices to be displayed on the chart, activate Show Slices.
11. Save your analytic or customize other properties.

Metric types for Interactive Metric Trend graphs
You may select one of the following metric or goal types to display:
•
•

Raw: the raw value of the metric or goal
% of origin: the division between two values of a single metric.
Generic formula is: Metric value Current Period / Metric value Origin
Period
In the Analysis Tab, Origin depends on the time window you have
selected. For example:
• a Monthly Metric where Last value is Sept.-2000. If you have selected
Time window Last 6 months, then Origin Period is Apr.-2000.
• a Monthly Metric where First value is Jan.-1999. If you have selected
Time window All, then Origin Period is Jan.-1999.
A % from Origin trend always starts at 100%.

•
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% Change of origin: the relative change between a Current value and an
Origin value of a single metric.
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Generic formula is: (Metric value Current Period - Metric value Origin
period) / Metric value Origin period
The advantage of the % Change from Origin as compared to % from
Origin is that it better represents the direction of the change. Negative %
Change from Origin means that the change is negative. Positive % Change
from Origin means that the change is positive. A % Change from Origin
trend always starts at 0%.
•

Change: the difference between two values. Generic formula is: Metric
value Current Period - Metric value Prior period. The prior period is relative
to the current period.
For example:
• a Monthly Metric with an "Annual lag Change". The resulting value for
January 2001 represents the absolute value of Change between the
value of January 2001 and the value of January 2000.
• a Monthly Metric with an "Adjacent-point lag Change". The resulting
value for January 2001 represents the absolute value of Change
between the value of January 2001 and the value of December 2000.

•

% change: the relative change between two values of a single metric or
goal.
Generic formula is: (Metric value Current Period - Metric value Prior
period) / Metric value Prior period
The advantage of the Percent change as compared to Change is that it
enables the comparison between two metrics that have different kind of
units (for example, Number of customers versus Total revenue) and
different sized units (revenue in $hundred millions versus profits in $ten
millions).
The advantage of the Percent Change as compared to Current Versus
Prior is that it better represents the direction of the change. Negative
Percent change means that the change is negative. Positive percent
change means that the change is positive.

•

Current vs prior: the division of two values of a single metric or goal.
Generic formula is: Metric value Current Period / Metric value Prior period
The advantage of the Current Vs Prior as compared to Change is that it
enables the comparison between two metrics that have different kind of
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units (for example, Number of customers versus Total revenue) and
different sized units (Revenue in $hundred millions versus Profits in $ten
millions).
•
•
•
•

Cumulative sum
Month to date
Quarter to date
Year to date

Chart types for Interactive Metric Trend analytics
You can select between the following Interactive Metric Trend chart types:
•

Lines
This chart uses a line to connect the datapoints.

•

Bars
This chart represents each datapoint as a bar.

•

Stacked bars
This chart represents each datapoint as a bar that is segmented by the
dimensions in the metric.

•

% Stacked bars
This chart represents each datapoint as a bar that is segmented by the
dimensions in the metric growing or declining based on the percent change
from the previous datapoint.

Customizing columns in Interactive Metric Trend and Metric List
analytics
Note:

These steps apply to the Interactive Metric Trend and Metric List analytics
that use goal, metric and universe query data sources.
1.
2.
3.
4.

In the analytic edit panel, expand Customize Columns.
From the "Available Items" list, select the columns to view and click >>.
To rename a column, select the column in a list and click Rename.
To customize the view you can also select:
• Show Header
Select this option to display a header.
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Note:

No header is added for folders.
•

Remove Duplicate
Use this option to avoid duplicating data. Metrics can have several
goals associated, however when this option is selected, all data related
to a metric is displayed only once.

•

Gray background every other row
Use this option to display a gray background every other row. This
action makes the list easier to read.

Related Topics

• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries
• Configuring a Metric List analytic using metrics and goals

Customizing the tooltip in the Gauge, Interactive Metric Trend and
Metric List analytics
You use the tooltip to display additional information on an analytic.
Note:

These steps apply to the Interactive Metric Trend, Gauge and Metric List
analytics that use goal, metric and universe query data sources.
1. In the analytic edit panel, expand Customize Tooltip.
2. Select an item in the "Available Items" box and click >>. Repeat this step
as much as necessary.
3. If you selected an item in error, highlight it in the right-hand box and click
<<.
Note:

To rename an item, click Rename.
Related Topics

• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries
• Configuring a Metric List analytic using metrics and goals
• Configuring a Gauge analytic using a metric, goal or universe query
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Graph options on the Interactive Metric Trend chart
In the Interactive Metric Trend chart, you have a graph options provided in
a menu.

You can do the following actions on this menu:
1. Change the chart type.
2. Activate or deactivate the legend.
3. Activate or deactivate the previous year analysis.
4. Activate or deactivate the target value analysis.
5. Change the metric type.
To activate this menu, you must go to the analytic's edit panel.
Related Topics

• Chart types for Interactive Metric Trend analytics
• Metric types for Interactive Metric Trend graphs
• Configuring the Interactive Metric Trend display modes

Gauge analytic based on goals, metrics and universe queries
Gauge
A gauge highlights the status of a metric and its monitors or measures
compared to a dimension value across a particular dimension, for example,
time.
The gauge can appear in the following formats:
•
•
•
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Barometer (default option)
Speedometer
Thermometer
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•

Traffic Light

You can create a gauge that is based on a single metric, goal, or universe
query.
Related Topics

• Configuring a Gauge analytic using a metric, goal or universe query

Configuring a Gauge analytic using a metric, goal or universe query
1. In the Gauge edit panel, select the data you want to display:
• Metric Data
When you select this option, you can select metrics and a default goal
type.
•
•

Prompt for a Metric
Goal Data
Select Goal Data if you want to select a Performance Manager goal
as the data source.

•

Prompt for a Goal
Use this option If you only want to list goal trends.

•

Universe Query
Select this option to define a query on a universe.

2. If you want slice navigation, select Allow dimension slice navigation.
When this option is activated, it allows navigation through all of the slices
of the metric. If you prefer to have navigation in only one slice or slice
family, click Choose Slice, then Slices, to select a particular dimension
slice.
Note:

The slice navigation option only works on dimensions that contain slices,
and is not available with the Universe Query option. For the prompts,
you can only enable this option, you cannot specify a slice.
3. To define a time window, select one of the following options and specify
the dates or periods:
• All
• Between
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•
•
•

From
Until
Last Period

4. Select a gauge style from the "Render Style" list.
• Speedometer
• Thermometer
• Barometer
• Traffic Light
• Horizontal Traffic Light
• Vertical Traffic Light
The style icon changes to show the render style.
5. Depending on what you want to specify for the selected analytic, go to:
6. Click OK to save your configuration.
Related Topics

• Customizing the tooltip in the Gauge, Interactive Metric Trend and Metric
List analytics
• Customizing the graph options in a Gauge analytic
• Configuring the graph properties in a single metric, goal or universe query
Gauge analytic
• Defining a universe query for an analytic
• Prompt for a Metric in analytics using metric universes

Configuring the graph properties in a single metric, goal or universe
query Gauge analytic
For gauges based on a single metric or universe-based query, you configure
the graph properties in the analytic's creation or edit mode.
1. Set the boundaries.
The default zone boundary is set to Calculated automatically based
on metric values, which sets the zone based on the metric values. If you
want to narrow the range of metric values on the gauge, you set your own
zone boundaries by selecting Manually defined, and adding the from
and to settings.
2. Set the zone definition:
• Automatically split into equal sizes
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This setting causes the gauge zones to be three equal sizes.
•

Entered manually
You use the "Entered manually" zone definition option to set for each
zone color the gauge zones by value ranges. If you have set the
analytic boundary zones using "Manually defined", you can still include
the 'excluded' metric information in your color zone.
Note:

This option does not work well with sliders the 'excluded' metric
information would still be included in the range of values that you set
for sliders in Properties > General.
•

Entered manually as %
You use the "Entered manually as %" zone definition option to set for
each zone color the gauge zones by value ranges.

3. Change a zone color by clicking the zone and then the colored box below
it.
The custom color picker panel appears, from which you can select or
customize a new zone color.

Setting the navigation options for Gauge analytics
Note:

These steps do not apply to the Performance Model gauge analytics.
1. In the gauge's edit panel, expand Navigation Options.
2. Activate Display link to Metric Tree when available if you want to create
a link to one or more defined Metric Trees where the metric or goal defined
on a metric used in the gauge is the root metric in the Metric Trees.
For more information on Metric Trees, see the Performance Manager
documentation.
Note:

This option does not work with Gauges that use a universe query as the
data source.
3. If you want to link to a document on the Central Management Server,
click Browse and select the document.
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The name of the document appears in the text box as part of an
openAnalyic link. For information on openAnalytic and its variables see
the section on Linking from goal, universe query and metric-based
analytics.
4. If you want to link to more than one document on the Central Management
Server, click Multiple Links.
In the "Edit Navigation Link Menu" panel you can add as many links as
you want, as well as changing the order of the links as they appear in the
list box.

Customizing the graph options in a Gauge analytic
Use the graph options section of the gauge analytic edit panel to modify the
appearance of the gauge analytic.
1. In the gauge's edit panel, expand Graph Options.
2. For the title, use the metric name as the gauge title, the default option,
or activate Display text to type the name of your choice in the text box.
3. In the Display Options section, select the items that you want to appear
with the gauge:
• Dimension Slider
The dimension slider allows you to navigate between time periods on
a gauge. This option, when activated, causes the slider to appear at
the base of the Speedometer or Barometer, or next to the line in the
Thermometer or Traffic Lights.
•

Dimension Value
This option, when activated, causes the selected slider value to appear
just above the slider.

•

Metric Value - Previous Period
Select this option if you want for the number of the metric value's
previous period value to appear in the form of a second, slim needle
in the gauge.

•

Metric Value
Select this option if you want for the number of the metric value to
appear in the base of the Speedometer or Barometer, or next to the
line in the Thermometer or Traffic Lights.

•
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Goal Name
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Select this option if you want for the goal name to be displayed as a
tooltip on the Goal Value triangle.
•

Goal Value
Select this option if you want for the goal value to be displayed in the
form of a triangle on the outer rim of the Speedometer or Barometer,
or along the left side of the Thermometer or Traffic Lights.

4. To have a character in the gauge dial above the dimension or goal value,
enter a text string in "Symbol" box.
For example, if the dimension value is a dollar amount, you can type the
dollar symbol, $, in the box.
Note:

You do not need to activate any display options for the symbol to appear.
Related Topics

• Configuring a Gauge analytic using a metric, goal or universe query

Bubble Chart
A Bubble Chart analytic shows a complex comparison over time.
If you use sliced metric data, you use three sliced metrics, for example
revenue, margin, and market share, that share a dimension. For a universe
query analytic, you are prompted to select three measures and a dimension
that is common to the measures (for example, Country). You can also select
another common dimension as slider.

Configuring a Bubble Chart analytic
1. In the Bubble Chart edit panel select a data source from the "Select Data
to Display" section:
• Universe Query
• Metric Data
If you select Metric Data, select primary and secondary metrics, and
set the time window.
2. Set a limit on the slices.
3. In the "Graph Options" section, you need to set the title options.
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•
•

If you are using a metric, use its name for the analytic by activating
Use metric name.
If you are using a universe query or want to use a different name from
that of the metric, activate Display text and type the name in the text
box.

4. Set the navigation options.
Related Topics

• Setting the navigation options for the Bubble, Pie and Radar Charts and
Data Exploration analytics
• Defining a universe query for an analytic

Pie Chart
A Pie chart is useful if you want to show the proportional size of values that
make up a dimension over the time through a slider. This analytic is available
in Dashboard Builder's Data Exploration category.
A Pie Chart analytic shows the proportional size of a given metric by
displaying the proportional size of a given metric's dimensions (slices)
displayed over time (slider). For a universe query analytic you are prompted
to display a measure and its first dimension. You can also select another
dimension to use as the slider measure.

Configuring a Pie Chart analytic
1. In the Pie Chart edit panel select a data source from the "Select Data to
Display" section.
• Universe Query
• Metric Data
If you select Metric Data, select primary and secondary metrics.
•

If you select Prompt on a Metric, enter prompt text in the text box.

2. Set a limit on the slices.
3. If you are creating a metric prompt or using metric data, you also need
to select the time window.
4. In the "Graph Options" section, you need to set the title options.
• If you are using a metric or creating a metric prompt, use its name for
the analytic by activating Use metric name.
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•

If you are using a universe query or want to use a different name from
that of the metric, activate Display text and type the name in the text
box.

5. Optionally, set the navigation options.
Related Topics

• Defining a universe query for an analytic
• Prompt for a Metric in analytics using metric universes
• Setting the navigation options for the Bubble, Pie and Radar Charts and
Data Exploration analytics

Radar Chart
A Radar Chart analytic shows a comparison over time of several values for
a given sliced metric or a universe measure that should be homogenous,
and not change too much over time (for example, a ratio or market share).

Configuring a Radar Chart analytic
1. In the Radar Chart edit panel select a data source from the Select Data
to Display section.
• Universe Query
• Metric Data
If you select Metric Data, select primary and secondary metrics, and
set the time window.
2. Set a limit on the slices.
3. In the "Graph Options" section, you need to set the title options.
• If you are using a metric, use its name for the analytic by activating
Use metric name.
• If you are using a universe query or want to use a different name from
that of the metric, activate Display text and type the name in the text
box.
4. Optionally, set the navigation options.
Related Topics

• Defining a universe query for an analytic
• Setting the navigation options for the Bubble, Pie and Radar Charts and
Data Exploration analytics
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Data Exploration analytics based on metrics, metric
prompts and universe queries
The techniques in the Data Exploration anaytics are applied on top of
sequential measurements in general and time series in particular. The line
charts uncover cycles, trends or seasonality in a series thanks to smoothers,
curve fitting and transformations techniques. The Data Exploration analytics
harness the power of Xcelsius templates.
Dashboard Builder offers the following data exploration analytics:
•
•
•
•
•

Curve Fitting
Frequency Histogram
Lag Plot
Normal Probability Plot
Smoothing

Configuring a Frequency Histogram, Curve Fitting, Lag Plot,
Normality Probability Plot or Smoothing analytic
1. In the analytic edit panel, select the data you want displayed.
Option

Description

Metric Data

Metric Data allows you to select a metric on which you
can explore data.

Prompt for a
metric

Prompt for a Metric allows you to set up a prompt.

Universe Query Universe Query allows you to query a universe.

2. If you are using a sliced metric, activate Choose Slice and click Slices
to select the slices to include in the chart.
3. Choose the graph options.
4. Choose the navigation options.
5. Configure the custom parameters for the following:
• Frequency Histogram
• Curve Fitting
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•

•

Lag Plot: If you are configuring a Lag Plot analytic, you need to set
the lag period. Lag 1 means we plot a scatter of Yt against Yt-1. Lag
2 means we plot a scatter Yt against Y t-2.
Smoothing: If you are configuring a Centered Moving Average or Local
Regression Smoother analytic, you need to select from the "Smoothing
window size" list the number of points to see the immediate smoothing
effect on the data in a line chart. The larger the window, the smoother
the smoothing line.
If you are configuring a Moving Average Smoother analytic, you need
to select a moving average type. For information on moving averages,
see Moving averages explained in the Data Exploration terms.

Related Topics

• Prompt for a Metric in analytics using metric universes
• Defining a universe query for an analytic
• Graph options in data exploration analytics
• Setting the navigation options for the Bubble, Pie and Radar Charts and
Data Exploration analytics
• Frequency Histogram
• Custom parameters in a Frequency Histogram analytic
• Curve Fitting
• Custom parameters in a Curve Fitting analytic
• Lag Plot
• Normal Probability Plot
• Smoothing

Setting the navigation options for the Bubble, Pie and Radar Charts and Data
Exploration analytics
1. To link to the chart title and legend, activate Use Title/Legend as
hyperlink to go to, and click Browse to select the analytic.
2. To link to the data points on the chart, activate Use data point as
hyperlink to go to, and click Browse to select the analytic.
Related Topics

• Linking analytics and documents
• Configuring a Bubble Chart analytic
• Configuring a Pie Chart analytic
• Configuring a Radar Chart analytic
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Graph options in data exploration analytics
These steps apply to the Data Exploration analytics, which include:
• Frequency histogram
• Curve fitting
• Lag plot
• Normal probability
• Smoothing
Graph options
Option

Description

Use metric name

Use this option if you want the metric name to appear
as the title of the graph.

Display text

Use this option if you want to use a title that is different from the metric name.

Prompt for a Metric in analytics using metric universes
Prompt for a Metric in the "Select Data to Display" list of the analytic edit
panel allows you to set up a prompt that appears when the analytic is opened.
This prompt allows you to select any metric in the universe and always
defaults to the last metric selected using the prompt. You also enter the
prompt text. For example, if want to set up a prompt on a product line
universe, you can create a prompt that asks "What product line do you want
to see?"
The Prompt for a Metric option is available for Pie Chart, Gauge and Data
Exploration analytics.
Related Topics

• Configuring a Pie Chart analytic
• Configuring a Gauge analytic using a metric, goal or universe query
• Configuring a Frequency Histogram, Curve Fitting, Lag Plot, Normality
Probability Plot or Smoothing analytic
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Frequency Histogram
Organizations can use histograms in various areas of business. For example,
a human resources department can analyze the distribution of employees'
age and salary, a marketing analyst of a company can look at the number
of customers by tenure and lifetime value and a quality analyst at a car
company can study the variability of the braking distance in a new car model.
A Frequency Histogram analytic shows aggregated values (counts of data
points) on the vertical axis over data intervals on the horizontal axis. It does
not take the sequence of data points into account, so it can be used for
sequential as well as non-sequential data such as employee salary or
customer age.
It works well as part of a quadrant analytic that reveals different aspects of
a sequence of measurements that show the main features of a data set at
a glance.
The Frequency Histogram chart is interactive in that you can modify the
number of bars visible in the chart.

Custom parameters in a Frequency Histogram analytic
When you are configuring a Frequency Histogram analytic, you need to set
the custom parameters in the analytic edit panel.
Parameter

Description

Manual

Activate Manual to specify the number of bars.

Number of Histogram
Bars

Specify the number of bars that you want to appear
in the Frequency Histogram. See the section below
on deciding the number of histogram bars to help
you choose the number of bars.

Deciding on the number the histogram bars to show

The following table shows the best way to represent the distribution of a data
set as bars:
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Data set size

Number of bars

Less than 50

5 to 7

50 to 99

6 to 10

100 to 250

7 to 12

Histogram charts: a case study in manufacturing
At an automobile manufacturing plant, seventy cars are picked randomly
from the assembly line for quality control inspection. For each car, the braking
distance from the running speed of 35 mph to a complete stop is recorded.
The following table lists the braking distance measurements, in feet, that
were obtained from the inspection:
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39

54

21

42

66

50

56

62

59

40

41

75

63

58

32

43

51

60

65

48

61

27

46

60

73

36

38

54

60

36

35

76

54

55

45

71

54

46

47

42

52

47

62

55

49

39

40

69

58
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52

78

56

55

62

32

57

45

84

36

58

64

67

62

51

36

73

37

42

53

49

Seven intervals of equal size that cover all the data points from 21 to 84 are
defined; then the 70 data points are assigned to their respective intervals
and counted for each intervals as follows:
Interval number:

1

2

3

4

5

6

7

Interval limits:

(20-29)

(3039)

(4049)

(50-59)

(6069)

(7079)

(8089)

11

16

20

14

6

1

Number of data per
2
interval:

The graphical representation of the counts by interval in a bar chart gives
the following histogram:

N

70

Interval width

10.000
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Minimum

12.000

Maximum

84.000

Mean

52.300

Sigma

12.980

The histogram shows a nearly symmetric shape. Choosing an interval width
of 5 instead of 10 leads to a chart with more bars and a different shape.

N

70

Interval width

5.000

Minimum

12.000

Maximum

84.000

Mean

52.300

Sigma

12.980

Notice that the descriptive statistics (N, Minimum, Maximum, Mean and
Sigma) remain unchanged between the 10-bar histogram and the 5-bar
histogram. This is because they are based on the same individual data points;
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only the summary picture given by the chart is different due to the change
of intervals.
The following histogram uses intervals of 15.

N

70

Interval width

15.000

Minimum

21.000

Maximum

84.000

Mean

52.300

Sigma

12.980

From these examples we see that choosing the right interval’s width is
important to best represent the distribution of a data set.
To assess the symmetry of a data set it is recommended to use, in addition
to the histogram, a Normal Probability Plot plot, which is considered more
robust. Unlike the histogram that only shows aggregated counts, the Normal
Probability Plot displays the individual data points.
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N

70

Interval width

15.000

Minimum

21.000

Maximum

84.000

Mean

52.300

Median

53.500

Skew

0.0814

Standard Deviation

12.980

Coefficient Kurtosis

-0.2683

R2

0.9938

The graph is designed so that if the data follow a normal distribution, the
points appear as a linear pattern; a red-line can be fitted to the data to help
evaluate the normality.

Curve Fitting
You can use the following curve analytics to analyze trends:
• Simple trend curves
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•

S-shaped curves

When viewing the finished analytic, you have the option to change the custom
parameters from the analytic's interative menu.
Least squares

The Curve Fitting analytic uses the least squares method to estimate the
trend and S curves that best fit the metric values over time.
All curves are turned into a linear function of the form Y = a + b T.

S-shaped curves
S curves happen typically on cumulative sales of products plotted over time.
Fitting an S-shaped curve to the first few months or years of data enables a
company to estimate the maximum sales level for the product. It also helps
the user estimate how long it will take for sales to level off.
The following S curve variations are recommended:
•

Logistic
The logistic curve is often used to describe the sales growth of a new
product: an initial learning period when sales are low, rising rapidly as
sales spread through the population, and then slowing down as new
demand for the product reaches saturation point. The logistic curve is
also called the Pearl curve.

•

Gompertz
The Gompertz curve is a growth curve similar to the logistic curve but
unlike the Logistic curve it is not symmetric.

Related Topics

• What is the Gompertz curve?
• What is the logistic curve?

Simple trend curves
You can use the following simple trend curves for Curve Fitting:
•

Linear
The Linear curve shows the metric data with a straight line; appropriate
for data that changes by the same amount each period.

SAP BusinessObjects Dashboard Builder User Guide

123

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

•

Exponential
The Exponential curve attempts to fit the time series in a decreasing or
increasing curve; it works with data that increases or decreases at the
same rate for each period.

•

Power, Logarithmic, Hyperbola
The Power, Logarithmic and Hyperbola curves are similar to the
exponential curve, except that the rate of growth or decay follows a
different pattern.

Custom parameters in a Curve Fitting analytic
When you are configuring a Curve Fitting analytic, you need to set the custom
parameters in the analytic edit panel.
Parameter

Description
You can choose from the following:
• To create a simple trend curve use:
•
•
•
•
•

Curve
•

To create an s-shaped curve use:
•
•
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Linear
Exponential
Power
Logarithmic
Hyperbola
Gompertz
Logistic

Forecast Periods

Use this parameter to extrapolate metrics values
across future periods. Specify the number of periods
you want to forecast based on the fitted curve.

Use Last Periods

Use this parameter to apply the fitting to only the
most recent values and not all of the data points.

Limit (Logistic and
Gompertz)

Activate Limit to set an upper limit on the curve.
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Related Topics

• S-shaped curves
• Simple trend curves
• What is the Gompertz curve?
• What is a hyperbola curve?
• What is the logistic curve?
• What is an exponential curve?
• What is a power curve?
• What is a logarithmic curve?

Lag Plot
With the Lag Plot analytic you reveal patterns in sequential data (for example
in a time series) that may have been missed by looking at a line chart.
The Lag Plot is a scatter diagram that takes as an input one single series of
measurements and generates as output the following series:
•

Yt - the value at time t

•

Yt-l - the value at time t minus lag

The Yt-l value is plotted on the horizontal axis, while the Yt is plotted on the
vertical axis. By default the chart is displayed with lag=1. The user can
increase the lag from 1 to any integer that is less than the total number of
raw values.
A Lag Plot that shows results in the pattern of an oval is typical of sinusoidal
data, which cannot be seen in a line chart where the points go up and down
constantly.

Normal Probability Plot
The Normal Probability Plot is a scatter plot diagram in which, if the data set
is normally distributed, the data points follow a straight line. It does not
preserve the sequence of the data when dealing with sequential
measurements.
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Note:

The time sequence of the data points is totally ignored in the process of
building a Normal Probability Plot.
The y-axis of the graph represents the raw values of the measure, and the
x-axis shows z values based on ranking statistics. To get the x-axis values,
you compute the ranking statistic from the rank numbers, using one of several
methods:
• Midpoint ranking = (Rank - 0.5) / n
• Median ranking type I = (Rank -0.3) / (n+ 0.4)
• Median ranking type II = (Rank -3/8) / (n+ 1/4)
where n represents the total number of values in the data set.

Smoothing
Smoothing is a visualization technique that magnifies the underlying trend
or cycles of your data. In some time series, seasonal variation is so strong
that it obscures trends or cycles that allow you to understand the metric being
observed.
A smoother acts as a filter that removes seasonal variation or unusual values,
and makes long-term fluctuations in the series stand out more clearly. The
following standard techniques for smoothing time series data are available:
•
•
•
•

Centered moving average
Weighted moving average
Resistant smoother
Local regression smoother

Centered moving average
With the Centered moving average analytic you can smooth a sequence of
measurements to calculate the average value of an indicator over a moving
time window.
You select the number of points to see the immediate smoothing effect on
the data in a line chart. The larger the window, the smoother the smoothing
line.
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Local regression smoother
The local regression smoother is similar to the weighted moving average
technique except that, instead of computing the average of the data points
included in the moving time window, it fits a regression line to the data based
on the weighted-least-squares method.
Related Topics

• Moving Average Smoother

Resistant smoother
The resistant smoother applies multiple running medians to the data, therefore
the smoothed line is not contaminated by extreme values (also known as
outliers).

Moving Average Smoother
You can create the following types of weighted moving averages in the
Smoothing analytic:
•
•
•

2 x 4 Moving Average
MA Spencer
MA Henderson

For information on moving averages, see Moving averages explained in the
Data Exploration terms.

Data Exploration terms
What is an exponential curve?
An exponential relationship between variables X and Y means that Y data
changes by the same percent for a given absolute change of X.
The exponential curve equation is:
Y = a exp(bX)
where a and b are constants.

What is the Gompertz curve?
The Gompertz curve is an S-shaped growth curve similar to the logistic curve
except that it is not symmetric.
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The Gompertz curve equation is:
Y = L exp(-b exp(-k X) )
where L is the limit and b and k are constants.

What is a hyperbola curve?
A hyperbolic relationship between variables X and Y means that Y data
changes by the same absolute amount for a given absolute change of the
reciprocal of X. The hyperbolic curve equation is:
Y = a + (b/x)

What is a logarithmic curve?
A logarithmic relationship between variables X and Y means that Y data
changes by the same absolute amount for a given percent change of X. The
logarithmic curve equation is:
Y = a + b ln(X)
where a and b are constants and ln is the natural logarithm.

What is the logistic curve?
The logistic curve, also known as the Pearl curve, is an S-shaped symmetric
growth curve.
The logistic curve is often used to describe the sales growth of a new product,
an initial learning period when sales are low, rising rapidly as sales spread
through the population and then slowing down as new demand for the product
reaches saturation point.
The logistic curve equation is:
Y = L / ( 1 + a exp(-b X) )
where L is the limit and a and b are constants.

Moving averages explained
What is the moving average?
In data analysis, you use the moving average to calculating the average
value of an indicator, over a period of time. In some time series, seasonal
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variation is so strong it obscures any trends or cycles, which are very
important for the understanding of the process being observed.
Moving average may be used as a smoothing method that removes
seasonality and makes long-term fluctuations in the series stand out more
clearly. It may also be used for forecasting purposes.

Moving average transformations
Transformation

Use

MA 2x12

If your time series is monthly, use the MA 2x12 to remove the seasonality.

MA 2x24, MA 2x36

If a stronger "seasonality filter" is required, use MA
2x24 or MA 2x36 for monthly series.

MA 3x3, MA 3x9,
MA 3x5

Also known as a double moving average, this moving
average that is taken of a series of data that already
represents the result of a moving average.

MA exponentially
weighted

A moving average transformation. Henderson’s MA is
another centered symmetric weighted moving average
method. The 5- and 7-point averages are used for
Quarterly series. The 9-, 13-, and 23-point averages
MA henderson 9-pt,
are used for Monthly series.
13-pt, 23-pt

Note:

All the moving average methods are externalized in a
file (Stats.ini) that can be customized.
MA linearly weighted
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Transformation

Use

MA linearly weighted center

MA same months

This same months moving average method uses a
fixed-interval time window but with non-continuous
data points. It is useful on seasonal data for smoothing
or forecasting purposes.

MA spencer 15-pt,
21-pt

The Spencer’s weighted moving average is an approach to computing a moving average that will compensate for a cubic trend in the data. It consists of two
averages, one for 15 periods and the other for 21 periods. Spencer’s weights are centered and symmetric.

Related Topics

• MA exponentially weighted
• MA linearly weighted
• MA linearly weighted center

MA exponentially weighted
A moving average transformation. An MA exponentially weighted
transformation finds the number of points parameter required. The smoothing
constant parameter is required:
• Less than 1 weights current data more heavily
• Equal to 1 weights every points identically (same as simple MA)
• Greater than 1 weights old data more heavily
The Single exponential smoothing (SES) forecast can be expressed as a
weighted moving average that applies exponentially decreasing weights to
the data, as the observations get older. Thus it is called exponential
smoothing.
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The next period forecast is then:
Ft+1 = aYt+a(1 - a)Yt–1 + a(1 - a)²Yt–2 + a(1 - a)³Yt–3
+ … + a(1 - a)^ t–1 Y1+a(1 - a)^ t F1
where a is a constant between 0 and 1, and F1 is the initial value that usually
is given the value of Y1.
As a guide in choosing a, try values close to 0 if the series has a lot of random
variation. If you wish the forecast values to depend strongly on recent
changes in the actual values, try values close to 1.

MA linearly weighted
A moving average transformation. You use a weighted moving average to
give more weight to current data. Weights can be calculated automatically
using a function.
The weight function for a Linearly weighted MA is defined as:
W(p)=(2/n(n+1)) p
where p is the sequence of the data points in the moving window ranging
from 1 to n. The weights must sum to a value of one.
The weight function for a exponentially weighted MA is defined as:
W(p)=power(a,n-p)
where a is the smoothing constant and p is the sequence of the data points
in the moving window ranging from 1 to n.
Smoothing constants less than 1 weigh recent data more heavily. A smoothing
constant of 1 gives equal weight to each point. If the smoothing constant
exceeds 1, older data are weighted more heavily than recent data.

MA linearly weighted center
A moving average transformation. A centered weighted moving average,
also known as a double moving average, is a moving average that is taken
of a series of data that already represents the result of a moving average.
With a centered weighted moving average, the majority of the weight is
assigned to the middle portion of the data. A centered weighted moving
average is useful to de-seasonalize the data.
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If your time series is quarterly, use the MA 2x4. If stronger “seasonality
filters ? are required, use MA 2x8 or MA 2x12 for quarterly series.

MA centered
A moving average transformation.
Related Topics

• What is the moving average?

What is single exponential smoothing?
Single exponential smoothing (SES) is a forecasting method that works best
for data which have no trend, no seasonality, or underlying pattern. It takes
the forecast for the previous period and adjusts it using the forecast error.
If Yt is the actual observation for period t and Ft is the forecast for the same
period, then the forecast for the next period is:
Ft+1 = Ft+a(Yt–Ft)
where a is a constant between 0 and 1.
An SES analytic is based on the time series system universe. The SES
weight function is built into the universe. The end user can try different values
of the smoothing constant in order to find the best one.
Related Topics

• MA exponentially weighted

What is a power curve?
A Power relationship between variables X and Y means that Y data change
by the same percent for a given percent change of X. The Power curve
equation is:
Y = a Xb
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Goal and strategy analytics in Performance Manager
Performance Manager offers the following goal analytics:
•
•
•
•
•
•
•
•

Goal
Goal Subscription
Map
Metric List
Metric Tree
Metrics Overview
Pareto
Strategy Map

Goal
The goal analytic shows the metric trend, deviation, or cumulative deviation
curve over a period of time or across tolerance zones for a goal.

Configuring a Goal analytic
1. In the goal analytic edit panel, expand Select Goal to display.
2. Select a universe and then a goal from its list.
3. In the "Graph properties" section, select a goal view:
• Select Variance to see the variance of the metric values from the
goals values over time or across GYR zones.
• Select Deviation to show the cumulative deviation curve over a period
of time or across GYR zones.
4. To set a hyperlink on the analytic's title to an analytic in the Central
Management Server, activate Use title as hyperlink to go to, click
Browse, and navigate to the analytic.
The hyperlink text appears in the text box in an openAnalytic text string.
You can edit this text string. For information on openAnalytic, see the
Linking from goal, universe query and metric-based analytics section in
the documentation.
5. To plot the actual goal values for the periods, select Show goal trend.
Default chart lines shows variance of metric value over time.
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6. To display the acceptable, tolerance, and unacceptable zones in green,
yellow and red respectively in the goal analytic, select Show GYR zones
in the background.
7. To display goal achieved as a percentage instead of as an absolute value,
select Show percent of goal.
8. Under Time window, select one of the following options for the time slider:
• Show all goal span
Select this option to display the goal span defined during goal creation.
•

Show only the last x metric values in goal span
If you select this option, you need to choose a value from the
drop-down list.

Goal Subscriptions
The Goals Subscriptions analytic displays the "My Goals" list of goals to
which a user is subscribed.
This is the same goals list that can be viewed in Strategy Builder > Home
> Items Assigned.

Configuring a Goal Subscriptions analytic
You need to have goals assigned to your role in Performance Manager,
otherwise the Goal Subscriptions list will be empty.
1. In the goal subscription edit panel, expand Desired Entry-Selection
Behavior and select one of the following options:
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Option

Description

Display associated insight in viewer

Select this option if you want the goals in the list
to link to their respective insight tabs.

Display associated ana- Select this option if you want the goals in the list
lytic in viewer
to link to their default analytic.
Nothing - Do not allow
selection of scorecard
entry

If you select this option, there is no link on the
goals in the list.

2. In the "Default Group By" section, select how you want the list sorted.
3. In the "Attribute columns to display" section, select one of the following
options:
Option

Description

Display simple column Select this option to limit the goals subscription
list: Name, Trend and list to columns for the goal name, trend arrow and
Status
status icons.
Add Target, Actual and Select this option to have not only the goal name,
Variance
trend, and status, but also information on the goal
target value, actual goal value, and the variation
of the goal from the target value.

4. Click OK to save your changes.

Map
Map analytics display geographical indicators, for example, revenue for each
country or sales of every state. A map analytic can display data from sliced
metrics, universe queries or performance models.
You can drill into the maps for more detailed information. For example, if you
use a map of the United States with details on the overall country revenue
and click on a state, for example Nebraska, the state and its revenue appear.
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Configuring a Map analytic
These steps help you create a Map analytic using sliced metrics and universe
queries.
1. In the map analytic edit panel "Select data to display" section, select a
map.
2. Select an item from "Match map object by" that sets up the match between
the analytic and the universe classification.
• Name
Name represents, for example, in the state classification, CA, AZ and
NV.
•

Long Name
Long Name represents, for example, in the same state classification,
California, Arizona and Nevada.

•

Code
Code represents, for example, in the same state classification, 06, 04
and 32.

3. Select the origin of the data:
• Use a sliced metric
• Use a Universe
4. In the "Map properties" section, enter the number of ranges that you would
like the map to have.
5. To specify the color for each range, select the range and specify the color.
You can either enter the color code directly or click Palette to pick a color
from the color palette.
6. Specify the range boundaries.
This can be done automatically or you can set it manually. If you select
Manually set ranges, you also need to specify the range percentage.
7. Set the graph properties.
8. Set the navigation options.
9. In the "Time Window" section, you need to set the time period.
• If the map is based on a sliced metric, you need to specify the number
of periods.
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•

If the map is based on universe objects, you need to choose from
"Last" and set the calendar unit, or period, or "From" and specify
specify the beginning and ending dates and times.

Related Topics

• Selecting universe objects for a Map analytic
• Selecting a sliced metric for a Pareto Chart or Map analytic
• Setting graph properties for Map analytics
• Setting navigation properties in a Map analytic

Selecting a sliced metric for a Pareto Chart or Map analytic
Before you select a sliced metric, you need to have a universe where the
dimensions are defined in a hierarchical manner. If you do not do this, the
message 'Can't find the appropriate metric' appears appears when you try
to drill down a map because the analytic does not know where to drill into.
1. In the pareto chart or map edit panel, expand Select data to display,
then select Use a sliced metric.
2. Click Select Metric.
3. In the "Select a metric" dialog box, click the drop-down arrow next to the
list box and then select a subject area (or class) from the list.
4. Select a metric.
Note:

Only sliced metrics are displayed.
5. Click OK.
The name of the selected metric is displayed in the Metric box.
Related Topics

• Configuring a Pareto Chart analytic
• Configuring a Map analytic

Selecting universe objects for a Map analytic
These steps help you create a Map analytic using sliced metrics and universe
queries.
1. In the map analytic edit panel, expand Select data to display, then select
Use a Universe.
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2.
3.
4.
5.

Click Select objects.
In the "Select objects" dialog box, select a "Subject Area" from the list.
Select a measure.
Select the classification.
This is a dimension from the universe.

6. Select an aggregation method.
7. Select a dimension hierarchy.
8. To add filters, click the filter you want in the left pane and then click >>
to add it to the query definition.
9. Click OK to return to the edit panel.
Your selections appear in the "Select data to display" section.
Related Topics

• Configuring a Map analytic

Setting graph properties for Map analytics
The graph properties details how the map appears in the analytic. These
steps help you create a Map analytic using sliced metrics and universe
queries.
1. In the "Graph properties" section of the map analytic edit panel, configure
the title.
• Use map name
Use this option if you want the title of the analytic to be taken from the
map you selected in the "Select data to display" section.
•

Use metric name
Use this option if you want the metric name to be used for the analytic's
title.
Note:

This option is not available if you selected Use a Universe in the
"Select data to display" section.
•

Display Text
Use this option if you want to use a different name for the analytic.
Type the name of the analytic in the text box next to "Display Text".
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2. If you are using a sliced metric for your map and want to show the metric
as a legend, activate Show legend.

Setting navigation properties in a Map analytic
These steps help you configure the link between a Map analytic that uses
sliced metrics and universe queries and another analytic. You can pass a
prompt to another analytic but not the other way around. For example, from
the Map analytic you can go to Interactive analytic but from the Interactive
Metric Trend analytic you cannot return to the Map analytic.
1. In the map analytic edit panel, if you want to link to another analytic,
activate Select an analytic to link to and click Browse to select an
analytic.
You use this option to pass a variable to another analytic.
2. To link to an analytic from any location from the map, activate Select an
Analytic to link to from individual map locations and click Browse to
select an analytic.
For example, if you click on the title of a US map representing all states,
you can open a document/analytic and pass the value United States.
When you click on a state, you can drill-down to another map or you can
open a document/analytic and pass the value CA or California.
3. Click OK.
The analytic name is displayed in the field. You can modify the
openAnalytic text string. See see the Linking from goal, universe query
and metric-based analytics section in the documentation for more
information.

Selecting the time window in a Map analytic
You can specify the data for the last certain time period. Like last few minute,
hour, day, month and year or you can specify the time period from and to.
1. In the map analytic edit panel, expand Time Window.
2. Select a time period from the drop down or define the number of time
periods you want included in the data.
3. Click OK.
Related Topics

• Configuring a Map analytic
• Setting graph properties for Map analytics

SAP BusinessObjects Dashboard Builder User Guide

139

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

• Setting navigation properties in a Map analytic

Metric List
A metric list provides a customized view of metric and goal data. This flexible
analytic allows you to build a list of metrics under a folder or just a flat list of
metrics. You can specify what you want to see in the metric list. That
information can be:
•
•

specified metrics
extra information related to metrics, for example metric name, metric
value, goal, goal status

Note:

The user interface for this analytic has been modified to comply with the
Section 508 guidelines.

Configuring a Metric List analytic using metrics and goals
1. In the "Select Metrics/Goals to display" section of the metric list analytic
edit panel, click Add.
Note:

You can also remove and rename items and add filters on sliced metrics
in the list. To better organize your list, you can add folders and place the
items in the folders using the up and down icons.
2. Customize columns.
3. Customize the tooltips.
4. In "Navigation Options", activate Display link to Metric Tree when
available if you want to create a link to one or more defined Metric Trees
where the metric or goal defined on a metric used in the metric list is the
root metric in the Metric Trees.
For more information on metric trees, see the Performance Manager
documentation.
5. If you want to link to a document on the Central Management Server,
click Browse and select the document.
The name of the document appears in the text box as part of an
openAnalyic link. For information on openAnalytic and its variables see
the section on Linking from goal, universe query and metric-based
analytics.
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6. If you want to link to more than one document on the Central Management
Server, click Multiple Links.
In the "Edit Navigation Link Menu" panel you can add as many links as
you want, as well as changing the order of the links as they appear in the
list box.
Related Topics

• Customizing columns in Interactive Metric Trend and Metric List analytics
• Customizing the tooltip in the Gauge, Interactive Metric Trend and Metric
List analytics

Customizing columns in Interactive Metric Trend and Metric List
analytics
Note:

These steps apply to the Interactive Metric Trend and Metric List analytics
that use goal, metric and universe query data sources.
1.
2.
3.
4.

In the analytic edit panel, expand Customize Columns.
From the "Available Items" list, select the columns to view and click >>.
To rename a column, select the column in a list and click Rename.
To customize the view you can also select:
• Show Header
Select this option to display a header.
Note:

No header is added for folders.
•

Remove Duplicate
Use this option to avoid duplicating data. Metrics can have several
goals associated, however when this option is selected, all data related
to a metric is displayed only once.

•

Gray background every other row
Use this option to display a gray background every other row. This
action makes the list easier to read.

Related Topics

• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries

SAP BusinessObjects Dashboard Builder User Guide

141

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

• Configuring a Metric List analytic using metrics and goals

Customizing the tooltip in the Gauge, Interactive Metric Trend and
Metric List analytics
You use the tooltip to display additional information on an analytic.
Note:

These steps apply to the Interactive Metric Trend, Gauge and Metric List
analytics that use goal, metric and universe query data sources.
1. In the analytic edit panel, expand Customize Tooltip.
2. Select an item in the "Available Items" box and click >>. Repeat this step
as much as necessary.
3. If you selected an item in error, highlight it in the right-hand box and click
<<.
Note:

To rename an item, click Rename.
Related Topics

• Configuring an Interactive Metric Trend analytic using on goals, metrics
and universe queries
• Configuring a Metric List analytic using metrics and goals
• Configuring a Gauge analytic using a metric, goal or universe query

Metric Tree
You use the Metric Tree to see the relationships in complex business
situations. You define a Metric Tree in Performance Manager using models
made of metrics, monitors and dimensions, and configure a Metric Tree
analytic from InfoView or Dashboard Builder.
You can create a Metric Tree that shows one of the following:
•
•
•
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the relationship of a derived metric
a hierarchy based on a metric and a dimension or the metric itself
a freeform relationship that you define
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Understanding the Metric Tree box
In a Metric Tree each box contains an item in the model. This box offers the
following information:
•

In the title bar:
• On the left: Fold and unfold icons (+/-)
• On the right: Icons that allow you to check the metric trends, see the
goal status, open up related documents and go to a different metric
tree, and view status flags.
• When you hover the mouse over the title, a tooltip shows the goal
name, status, target value and variance.

•

In the information section:
• the value of the metric
• the percent of change
• the goal target value

Configuring the Metric Tree analytic properties
1. In the metric tree analytic edit panel, select a tree from the Select tree
to display list.
2. Specify a default goal type if necessary.
3. Configure the graph properties.
4. Configure the box title.
5. In the "Box Content" section, click Add to select fields for the list.
To remove a field from the list, select it and click Remove. To rename a
field, select it from the list, click Rename and type the new name.
To modify the position of the fields in the list, use the up and down icons
located above the list box to the right.
Note:

The more fields you add, the larger the result metric tree box must be. If
you have a lot of metrics, then your tree will be very crowded. It is
recommended to pick no more than three of the most important metric
fields for the box content, and then choose the remaining metric fields as
tooltips.
6. To edit the box color, either type in the name of the color, or click Palette
to select from the color picker. If instead you want for the box status color
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to indicate the status of the metric tree's goal, activate Fill with goal
status color.
Note:

The default box color is white.
7. In the "Box Tooltip", click Add to select fields for the list.
To modify the position of the fields in the list, use the up and down icons
located above the list box to the right.
8. In the "Time Window" section, select Show last period to show data of
the last metric refreshed period.
9. To choose a period other than the last metric refresh, select Select
specific period and specify the period.
Related Topics

• Configuring the graph properties in a Metric Tree analytic
• Configuring the box title in a Metric Tree analytic
• Fields that can be used in Metric Tree and Strategy Map analytics

Configuring the box title in a Metric Tree analytic
1. In the metric tree analytic edit panel, expand the "Box Title" section and
select the field that acts as the box title.
2. If you want to link a box to an analytic in the Central Management Server,
select Attach an analytic to each box and click Browse to navigate to
the analytic. If you want to attach more than one analytic to the box, click
Multiple Links.
An openAnalytic link appears in the text box. You can edit this text. For
information on this, see the Linking from goal, universe query and
metric-based analytics section.
3. If you want to see a red flag icon next to the box title when at least one
sub-node is in danger, activate Show warning sign.
4. If you want to see a goal status icon next to the box title, activate Show
goal status.
5. If you want to see a metric trend icon next to the box title, activate Show
metric trend.
Related Topics

• Configuring the Metric Tree analytic properties
• Configuring a goal-based Strategy Map analytic
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• Fields that can be used in Metric Tree and Strategy Map analytics

Configuring the graph properties in a Metric Tree analytic
1. In the metric tree analytic edit panel, expand Graph Properties and select
Vertical Tree or Horizontal Tree.
The vertical tree displays the metric tree elements as top-down, whereas
the horizontal tree displays the metric tree elements from left to right.
Tip:

If you have more than a few metrics for each level, the horizontal tree
displays the data better.
2. Select a title for the metric tree analytic.
• Select Use tree title if you want to use the name of the metric tree as
the title of the analytic.
• Select Display text if you want to create your own analytic title, and
type the title in the text box.
3. To set a hyperlink on the analytic's title to a document on the Central
Management Server, activate use title as hyperlink to go to, then
Browse to select the document.
When you select the document and click OK, the hyperlink text appears
in the hyperlink text box in the form of an openAnalytic string. For
information on editing this string, see the section on Linking from goal,
universe query and metric-based analytics.
4. To set a background image on the metric tree analytic, activate Show a
background image, then Browse to select the image file.
5. Select the arrow format.
6. Select the maximum amount of levels on a page.
Note:

The box height depends not only on the amount of fields that you include
in the box, but also the number of levels and unfolded levels you set on
a metric tree. The greater the amount of levels, the smaller the tree and
its boxes are.
7. Select a line style.
8. Select the number of unfolded levels.
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Note:

The boxes shrink as levels are unfolded in an analytic.The greater the
amount of levels, the smaller the tree and its boxes are. You should use
this option sparingly.
9. Select the box width.
10. To show the metric tree with the root metric at the bottom of the analytic,
select Show root last.
By default, the root metric is diplayed at the top of the analytic and
branches down to other metrics.
Related Topics

• Configuring the Metric Tree analytic properties

Fields that can be used in Metric Tree and Strategy Map analytics
The following table shows the fields you can choose to provide information
in a metric tree or strategy map analytic via box titles (metric tree only),
contents and tooltips.

Field

Description

Metric
Box ConTree Box
tents
Title

% Achievement Displays the percent of
of Goal
goal achievement

X

X

% Change

Displays the percent of
change of the metric
from the previous period

X

X

% Variance
from Goal

Displays the goal variance divided by the
goal's target value

X

X

X

X

Displays the name of
Calendar Name the calendar associated X
to the metric
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Field

Description

Change

Displays the change of
the metric from the previous period

Goal Name

Displays the name of
the goal

Goal Target
Value

Metric
Box ConTree Box
tents
Title

Box
Tooltips

X

X

X

X

Displays the goal's target value

X

X

Goal Target
Value - Previous Period

Displays the goal's target value for the previous period

X

X

Goal Target
Value - Previous Year

Displays the goal's target value in the previous year

X

X

Goal Trend

Displays the goal's
trend using an trend arrow

X

X

Goal Type

Displays the goal type

X

X

Goal Variance

Displays the metric actual value minus the
goal target value

X

X

Last Metric Peri- Displays the latest metod
ric period

X

X

Long Description

Displays the metric description

X

X

Lower Tolerance

Displays the lower limit
of the goal tolerance

X

X

X
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Metric
Box ConTree Box
tents
Title

Description

Measure

Displays the name of
the measure associat- X
ed to the metric

X

X

Metric Code

Displays the metric
code, which is part of
the definition of the
metric

X

X

X

X

X

X

X

Metric Last Re- Indicates the last occurfresh
rence of metric refresh
Metric Name

Displays the name of
the metric

Metric Owner

Displays the name of
the metric owner

X

X

Metric Trend

Displays the metric
trend using a trend arrow

X

X

Metric Unit

Displays the unit associated to the metric

X

X

Metric Value

Displays the value of
the metric

X

X

Displays the value of
Metric Value the metric compared to
Previous Period
the previous period

X

X

Displays the value of
the metric compared to
the prevous year

X

X

Metric Value Previous Year
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Field

Description

Metric
Box ConTree Box
tents
Title

Box
Tooltips

Displays the value for
Previous Metric
the metric's previous
Period
period

X

X

Previous Year
Metric Period

Displays the value for
the metric's previous
year

X

X

Set

Displays the name of
the set associated with X
the metric.

X

X

Set2

Displays the name of
the second set associated with the migration
metric

X

X

Slice Name

Displays the name of
the slice

X

X

X

Subject

Displays the name of
the subject associated X
with the metric

X

X

Subset

Displays the name of
the subset associated
with the metric

X

X

Upper Tolerance

Displays the upper limit
of the goal tolerance

X

X

X

Metrics Overview
The Metrics Overview analytic provides you with a current snapshot on the
list of available sets. In addition to the membership of each metric that has
been defined for the set or group, this analytic also provides data for Joiners,
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Stayers, and Leavers in the Metric Status List. It also provides important
metadata associated with the chosen set.
The data available in the Metric Overview is a good starting point for
acquainting yourself with the status of sets, groups, metrics as well as for
making decisions regarding which metrics to add.

Configuring a Metrics Overview analytic
1. In the metrics overview edit panel, select sets to list in this analytic.
2. In the "Navigation Options" section, to put a hyperlink on the set name
to an analytic on the Central Mangement Server, activate Use set name
as hyperlink to go to and click Browse to navigate to the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
3. To hide the trend chart, activate Do not display an automatic trend
when clicking on a chart component.
when this option is deactivated, you can select an item in the chart list,
and its metric trend chart appears. This option is useful if you want more
space in the list for columns.
4. To set an hyperlink on data points to an analytic on the Central
Mangement Server, expand the "DataPoint Navigation options" section,
and activate Use data point as hyperlink to go to and click Browse to
navigate to the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
5. In the "Display Mode" section, select a mode.
6. In the "Time Window" section, select a window from the drop-down list.
Related Topics

• Choosing a set metric for the Metrics Overview, Membership, Migration or
Multi-Set Same Time Events analytic
• Analytic display modes
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Choosing a set metric for the Metrics Overview, Membership,
Migration or Multi-Set Same Time Events analytic
Note:

If you are configuring a metrics overview analytic, you can also select metrics
without sets.
1. In the analytic edit panel, expand Choose the sets to list in this analytic.
2. Select the set you want to include:
• All available sets
• All sets in these subject areas
If you select this option, choose the subject areas from the pane on
the right.
•

These specific sets
If you select this option, choose sets by selecting them in the left pane
and adding them to the right pane.

3. If you selected These specific sets, add a prompt by clicking Add under
the "Selected Sets" list box.
Related Topics

• Configuring a Metrics Overview analytic
• Configuring a Membership, Migration or Multi-set Same Time Events analytic

Pareto Chart
A Pareto chart analytic follows the Pareto principle, also known as the 80-20
rule, that you only need 20% of your resources to solve 80% of your problems.
With this analytic you can track a metric over a dimension like time. The
pareto analytic takes advantage of the Business Objects Enterprise metric
engine's OLAP capabilities for computation and drill.
The Pareto chart is useful to help set priorities among a number of problems
or a number of causes by arranging data graphically in descending order of
frequency. Slices are represented as vertical bars. A line indicates when the
threshold is reached. The pareto chart can be used to display data from a
metric or from a universe. You can use metric periods to create multiple
pareto charts over time.A Pareto chart is a type of histogram in which bars
are arranged in descending order, so that the left most bars on the chart
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should receive highest priority attention. It includes a cumulative curve that
represents the added contribution of each category (for example, bar).
Pareto Chart is often used as a problem-solving tool for quality improvement.
It helps you sort out the few really important defects from the more numerous
but less important ones. It is a simple and very useful tool applicable to
various areas. Use the pareto chart in the following types of situations:
•
•

To identify problems or defects that occur frequently. It can be applied to
measures like Complaints, Returned items or Repairs.
To identify the causes of greatest cost in order to improve the financial
bottom line.

The analytic has the following components:
•

Chart Bar
The Pareto Chart bar offers the following features:
• tooltip
When you hover the mouse arrow over a chart bar, you see a tooltip
that indicates the name of the item, its values and its current and
cumulative percentage.
•

drill
When you right-click on a chart bar, you can choose to drill down or
up one level. For example, if you have location as a dimension and it
is set to the 'region' level, you can drill up to 'country' or down to 'city'.

Note:

When you right-click on a chart bar, you can show the members of the
items included in the "Others" category. The "Others" category
summarizes in one bar all of the members that not shown as separate
bars on the Pareto.
•

Slider
Use the slider to show the data for a metric based on the dimension that
you have assigned to the analytic. You can also use the slider to expand
or reduce the range of data shown.

•

Legend
The legend shows the title for each item displayed in the analytic. If you
have more than one graph visible at one time, you can select an item in
the legend, and that item is subsequently highlighted on any graphs in

152

SAP BusinessObjects Dashboard Builder User Guide

Using analytics for analysis
Analytics that can be created in Dashboard Builder

which it appears, including the instances when the item might be included
in an 'Others' category.
•

Cumulative sum line
The cumulative sum line is a red line with data points that offers a visual
representation of the cumulative sum. The data points have a tool tip that
shows the actual amount.

Configuring a Pareto Chart analytic
1. In the pareto chart edit panel, select the data you want to display:
• if you activate Use a sliced metric:
Click Select Metric to choose a sliced metric.
•

if you activate Use a Universe:
Click Select objects to choose the objects from a universe.

2. Set the graph properties.
3. Set the time window for the chart.
• For a chart based on a sliced metric, you need to define the periods.
• For a chart based on universe objects, select from one of the following:
• "Last"
If you select this option, you need to set the calendar unit and
period.
•

"From""To"
Specify the beginning and ending dates and times.

4. Click OK to save your changes.
Related Topics

• Pareto Chart
• Selecting a sliced metric for a Pareto Chart or Map analytic
• Selecting universe objects for a Pareto Chart
• Setting the graph properties for a Pareto Chart
• Defining the time period for a Pareto Chart based on a sliced metric
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Selecting universe objects for a Pareto Chart
1. In the Pareto Chart edit panel, expand Select data to display, then select
Use a Universe.
2. Click Select objects.
3. In the "Select objects" dialog box, configure the following:
• Select a subject area.
Note:

Only Enterprise subject areas are displayed.
•

Select a measure. This information is used for the pareto chart's Y-axis.

•

Select the classification.
This is a dimension from the universe and is used for the pareto chart's
X-axis.

•

Optionally, select a dimension from "Pareto for each".
If you select a dimension, the analytic shows one pareto chart for each
value of the dimension.

4. To add filters, click the filter you want in the left pane and then click >>
to add it to the query definition.
5. Click OK to return to the edit panel.
Your selections appear in the "Select data to display" section. You can
modify your selections in this section.
Related Topics

• Configuring a Pareto Chart analytic

Defining the time period for a Pareto Chart based on a sliced metric
Sliced metrics are defined over a period of time and therefore you can view
them based on time. You can either view the history of the metric over a
specified time period or specify the last number of periods.
1. Expand Time Window.
2. Click the appropriate option button:
• All history
Select this option to display results for metrics for all periods
•
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Select this option to display results for a period you specify from the
drop-down list
3. Click OK to save the analytic, or make other edits.
Related Topics

• Configuring a Pareto Chart analytic

Setting the graph properties for a Pareto Chart
You can specify how you want to view Pareto charts and you can create
links to other documents from the Pareto chart title.
1. In the Pareto Chart edit panel, expand Graph properties.
2. Type the title you want to appear on the chart into the "Title" box.
3. If you want the title of the pareto chart to link to another document with
related data, select Use title as hyperlink to go to, click Browse and
select the destination document, then click OK.
4. In the "Number of Pareto bars" box, type or select the number of bars
you want to include in the chart.
5. Enter the number of charts you want in the window display.
Note:

You can have a maximum of five charts displayed. Each chart corresponds
to a period of the selected metric.
6. If you want to show the scale as percent instead of unit, select Show
scale in percent.
7. If you want to show the cumulative curve, select Show cumulative curve.
8. If you want to show legends, activate Show legend.
Note:

The Others bar is composed of a group of items (for example, causes),
each of which is smaller than the smallest individual bar. It is always
placed last, no matter how large it is.
Related Topics

• Linking analytics and documents
• Pareto Chart
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Strategy Map
A strategy map is a diagram that provides an overall view of the strategic
priorities of an organization. It is a model of how an organization creates
value.
The concept of strategy maps was introduced by Kaplan and Norton, who
developed the Balanced Scorecard methodology.
Strategy Maps allow you to:
•
•
•
•
•
•

map high-level targets
define and communicate its strategic objectives by linking specific
objectives in cause-and-effect relationships
draw cause and effect linkages between goals
indicate whether the current metric shows un upward or downward trend
and link the indicator to more information on trends over a period
link to an analytic that provides more detailed information related to the
metric
position goals on a background image that represents the perspectives
that shape corporate strategy

The Strategy Map interface offers the following features:
•
•
•
•
•

a Free Form layout that does not need to follow a tree structure
configurable content
the ability to visually define the relationships between goals
text items that can enhance the map contents (for example the Strategy
Map title or a comment)
the ability to include informational text as part of a mouse-over object

Configuring a goal-based Strategy Map analytic
1. In the strategy map analytic edit panel, select a universe from the
drop-down list.
The goals attributed to the universe appear in the list box below.
2. To add a goal to the strategy map, click and drag a goal from the list box
onto the strategy map layout area to the right.
Repeat this step as necessary.
3. Add text items.
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4. To add a help item, click Add Help Item, type the help text in the text
box, and click OK.
Repeat this step as necessary.
5. To edit the strategy map analytic options, click Options.
6. Configure the graph properties.
7. In the "Box Content" section, click Add to select fields for the list.
To remove a field from the list, select it and click Remove. To rename a
field, select it from the list, click Rename and type the new name.
To modify the position of the fields in the list, use the up and down icons
located above the list box to the right.
Note:

The more fields you add, the larger the result strategy map box must be.
If you have a lot of metrics, then your map will be very crowded. It is
recommended to pick no more than three of the most important metric
fields for the box content, and then choose the remaining metric fields as
tooltips.
8. To edit the box color, either type in the name of the color, or click Palette
to select from the color picker. If instead you want for the box status color
to indicate goal status, activate Fill with goal status color.
Note:

The default box color is white.
9. In "Box Tooltip", click Add to select fields for the tooltip.
To modify the position of the fields in the list, use the up and down icons
located above the list box to the right.
10. In the "Time Window" section, select Show last period to show data of
the last metric refreshed period.
11. To choose a period other than the last metric refresh, select Select
specific period and specify the period.
To remove an item from a strategy map, highlight it and press Delete on
your keyboard.
Related Topics

• Configuring text items in a goal-based Strategy Map
• Configuring graph properties in a Strategy Map
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Configuring graph properties in a Strategy Map
These steps apply to Strategy Maps that use Performance Manager goals.
1. Expand Graph Properties in the strategy map analytic edit panel.
2. Select a box outline format:
• Select Rectangle for the box content to appear in a rectangle box.
• Select Oval for the box content to appear in an oval.
• Select None if you want the box content to appear without a
background color or border.
Note:

If you select this option, the color fill setting and Fill with goal status
color are not available. In addition, a background image will be visible
behind the box text. If the background image is dark, the box text will
not be visible.
3. Select a box width.
4. To set up a background image, activate Show a background image,
click Browse to navigate to the image, and select a zoom percentage to
fit the image to the strategy map.
5. Specify the location of the icons in the strategy map boxes.
6. To have the trend icon appear in the box, activate Show trend icon.
7. To have the goal status icon appear in the box, activate Show goal status
icon.
8. To have long goal names wrap to two lines in a box, activate Show goal
name on two lines.
9. Activate Display link to Metric Tree when available if you want to create
a link to one or more defined Metric Trees where the metric or goal defined
on a metric used in the gauge is the root metric in the Metric Trees.
For more information on Metric Trees, see the Performance Manager
documentation.
Note:

This option does not work with Gauges using a universe query.
10. If you want the boxes to link to an analytic on the Central Management
Server, activate Attach an analytic to each goal and click Browse to
navigate to the analytic.
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The name of the document appears in the text box as part of an
openAnalyic link. For information on openAnalytic and its variables see
the section on Linking from goal, universe query and metric-based
analytics.
If you want to link the boxes to more than one analytic, click Multiple
Links. In the Edit Navigation Link Menu panel you can add as many
links as you want, as well as changing the order of the links as they appear
in the list box.
Related Topics

• Configuring a goal-based Strategy Map analytic

Linking items in the Strategy Map analytic layout
Links between items

In the strategy map layout area, click one of the small boxes attached to the
strategy map item that you want to link to, and drag the mouse to one of the
small boxes attached to the destination strategy map item.
A line appears linking the two items and an arrow indicates the direction of
the link.
Deleting a link

To delete a link between two objects, do one of the following:
• Select the link and press Delete.
• Right-click on the link and select Delete Item.
Editing a link arrow direction

To edit a link arrow direction, right-click on it and select Edit. In the "Edit
Link" panel select a link direction and click OK.
Related Topics

• Configuring a goal-based Strategy Map analytic

Configuring text items in a goal-based Strategy Map
These steps apply to a strategy map using on Performance Manager goals.
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1. In the strategy map layout area:
• to edit an existing text item, double-click on it.
• to create a new text item, click Add Text Item.
2. In the "Edit Text Item" panel, type or modify text in the Text box.
3. Choose a font size.
4. To add a hyperlink to an analytic in the Central Management Server,
activate Use text as hyperlink and click Browse to select the document.
To set more than one link on the text items, click Multiple Links.
The hyperlink text appears in the text box using the openAnalytic variable.
You can edit this text. For more information on hyperlinks and
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
Note:

To remove the hyperlink, deactivate Use text as hyperlink.
5. Click OK.
Related Topics

• Configuring a goal-based Strategy Map analytic

Panning in a Strategy Map
To move around a Strategy Map that does not fit in the browser window, use
Alt and click-and-drag.
You can also enable the Scroll lock button on your keyboard, and use Alt
+ arrow.

Zooming in a Strategy Map
• To select an area to enlarge, use Ctrl and click-and-drag.
• To zoom in, use Ctrl and click.
• To zoom out, use Ctrl + Shift and click.
• You can also right-click and select Zoom In, Zoom Out, or Original View
from the shortcut menu.

Analytic display modes
The display formats are:
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•
•
•
•

SVG – Scalable Vector Graphics format. This format is less interactive
than the applet.
Applet – The Java Applet allows interactive editing of the analytic.
Flash – Macromedia Flash provides a more interactive interface, and a
zero footprint.
HTML – The HTML display allows you to provide accessibility for
508-compliant analytics.

The display modes for the analytics are shown in the following table.
Analytic

SVG

Applet

Flash

HTML

Alerts

X

Bubble chart

X

Control chart

X

Curve fitting

X

Frequency histogram

X

Gauge

X

Goal

X

X

X

Goal subscriptions

X

Goal-based influencer detail

X

Individual list

X

Influencer detail

X

Influencer gains chart

X

Interactive metric trend

X

Key influencers

X

Lag plot
Map

DHTML

X

X

X
X

X
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Analytic

SVG

Applet

Membership

X

X

Metric forecaster

X

Flash

HTML

Metric list

X

Metric tree

X

Metrics overview

X

X

Migration

X

X

Model gains chart

X

Multi-set same time events

X

X

Navigation list

X

Normal probability

X

Pareto

X

Pie chart

X

Profiler

X

Radar chart

X

Scorecard

X

Smoothing
Strategy Map

X
X

Text

X

Variable profile box plot

X

Visual data counts

X

X

Web page
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Creating an analytic based on an existing analytic
You can edit an existing analytic based on universe queries, metrics, and
goals to select a different data source and save it as a new analytic.
Note:

You cannot change the data source of analytics based on Web Intelligence,
Crystal Reports, or Desktop Intelligence queries. Instead, you edit the query
to create an analytic. The process to edit queries is located in the
documentation for Web Intelligence, Crystal Reports, or Desktop Intelligence
.
1. Select the analytic on which you want to base the new analytic.
2. Click Edit.
The analytic's edit panel appears. See the information on configuring the
analytic in the "Analytics Catalog" in the Dashboard and Analytics
documentation.

Sample metric analytics
Metric analytics in the Analytic Catalog
You can create a new analytic based on pre-defined analytics in the Metric
Analytics tab of the Dashboard Builder Analytic Catalog.
Related Topics

• Creating an analytic based on an existing analytic
• Creating an analytic

Sample metric analytics based on Web Intelligence queries
The following sample analytics are available in the Metric Analytics tab in
the Dashboard Builder Analytic Catalog:
•
•
•
•
•
•

Annual growth
Change compare
Dual metric comparison
Kiviat diagram
Overview
Percent compare
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•
•
•
•

Radar diagram
Raw versus smoothed
Rollup compare
Year-to-year change

Note:

These analytics are based on a Web Intelligence query on the sample
Business Objects universes.

Annual growth
Annual growth is a sample Metric analytic in the Dashboard Builder Analytic
Catalog. It is based on a Web Intelligence query and shows the annual growth
rate of a given metric.
Annual growth is calculated using a "% change" metric with an Annual
difference.

Change compare
Change compare is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares sets at a point in time. It distinguishes which
sets are above the average from those that are below.
Change compare provides a common base of comparison of change for
different metrics. It is useful especially when metrics are measured in different
kinds of units (for example, Number of customers vs Total revenue).
You can select the lag you want. If you choose lag 1, the change is calculated
from adjacent period. If you choose lag 12 for monthly metrics, the change
is the annual change.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Dual metric comparison
Dual metric comparison is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares and contrasts two metrics or subsets that
require different scales. This analysis permits comparisons either of two
metrics for the same subset or, alternatively, of two subsets with respect to
the same metric.
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For example, you can compare the count and average purchase last quarter
for members of a particular set, or you can compare the average purchases
last quarter of a set's Joiners and Leavers.
Note:

•

Use either of the following:
• two metrics with one subset
• one metric with two subsets

•

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Kiviat diagram
The Kiviat diagram in the Metric Analytics tab of the Dashboard Builder
Analytic Catalog assesses your organization or product.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Overview
The Overview analytic in the Metric analytic samples of the Dashboard Builder
Analytic Catalog provides you an example of a Web Intelligence query that
contains a current snapshot on the list of available sets.
In addition to the membership of each metric that has been defined for the
set or group, this analytic also provides data for Joiners, Stayers, and Leavers
in the Metric Status List. It also provides important metadata associated with
the chosen set. The data available in the Overview is a good starting point
for acquainting yourself with the status of sets, groups, metrics as well as
for making decisions regarding which metrics to add.
You can display the following details:
•
•
•
•

Name
Description
Creation date
Frequency of the refresh

Once you have selected a set to review, familiarize yourself with the refresh
period and the date of the last refresh. This gives you a context for interpreting
the data displayed in the Metric Status List. The Metric Status List displays
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the most recent refresh period of each metric for various subsets - Members,
Joiners, Stayers, and Leavers.
A drop-down allows you to view the metrics which are cross set: migrating
from, migrating to, overlapping members, same time leaver and same time
joiners.
The set list is displayed and the metrics for the selected set are displayed.
Click Metric Details to display a graphical representation. You can view the
graph in different ways - line, bar, percent of origin or percentage change of
origin. You can either view set details based on measures or based on a
subset.

Percent compare
Percent compare in the sample Metric analytics in the Dashboard Builder
Analytic Catalog compares metrics to a Benchmark metric.
A Percent compare graph displays a benchmark metric as a flat line of value
zero. If a compared-metric line rises above zero, it is out-performing the
benchmark metric. If it declines below zero, the compared-metric is
under-performing the benchmark metric.
The Benchmark metric can be an Index or a best-in-class performance metric.
The formula for Percent compare is:
(Compared Metric/Benchmark Metric) - 1
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Radar diagram
The Radar diagram is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that is useful to visually benchmark your company or product
against the industry or the competition.
Note:

This analytic is based on a Web Intelligence query.
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Raw versus smoothed
Raw Versus Smoothed is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that reveals hidden trends within the naturally fluctuating
values of a metric. Raw versus Smoothed shows metric values versus
smoothed values for a given smoothing method selected from a list.
Smoothing can be used to remove seasonality and makes long-term
fluctuations stand out more clearly.
Note:

•
•

Make sure the smoothing methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Rollup compare
Rollup compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows a Year Versus Previous year matrix by slice at a given
point in time. The light gray figures are totals by filter.
The user can choose the time rollup.
Note:

•
•

Make sure the time rollup methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Year-to-year change
Year-to-Year change is a sample Metric analytic in the Dashboard Builder
Analytic Catalog and is applicable to additive metrics only (unless the metric
is yearly). It shows periods of growth with caps.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Sample metric analytics based on Desktop Intelligence queries
The following sample analytics are available in the Metric Analytics tab of
the Dashboard Builder Analytic Catalog:
•
•

Deviation from annual change
Deviation from SMA
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•
•
•
•
•
•
•

Deviation from specified target
Deviation trend
Moving average bands
Profile compare
Range compare
Shewhart u chart
Top slices

Note:

These analytics are based on a Desktop Intelligence query on the sample
Business Objects universes.

Deviation from annual change
Deviation from Annual Change is a sample Metric analytic in the Dashboard
Builder Analytic Catalog that shows how much a metric deviates from the
year-to-year relative change (for example, the target). This analytic tracks
the progress of sales for the current year compared to the previous year
sales.
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Deviation from same months average
Deviation from Same Months Average is a sample Metric analytic in the
Dashboard Builder Analytic Catalog that shows how much a metric deviates
from the Same Months Average (for example, the target).
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
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Deviation from specified target
Deviation from Specified Target is a sample Metric analytic in the Dashboard
Builder Analytic Catalog that shows how much a metric deviates from a target
which is another metric.
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
Note:

•
•

Use the Deviation Trend analytic, also in the Dashboard Builder Analytic
Catalog, to track the cumulative deviation for large time series.
This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Deviation trend
The Deviation Trend is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that is useful for tracking the deviation from a target and
predict whether or not the total target can be. The Deviation Trend is suitable
for seasonal data and large time series.
The plain line represents the cumulative deviation indexed on the total target.
The user can select the trend start date.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Moving average bands
The Moving average bands is a sample Metrics analytic in the Dashboard
Builder Analytic Catalog that shows the raw values of a given Metric (black
line) within moving average bands (green lines). You can create an alert that
notifies you when the raw data line hits the lower band or the upper band.
Moving average bands can also be used to find the proper thresholds for
alerts.
The moving average bands also represents the distance in standard
deviations between the raw values and the moving average. Length and
offset are two parameters entered by the user when running the analysis
and they define the moving time window.
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Higher and lower band size represent the distance in standard deviation
between the raw values and the moving average.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Profile compare
Profile compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that is useful to compare two sliced metrics at a given point in time.
Note:

This analytic is based on a Desktop Intelligence report.

Range compare
Range compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows range by slice. The gray thin bar represents the range.
The red/black mark represents the average value.
Sliced metrics with minimum, maximum and average values are required for
this analysis to run.
Note:

This analytic is based on a Desktop Intelligence report.

Shewhart u chart
The Shewhart u Chart is a sample Metric control chart in the Dashboard
Builder Analytic Catalog that is used in quality management. It is suitable to
measure average defects per unit when sample sizes vary.
UCL Level and LCL Level are two parameters entered by the user when
running the analysis.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
Related Topics

• What is a Shewhart control chart?
• What is a defects per unit (u) chart?
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Top slices
Top slices, a sample Metric analytic in the Dashboard Builder Analytic
Catalog, shows the best and worst performers among the slices of a given
metric in the current period. It points out the slices that reach the top for the
first time as well as those that have just fallen out. Beyond the current status,
it gives the number of times a slice has been on top and what was its last
rank (for example, its rank in the previous period).
Note:

This analytic is based on a Desktop Intelligence report.

Sample comparison analytics
The following sample comparison analytics are available in the Metric
Analytics section of the Dashboard Builder Analytic Catalog:
•
•
•
•
•
•
•
•
•

Change compare
Kiviat diagram
Pareto chart
Percent compare
Profile compare
Radar diagram
Range compare
Rollup compare
Top slices

Change compare
Change compare is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares sets at a point in time. It distinguishes which
sets are above the average from those that are below.
Change compare provides a common base of comparison of change for
different metrics. It is useful especially when metrics are measured in different
kinds of units (for example, Number of customers vs Total revenue).
You can select the lag you want. If you choose lag 1, the change is calculated
from adjacent period. If you choose lag 12 for monthly metrics, the change
is the annual change.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.
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Kiviat diagram
The Kiviat diagram in the Metric Analytics tab of the Dashboard Builder
Analytic Catalog assesses your organization or product.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Pareto chart
The Pareto chart on the Metrics analytics sample tab in the Dashboard Builder
Analytic Catalog is a type of histogram in which bars are arranged in
descending order, from left to right. It includes a cumulative curve that
represents the added contribution of each category.
Related Topics

• Pareto Chart

Percent compare
Percent compare in the sample Metric analytics in the Dashboard Builder
Analytic Catalog compares metrics to a Benchmark metric.
A Percent compare graph displays a benchmark metric as a flat line of value
zero. If a compared-metric line rises above zero, it is out-performing the
benchmark metric. If it declines below zero, the compared-metric is
under-performing the benchmark metric.
The Benchmark metric can be an Index or a best-in-class performance metric.
The formula for Percent compare is:
(Compared Metric/Benchmark Metric) - 1
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Profile compare
Profile compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that is useful to compare two sliced metrics at a given point in time.
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Note:

This analytic is based on a Desktop Intelligence report.

Radar diagram
The Radar diagram is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that is useful to visually benchmark your company or product
against the industry or the competition.
Note:

This analytic is based on a Web Intelligence query.

Range compare
Range compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows range by slice. The gray thin bar represents the range.
The red/black mark represents the average value.
Sliced metrics with minimum, maximum and average values are required for
this analysis to run.
Note:

This analytic is based on a Desktop Intelligence report.

Rollup compare
Rollup compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows a Year Versus Previous year matrix by slice at a given
point in time. The light gray figures are totals by filter.
The user can choose the time rollup.
Note:

•
•

Make sure the time rollup methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Top slices
Top slices, a sample Metric analytic in the Dashboard Builder Analytic
Catalog, shows the best and worst performers among the slices of a given
metric in the current period. It points out the slices that reach the top for the
first time as well as those that have just fallen out. Beyond the current status,
it gives the number of times a slice has been on top and what was its last
rank (for example, its rank in the previous period).
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Note:

This analytic is based on a Desktop Intelligence report.

Sample trend analysis analytics
The following sample analytics are available in the Metric Analytics section
of the Dashboard Builder Analytic Catalog:
•
•
•
•
•

Annual growth
Dual metric comparison
Overview
Raw versus smoothed
Year-to-year change

Annual growth
Annual growth is a sample Metric analytic in the Dashboard Builder Analytic
Catalog. It is based on a Web Intelligence query and shows the annual growth
rate of a given metric.
Annual growth is calculated using a "% change" metric with an Annual
difference.

Dual metric comparison
Dual metric comparison is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares and contrasts two metrics or subsets that
require different scales. This analysis permits comparisons either of two
metrics for the same subset or, alternatively, of two subsets with respect to
the same metric.
For example, you can compare the count and average purchase last quarter
for members of a particular set, or you can compare the average purchases
last quarter of a set's Joiners and Leavers.
Note:
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Use either of the following:
• two metrics with one subset
• one metric with two subsets

•

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.
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Raw versus smoothed
Raw Versus Smoothed is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that reveals hidden trends within the naturally fluctuating
values of a metric. Raw versus Smoothed shows metric values versus
smoothed values for a given smoothing method selected from a list.
Smoothing can be used to remove seasonality and makes long-term
fluctuations stand out more clearly.
Note:

•
•

Make sure the smoothing methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Year-to-year change
Year-to-Year change is a sample Metric analytic in the Dashboard Builder
Analytic Catalog and is applicable to additive metrics only (unless the metric
is yearly). It shows periods of growth with caps.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Sample statistical analytics
Statistical analytics in the Analytic Catalog
Statistical analytics are based on Web Intelligence and Desktop Intelligence
queries on the sample Business Objects universes. You may customize them
by populating them with data to create your analytics.
Related Topics

• Creating an analytic based on an existing analytic
• Creating an analytic

Sample correlation analytics
The following comparison analytics are available in the Statistical Analytics
tab of the Dashboard Builder Analytic Catalog:
•

ACF plot
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•
•
•

Correlation bars
Correlation plot
Lag plot

Note:

The data source for these analytics is based on the sample data shipped
with Business Objects. You can edit the query to create an analytic. The
process to edit queries is available in the documentation for Web Intelligence,
Crystal Reports, or Desktop Intelligence.

ACF plot
The ACF (auto-correlation function) plot is a Statistical sample analytic in
the Dashboard Builder Analytic Catalog that shows the auto-correlation within
a single time series at each lag. On the X axis are the different lags. On the
Y axis are the correlation coefficients.
The ACF plot is useful for identifying seasonal or cyclical patterns in a time
series. It can be used also to check that observations are independent.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Correlation bars
Correlation bars analytic is a Statistical sample in the Dashboard Builder
Analytic Catalog that indicates the relationship between two metrics. The
bars are ranked by size of the upper metric. If the lower metric pattern mirrors
the lower metric pattern, there is correlation between the two metrics. If the
mirror effect is reversed, the correlation is negative.
Note:

The metrics must have the same calculation interval and this analytic requires
that all of the metric's history periods are available. This analytic is based
on a Web Intelligence query on the sample Business Objects universes.

Correlation plot
A correlation plot analytic in the Statistical samples in the Dashboard Builder
Analytic Catalog indicates the relationship between two metrics. It measures
the linear association between two metrics' time series.
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The correlation coefficient (r) can range from an extreme value of –1 (perfect
negative correlation) through zero to an extreme value of +1 (perfect positive
correlation).
The sign of the correlation coefficient indicates the direction of the relationship
between the two metrics. If the correlation coefficient is positive, the metrics
tend to increase and decrease together. If the correlation coefficient is
negative, one metric increases while the other metric decreases. If the
correlation coefficient is close to zero, the metrics move in relatively unrelated
directions.
The magnitude of the correlation coefficient is a measure of the strength of
the association, meaning that as the absolute value of the correlation moves
away from zero, the association between the two metrics is strengthened.
However the graph needs to confirm this.
Note:

Use all periods available in the metrics history. The metrics must have the
same calculation interval. This analytic is based on a Desktop Intelligence
report using the sample Business Objects universes.

Lag plot
The ACF plot is a sample Process Control analytic in the Dashboard Builder
Analytic Catalog that shows see multiple lags at a glance. The lag plot shows
metric values versus lagged values for a particular lag.
It can help identify seasonal or cyclical patterns in a time series.
Lag plot can also be used to check that observations are independent, which
is an important assumption of statistical process control charts.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Sample forecast analytics
The following analytics are available in the Statistical Analytics section of
the Dashboard Builder Analytic Catalog:
•
•
•

Forecast Annual Change
Moving Average - Moving Regression
S-Shaped Trend
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•
•
•
•
•

Same Days Moving Average
Same Months Moving Average
Same Quarter Moving Average
Single Exponential Smoothing
Standard Time Trends

Note:

These analytics are based on Desktop Intelligence documents.

Forecast annual change
Forecast Annual Change is a sample Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful to forecast one year ahead. You need
at least two years of data to be able to forecast. This forecasting method
applies the year-to-year relative change to the raw data and projects the
result one year ahead.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

S-shaped trend
The S-shaped trend is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that shows the s-shaped trend that fits your metric series.
Two models are proposed:
•
•

Logistic curve
Gompertz curve

Try different values of L (upper limit of the curve) to find out the limit that has
the lowest MAPE error in the table. This analysis allows you to forecast your
metric data by the method of Trend Extrapolation. You can choose the
number of periods to forecast when running the analysis.
Often, when plotted over time, the sales of a product follow an s-shaped
curve. This is the case if sales start by increasing slowly, then increase
sharply and finally level off at some upper limit L. A sales pattern of this type
is likely to occur for a product that follows the product life cycle. Often the
diffusion over time of the number of companies producing a product also
follows an s-shaped curve.
Fitting an s-shaped curve to the first few months or years of data is important
because it enables a company to estimate L, the maximum sales level for
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the product. Fitting the s-shaped curve also enables us to estimate the length
of time passed before sales start to level off. Such information can be useful
in capacity planning and strategic planning.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
Related Topics

• What is the Gompertz curve?
• What is the logistic curve?

Same days moving average
Same Days Moving Average is a sample Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful for forecasting daily metrics one week
ahead. You can choose how many weeks you want to include in the
calculation of the forecast. If you choose three weeks, the forecast will be
the average of the last three same days values.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Same months moving average
Same Months Moving Average is an example of a Statistical analytic in the
Dashboard Builder Analytic Catalog that is useful for forecasting monthly
metrics one year ahead. You can choose how many years you want to include
in the calculation of the forecast. If you choose three years, the forecast will
be the average of the last three same months values.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Same quarter moving average
Same Quarters Moving Average is a Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful for forecasting quarterly metrics one
year ahead. It is suitable for seasonal data.
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You can choose how many years you want to include in the calculation of
the forecast. If you choose three years, the forecast will be the average of
the last three same quarters values.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Single exponential smoothing
Single Exponential Smoothing (SES) is a sample Statistical analytic in the
Dashboard Builder Analytic Catalog that provides forecasts using the
weighted moving average of past values of the data. As opposed to a moving
average that gives equal weight to the past values, SES gives weights that
decline geometrically as you go back in time. Recent data is given more
weight.
SES is suitable for data with no trend or seasonal patterns.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Sample projection and distribution analytics
The following comparison analytics are available in the Statistical Analytics
tab in the Dashboard Builder Analytic Catalog:
•
•

Distance from target
Stem and leaf

Note:

These analytics are based on Desktop Intelligence documents.

Distance from target
Distance from Target is a sample Statistical analytic in the Dashboard Builder
Analytic Catalog that is useful for seeing how long it takes to reach a given
target value.
You can use Distance from Target to help you define a realistic target based
on past data trend.
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Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Stem and leaf
Stem and Leaf, the sample Statistical analytics in the Dashboard Builder
Analytic Catalog, gives a quick picture of the shape of the distribution for a
given metric.
It looks like a histogram turned on its side. Its main advantage over the
histogram is that it preserves the original data values.
Data values are split into stem and leaf components. Stem and leaf works
well with a relatively small number of observations (not much more than
100). Unit and stem intervals are two parameters entered by the user.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Process Analysis Control Chart analytics
Control Chart analytic based on a Process Analysis Control
Chart
Control charts are statistical tools for quality improvement. Control charts
were originally developed in the 1920s for the manufacturing environment
and later extended to quality improvement in all areas of an organization.
You must create a control chart in Process Analysis, and then you can add
it as an analytic to dashboards using Dashboard Builder.
A control chart has several functions:
•
•
•
•

It signals when a significant change has occurred.
It distinguishes special from common causes of variation.
It helps improve a process to perform in a consistent and repeatable
manner.
It typically plots some function (for example mean) of process
measurements against sample number or time.
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A typical control chart contains:
•

Control limits
The fluctuation of the points inside the limits results from variation inherent
in the process (common/chance causes). The points outside the control
limits come from special causes of variation (such as human errors or
unplanned events).

•

A center line
The center line represents the process average and is relative to the
specification or internal target.

•

Patterns
Control charts show trends, shifts, and instability.

The control chart distinguishes common causes of variation (such as points
falling inside the control limits) from special causes of variation (such as
points falling outside the control limits).
Note:

You can view the information for a data point by hovering the mouse over
the point in the chart.

Configuring a Control Chart analytic
You need to create a control chart in Process Analysis. You then can include
this control chart as an analytic in dashboards.
1. Do one of the following:
• In a dashboard:
a. Click Edit Dashboard
b. From the Analytic Toolbox > New Analytic drag Control Chart
to the dashboard layout.
c. Click the edit icon.
•

In Dashboard Builder, go to Create New Analytic > Process Analysis
> Control Chart.

2. In the Control Chart properties screen select a universe from the list under
"Available Control Charts".
If necessary, click Available Control Charts to refresh the list of control
charts from the data source you selected.
3. Select the control chart to edit.
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Its chart appears in the right pane. You may need to scroll right to see
the "Selected Graph(s)" list, and down to see all display options. You can
also drag the border between the left and right panes to the left until you
see the "Selected Graph(s)" list.
4. From the "Selected Graph(s)", select the graphs you want to appear in
the chart.
You can use Ctrl + mouse click to select or deselect items in the list.
5. Select the amount of samples you want to appear on the control chart
graph.
Option

Description

Show all history Activate if you want for the control chart graph to show
the entire history.
Show only the
last X samples

Activate to limit the amount of samples shown, and select
the number of samples.

6. Select display options.
Option

Description

Show ABC zones

Activate to make ABC zones visible on the graph.

Show alarms on
graph

Activate to have alarms appear on the graph.

Display table with
graph

Activate to have the data table appear with the graph.

7. Click OK.
8. If you created this analytic directly in a dashboard, it is saved as part of
the dashboard and is automatically refreshed whenever the dashboard
is opened. Click Save.
If you created this analytic in the Dashboard Builder "Create New Analytic"
tab, click Save or Save As and save it in a personal or public folder. It is
saved on the Central Management Server. To add it to a personal
dashboard tab in My Dashboard, click Add to My Dashboard.
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Related Topics

• What are ABC zones?
• What are alarm rules?
• Configuring a Process Analysis control chart alarm

Editing a Process Analysis control chart
1. Go to Dashboard and Analytics > Process Analysis > Control Chart
and select the chart you want to edit.
2. Use the following options on the chart:
Option

Description

Add to My Dashboard

Adds the chart to the My Dashboard list.

Download

Download the chart to your computer.

Edit

Allows you to edit the control chart graph.

Email

Emails the control chart to someone.

Save

Saves the control chart.

Save As

Saves the control chart to a folder and category.

Refresh

Refreshs the content.

Note:

View the information for a data point on the chart by hovering the mouse
over the point in the chart. To increase the size of the control chart,
right-click on the chart and select Zoom in. To decrease the size of the
control chart, right-click on the chart and select Zoom out.
Related Topics

• Creating a control chart in Process Analysis

Creating a control chart in Process Analysis
You need to create a control chart using Process Analysis before you can
make it accessible as an analytic for use in dashboards in the Dashboard
Builder "Create New Analytic" tab.
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1. Go to Dashboard and Analytics > Process Analysis > Control Chart.
2. In the "Available Control Charts" pane, click Add.
The "New Control Chart" wizard opens.
Note:

In the "New Control Chart" wizard, you do not need to do the steps in any
specific order, and you can go back and forth between the sections as
necessary using Next>> and <<Back, or by clicking on the name of the
step.
3. In "Name and Type", configure the control chart attributes, including the
name and type of chart.
4. In "Data Collection", configure the control chart data collection methods.
5. In "Limits", configure the control and specification limits.
6. In "Alarm", configure an alarm.
7. Click Finish.
You have now defined the chart structure but not the content.
8. To generate the data for the chart, click Refresh.
The chart appears in the right-hand pane.
Note:

You can schedule the refresh of a control chart at Dashboard Builder >
Scheduler.
Related Topics

• Configuring the Process Analysis control chart name and type
• Configuring the Process Analysis control chart data collection
• Configuring the Process Analysis control chart limits
• Configuring a Process Analysis control chart alarm
• What is Process Analysis?
• What is a control chart?

Configuring the Process Analysis control chart name and type
1. In the "New Control Chart" wizard "Name and Type" step, type a name
in the "Name" box.
2. Select one of the following control chart types:
• Attributes control chart
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•

Variable control chart
If you select the "Individuals & Moving Range" or "Moving Average &
Moving Range" chart, you need to set the "Span".

Note:

The subsequent settings are not used with the "Moving Average & Moving
Range" chart. If this is the chart you are creating, click Next to configure
the data collection.
3. Select a chart in the "Select Chart" list.
4. If you are creating an "Attributes control chart" and want to set the central
line at zero, click Standardized.
5. Optionally, configure the "EWMA".
6. Optionally, configure the "Cumulative sum".
7. Click Next to go to the next step in the "New Control Chart" wizard.
Related Topics

• Configuring the Process Analysis control chart data collection
• What is an attributes control chart?
• What is a variable control chart?
• What is an individuals & moving range chart?
• What is a moving average & moving range chart?
• What is a standardized control chart?
• What is EWMA?
• What is a CUSUM control chart?

Setting the EWMA for a Process Analysis control chart
1. In the "New Control Chart" wizard "Name and Type" step, select EWMA.
2. Enter the weighting factor parameter.
3. In the "EWMAo" box enter the target for the chart.
Note:

When using the "EWMA" and "Standardized" options together, the EWMA
is based on the values in Standardized control charts.
Related Topics

• Configuring the Process Analysis control chart name and type
• What is EWMA?
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• What is an EWMAo?
• What is a standardized control chart?
• What is weighting factor?

Setting a CUSUM on a Process Analysis control chart
The CUSUM is useful in both Attributes and Variables control charts.
•

In the "New Control Chart" wizard "Name and Type" step, set for the
Upper and Lower Cusums the following values:
• "Target"
• "Headstart"
• "Slack"
• "Decision interval"

Related Topics

• Configuring the Process Analysis control chart name and type
• What is a variable control chart?
• What is an attributes control chart?
• What is the CUSUM target?
• What is slack?
• What is a decision interval?
• What is a headstart value?

Configuring the Process Analysis control chart data collection
1. In the "New Control Chart" wizard "Data Collection" step, select
Aggregated data or Individual data.
Note:

If you are creating a Defects (c) chart or Defects per unit (u) chart, only
aggregated data can be collected, so the "Individual data" option is
unavailable. If you are creating a Variables control chart, only Individual
data can be collected, so the "Aggregated data" option is unavailable.
The "Individual data" option can be used for the Percent rejected (p) chart
or Number rejected (np) chart when the measurements are expressed
as passed/failed status for each individual inspection.
2. Select a sampling from the "Sampling" list or click Add Sampling to set
the parameters.
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3. Optionally, select a filter.
4. If you are creating:
• a Variables control chart, select the measure object from the
"Measures" list.
• an Individual data Percent rejected (p) chart or Number rejected (np)
chart, select a "Yes/No Measure" from the list.
• an Aggregated Data Percent rejected (p) chart or Number rejected
(np) chart, select objects from the "Number rejected" and "Number
inspected" lists.
• a Defects per unit (u) chart, select objects from the "Number of defects"
and "Number of units" lists.
• a Defects (c) chart, select an object from the "Number of defects" list.
5. If you want a data breakdown within a dimension, select it from the
"Breakdown by" list.
A list of all possible values on which the product can be rejected appears.
6. Click Next to go to the next step in the "New Control Chart" wizard.
Related Topics

• Configuring the Process Analysis control chart name and type
• The sampling list in my control chart is empty
• Configuring the Process Analysis control chart limits
• What is a defects (c) chart?
• What is a defects per unit (u) chart?
• What is the percent rejected (p) chart?
• What is the number rejected (np) chart?
• What is a sampling?

Adding a filter to a Process Analysis control chart
1. In the "Data Collection" step of the "New Control Chart" wizard, click Add
filter.
2. Type a name in the "Filter Name" box.
3. Click a subject in the "Subject Area" list.
4. Select at least one filter to use to generate the control chart.
5. Click OK.
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Adding a sampling to a Process Analysis control chart
1. In the "New Control Chart" wizard "Data Collection" step, click Add
sampling.
2. In the "Create a new Sampling" panel, type a name in the "Sampling
Name" box.
3. Select one of the following sample types:
• Systematic
The option sets the sampling to a regular time interval. If you select
Systematic, define the following parameters:
•

Sample Size
Specify the sample size from which an average is derived.

•

Gap size
Gap size is the number of measurements to be skipped between
two samples. The default value is 0.

•

Time Stamp
The time stamp represents the time and date when the sampling
starts.

•

Time-based
If you select Time-based, you must specify the time interval.

•

Calendar-based
Select a custom calendar containing specific time and dates that are
specific to your needs.
For example, if you want to generate a control chart for sales two days
before a given day, create a custom calendar and use it for the
sampling.

4. Set the "Start Time" for the sampling by clicking on the calendar icon.
5. To set a "Stop Time", activate the check box and set the stop time by
clicking the calendar icon.
6. Click OK.
Related Topics

• What is a sampling?

SAP BusinessObjects Dashboard Builder User Guide

189

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

Configuring the Process Analysis control chart limits
This step in the "New Control Chart" wizard is optional. You need to have
already set the control chart name, type, and data collection.
1. Set the control chart limits.
2. Set the specification limits.
3. Click Next to create control chart alarms.
Related Topics

• Setting Process Analysis control chart specification limits
• Setting the Process Analysis control chart control limits
• Configuring a Process Analysis control chart alarm

Setting the Process Analysis control chart control limits
Note:

Make sure that the baseline limits match the chart span, otherwise the limits
and center lines do not appear.
1. To set limits in the values in the "New Control Chart" wizard "Limits" step,
click Enter Values and set the following parameters:
• "Upper Control Limit"
• "Center Line"
• "Lower Control Limit"
2. To set an auto-calculation, click Auto-calculation and set the following
parameters:
• "Baseline window from sample""to Sample"
Select to fix a range of samples within which the control limits are
calculated. The default is 20 points.
Tip:

Create the control chart with no limits to find the best representative
sampling, and then edit the control chart to set the baseline to the
preferred sampling.
•

"Distance from center line"
Select to fix the distance from the center line. The default is three.

•
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Enter specific samples separated by a semi-colon.
•

"Target p0"
If you want the center line calculated automatically, leave Target c0
value empty.

3. Do one of the following:
• Set a specification limit (optional).
• Click Next to go to create a control chart alarm.
Related Topics

• Setting Process Analysis control chart specification limits
• Configuring a Process Analysis control chart alarm
• What is center-line hugging in a control chart?
• What is a sampling?

Setting Process Analysis control chart specification limits
Set specification limits for a control chart so that you can do the following:
• define an alarm that triggers whenever a point is beyond the specification
limits.
• display the limits and compute the capability indices based on the
specification limits using a Desktop Intelligence report. It is recommended
that you display specification limits only on an 'Individual' control chart.
1. In the "Specification limits" section of the "New Control Chart" wizard
"Limits" step , enter the upper and lower limits of acceptable results.
2. Click Next to go to the next step in the "New Control Chart" wizard.
Related Topics

• Configuring the Process Analysis control chart limits
• Configuring a Process Analysis control chart alarm
• What are specification limits?

Configuring a Process Analysis control chart alarm
Optionally, you can use an alarm to notify you when non-random patterns
occur.
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Note:

•

Before you configure an alarm, you need to create a rule in Performance
Manager. The alarm does not communicate with the Rules engine without
a rule. For information on rules, see the Performance Manager
documentation.
• A selected alarm can remain activated all the time or you can save the
latest triggered alarm in the repository.
1. In the "New Control Chart" wizard "Alarm" step, select a chart.
Note:

A Variables control chart can have an alarm on any type of data.
2. Either select an alarm from the "Alarm name" list, or click Add alarm.
3. To activate the alarm, click Activated.
4. To store the alarms in the repository log files, click Keep latest triggered
alarm in repository.
5. Select from the "Event type" list:
• Email
• Alert
• Named Event
Note:

There are two pre-built events, SPMail and SPAlert, that trigger the events.
Without these events, alerts cannot be triggered. If you create a repository,
make sure that the events are also in the new repository. If these events
are not on the new repository, you need to create them.
6. If you selected:
• Email – enter the email address of the alert recipient
• Alert – enter the name of the Business Object owner
• Named Event – enter the parameters
A named event is constructed from a rule in the Rules engine that is
registered in the Central Management Console.
7. If you are setting an email alarm event, you can link the control chart by
clicking the arrow box next to Control Chart.
8. To link a document, click Browse and select the document from the
repository.
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Note:

For more information on alerts, refer to the Dashboard Builder
documentation.
9. Click Finish.
You have defined the chart structure but not the data.
10. To generate the data for the chart, click Refresh.
The chart appears in the right pane.
Note:

You can schedule the refresh of a control chart in Dashboard Builder >
Scheduler.
Related Topics

• Adding an alarm to a Process Analysis control chart
• Process Analysis alerts do not work on my new repository

Adding an alarm to a Process Analysis control chart
1. In the "New Control Chart" wizard "Alarm" step, click Add Alarm.
2. Type a name in the "Alarm name" box.
The "Create a New Alarm" panel appears.
3. Select rules to use to trigger the alarm:
• The following alarms respect the Western electric rules:
• One point outside the Specification limits
• One point outside of the control limits
• 2 out of 3 points in a row in Zone A (same side)
• 4 out of 5 points in a row in Zone B (same side)
•

These alarms follow the trend rules:
• 8 points in a row on same side of center line
• 6 points in a row increasing or decreasing
• 14 points in a row alternating up and down

•

15 points in a row in Zone C, above or below
This alarm detects under-dispersion (the center line hugging pattern)
which arises from improper sampling, or a decrease in process
variability that has not been accounted for when calculating control
chart limits.

SAP BusinessObjects Dashboard Builder User Guide

193

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

•

8 points in a row on both sides of the center line with none in
Zone C
This alarm detects over-dispersion (the mixing pattern) which occurs,
for example, in an X-bar chart where samples from two different
machines have been mixed.

4. Click OK.
The "Create a New Alarm" panel closes. The Control Chart wizard "Alarm"
step reappears so that you can configure the new alarm.
Related Topics

• Configuring a Process Analysis control chart alarm
• What are specification limits?
• What are the Western Electric rules in control charts?
• What is the trend rule?
• What is over-dispersion in a control chart?
• What is center-line hugging in a control chart?

Using a Web Intelligence report as the entry point to navigate
to Process Analysis control charts
1. Define a Web Intelligence query using a 'Control charts' universe with at
least the run name and the run id objects.
2. Define a report variable that represents the URL to the control chart
analytic, for example:
(=<a href='/apps/jsp/viewCC.jsp?id=" + [Run Id] +
"&alarms=yes'>...</a>")
and specify the cell display property as 'read content as hyperlink'.
3. Refresh the document to make sure the newly created control charts
appear in the Web Intelligence report.
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Control Chart navigation tips
Panning around a Process Analysis control chart
The SVG viewer does not use scroll bars to pan around, but you can still
move and look at parts of a control chart that do not fit in the window.
Simultaneously press the Alt key and drag the view at the same time to move
around a control chart. The cursor turns into a hand.
Note:

You can also use Alt and the arrow key, if Scroll Lock is enabled.

Zooming on a Process Analysis control chart
To zoom in on a control chart, do one of the following:
• Hold down Ctrl and click the area in which you want to zoom.
The cursor turns into a magnifying glass with a plus sign. Click on the
control chart to zoom in.
To return to the default control chart display, do one of the following:
• Right-click the chart and select Original View or Zoom Out.
• Press Ctrl + Shift and click the control chart.

Printing a Process Analysis control chart
1. Right-click the control chart and select View SVG.
The control chart appears in a new browser window.
2. Use the web browser print function to choose the "Landscape" orientation
and print.

Process Analysis control chart troubleshooting
This section explains troubleshooting methods for some Process Analysis
control chart problems that can occur.

The bottom graph of my control chart is a zero flat line
Your X-bar & range or X-bar & standard deviation control chart has a range
or standard deviation graph with a zero flat line.
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Cause: The Process Analysis engine retrieves one row per sample unit from
the query. The standard deviation and range statistics are computed based
on a single, aggregated figure, and therefore return zero for each sample
unit.
Action: Remove the aggregate function from the measure object.

The sampling list in my control chart is empty
The sampling list is empty in the "Data Collection" step of the Process
Analysis "New Control Chart" wizard.
Cause: When you create an "Individuals & Moving Range" or "Moving
Average & Moving Range" control chart where the sampling list is empty,
the appropriate sampling is not available. The "New Control Chart" wizard
filters the sampling list to systematic samplings the size of 1.
Action: Create a systematic sampling of size 1.

The limits and center line do not appear on my control chart
Even though you specified the auto-calculation limits, the run line is displayed
alone.
Cause: The baseline is wider than the chart history.
Action: Do one or more of the following:
•
•
•

Reduce the baseline limits calculation to match the chart span and refresh
the chart.
Bring in more history.
Wait the amount of time necessary for the chart span to meet the baseline
calculation.

The run line shows the same value continuously in my control chart
The control chart run line shows the same value.
Cause: The Process Analysis engine issues one query for each hourly sample
for a control chart that has the time-based hourly setting based on a universe
that uses the following date prompts:
•
•
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The time predicate includes the day element but is missing the time. All
hourly queries for a given day are the same, and therefore return the same
results.
Action: Replace the date prompts with date-time prompts in the fact_ta
ble.fact_timestamp:
•
•

@Prompt('BEGIN_DT','D',,mono,free)
@Prompt('END_DT','D',,mono,free)

The control chart does not show a new member in the existing group
The control chart does not show a new member of a group.
For example, you created a control chart called Cost by Department and a
new department has just been added to the source database. However, this
new department is not in the control chart, even though you have refreshed
the chart.
Create a new control chart for the group.

Process Analysis alerts do not work on my new repository
You have a new repository on which you have defined control charts and
alarm rules, but the alert does not work, even though red circles show on
the graph.
Create the following alerts in Performance Manager in the "Rules" sub-tab:
•

SPCAlert
This rule needs to have a Public scope and have the following rule
description:
On this named event: SPCAlert if a condition is met, create the alert: SPC
Alert.

•

SPCMail
This rule needs to have a Public scope and have the following rule
description:
On this named event: SPCMail if a condition is met, send an email.

For more information in creating rules, see the Performance Manager
documentation.
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Decimals do not show on the control chart
The numbers displayed in the legend of the control chart appear truncated
without decimals.
In the source universe of the control chart, assign a number format to the
measure with the right-click menu. In Dashboard and Analytics Setup, update
the universe and check the properties of the measure object to verify that
the number format is updated.

Large numbers overlay the control chart border
The control chart analytic is plotting large numbers that go over the graph
border.
Apply a /1000 transform to the SQL of the measure object on which the
control chart is based, and assign a custom format using the right-click menu.
Make sure you update the universe in Dashboard and Analytics Setup. Click
the measure object to see the number format in the universe set up screen.
You must purge and refresh the control chart to see the new format in the
analytic.

The EWMA run is identical to the Shewhart run in my control chart
You specified a weighting factor of '1'. The EWMA computation assigns a
100% weight to the X-bar current sample, while 0% is assigned to the
previous samples.
It is common practice to use a weighting factor between 0.05 and 0.25.
Specify a weighting factor of 0.2 to assign a 20% weight to the current sample.

Building a dashboard with too many control charts
If you have created many control charts and you want to include them in a
corporate dashboard, you do not have to go through the Dasboard Builder
"Create New Analytic" workflow for each control chart.
Use the Control Chart applet as an analytic. In the edit mode of a dashboard,
select Toolbox > Analytics Services > Control Charts.
Whenever a control chart is created, it automatically appears in the corporate
dashboard. The end user selects a control chart from the list on the left and
the control chart appears on the right.
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The control chart takes a long time to refresh the first time
Cause: You created a control chart using a time-based sampling (such as
Every Hour); the initial refresh of the chart can take a long time.
For example, if the raw source data starts September 1st 2004 and the
sampling start date has been specified as 'January 1st 2004', the Rules
engine runs one query for each hour starting Jan 1st. Useless queries
(24x30x8) are run.
Action: Use a more precise sampling. In the example, you use the start date
'Sept 1st 2004'.
Note:

This issue does not occur with systematic samplings that use one single
query for all periods from start date to current date.
Related Topics

• What is a sampling?

Displaying time periods on the X axis of the control chart
You created a Process Analysis control chart using a time-based sampling
but you cannot display the time on the X axis.
Problem: The control chart shows the sample number on the x-axis with the
time period exposed only in the tool-tip.
Resolution: Use a custom Desktop Intelligence report using the 'Control
charts' universe (CI_SPC.unv) to display the period on the x-axis.

Specification limits do not show on the control chart
You have defined Specification limits for a control chart but only the control
limits appear in the analytic.
The control chart analytic allows you to plot the control limits, not the
specification limits. Specification limits apply to individual measurements,
but not to the summary statistics used in control charts (such as X-bar, Range,
Standard Deviation and Moving Average).
For this reason specification limits can only be used with an Individuals &
moving range control chart, because it includes the upper and lower
Specification Limit measure objects that allow you to build a Desktop
Intelligence query and plot the specification limits in a trend line chart.
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Process Control Analytics (Samples)
The following samples based on the Control Chart analytic.
These samples are available at Dashboard Builder > Analytic Catalog >
Process Control Analytics Samples:
Shewhart charts for Attribute data
•
•
•
•
•
•

c chart
u chart
u chart standardized
np chart
p chart
p chart standardized

Shewhart charts for Variable data
•
•
•
•
•

X-bar & range
X-bar & standard deviation
Median and range
Individuals & moving range
Moving average and moving range

CUSUM and EWMA charts
•
•
•
•
•
•

Cusum on defects
Cusum on individuals
Cusum on x-bar
EWMA on rejects
EWMA on individuals
EWMA on x-bar

Related Topics

• Control Chart analytic based on a Process Analysis Control Chart

c chart
The c chart on the Process Control Analytics tab in the Dashboard Builder
Analytic Catalog is an example of a Defects (c) control chart. It monitors the
number of defects, errors and accidents with a constant sample size.
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Related Topics

• What is a defects (c) chart?

Cusum on defects
The Cusum on defects chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a cumulative sum. This chart is a prevention tool as it gives signals
when defects are likely to happen.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

Cusum on individuals
The Cusum on individuals chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a cumulative sum where the Individual data option is activated.
This chart signals small changes on the individual chart.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

Cusum on x-bar
The Cusum on x-bar chart analytic in the Process Control Analytics tab of
the Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a CUSUM. It signals small changes on x-bar chart data.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

EWMA on individuals
The EWMA on individuals chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing an EWMA where the Individual data option is activated. You can
use this chart when the data is not independent or is auto-correlated.

SAP BusinessObjects Dashboard Builder User Guide

201

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

Related Topics

• What is EWMA?
• What is a defects (c) chart?

EWMA on rejects
The EWMA on Rejects chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Percent rejected (p)
chart with the EWMA configured, and made into Standardized control charts.
It signals small shifts in a p chart or standardized p chart.
Related Topics

• What is EWMA?
• What is the percent rejected (p) chart?
• What is a standardized control chart?

EWMA on x-bar
The EWMA on x-bar chart in the Process Control Analytics page of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing an EWMA. It shows small changes on x-bar data.
Related Topics

• What is EWMA?
• What is a defects (c) chart?

Individuals & moving range
The Individuals & Moving Range chart on the Process Control Analytics
sample analytics tab in the Dashboard Builder Analytic Catalog shows how
you can monitor individual values.

Median and range
The Median and Range chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is a sample of an analytic that monitors
variables with a constant and relatively small sample size.
Related Topics

• What is a median?
• What is a range?
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Moving average and moving range
The Moving Average and Moving Range chart on the Process Control
Analytics tab in the Dashboard Builder Analytic Catalog monitors individual
values where each sample has one value.
Related Topics

• What is a moving average & moving range chart?
• What is the moving average?
• What is a range?

np chart
The np chart on the Process Control Analytics tab of the Dashboard Builder
Analytic Catalog is an example of a Number rejected (np) chart.
Related Topics

• What is the number rejected (np) chart?

p chart
The p chart on the Process Control Analytics tab of the Dashboard Builder
Analytic Catalog is an example of a Percent rejected (p) chart.
Related Topics

• What is the percent rejected (p) chart?

p chart standardized
The p chart standardized on the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Percent rejected (p)
chart made into a standardized control chart. This chart is useful for short-run
production.
Related Topics

• What is a standardized control chart?
• What is the percent rejected (p) chart?

u chart
The u chart on the Process Control Analytics tab in the Dashboard Builder
Analytic Catalog is an example of a Defects per unit (u) chart.
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Related Topics

• What is a defects per unit (u) chart?

u chart standardized
The u chart standardized on the Process Control Analytics tab in the
Dashboard Builder Analytic Catalog is an example of a Defects per unit (u)
chart made into a standardized control chart. This chart flattens the u chart
limits. It is useful for short run production.
Related Topics

• What is a standardized control chart?
• What is a defects per unit (u) chart?

X-bar & range
The X-bar & Range chart on the Process Control Analytics tab in the
Dashboard Builder Analytic Catalog monitors a variable with a constant and
relatively small sample size.
Related Topics

• What is an X-bar & range chart?

X-bar & standard deviation
The sample X-bar & standard deviation chart on the Process Control Analytics
tab in the Dashboard Builder Analytic Catalog monitors variable data with a
variable or constant sample size.
Related Topics

• What is an X-bar & standard deviation chart?

Process Control Analytics
The following sample Desktop Intelligence control charts are available at
Dashboard Builder > Analytic Catalog > Process Control Analytics:
•
•
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Note:

These analytics are based on Desktop Intelligence reports using the sample
Business Objects universes. You can modify them to some extent using
Desktop Intelligence or Web Intelligence reports.

SPC ACF plot
The SPC ACE plot chart in the Process Control Analytics tab in the Dashboard
Builder Analytic Catalog is an example of a control chart that shows
auto-correlation within a single time series at each lag. On the X axis are the
different lags. On the Y axis are the correlation coefficients.
The ACF plot is useful to identify seasonal or cyclical patterns in a time series.
You can also use this chart to check that observations are independent.

SPC lag plot
The SPC lag plot chart on the Process Control Analytics tab in the Dashboard
Builder Analytic Catalog is an example of a control chart that shows metric
values versus lagged values for a particular lag. It can help identify seasonal
or cyclical patterns in a time series.
The lag plot can also be used to check that observations are independent,
which is an important assumption of Process Analysis charts. To see multiple
lags at a glance use the SPC ACF plot.

Process Analysis Terms
A to C
What are ABC zones?
In Process Analysis, control chart zones are used in tests for instability and
identifying unnatural patterns. Control charts have six zones: three upper
zones and three lower zones. Each zone's dividing line is exactly one-third
the distance from the center line to either the upper or the lower control limit.
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Each zone has an associated probability. The closer a zone is to the center,
the higher the probability. Zones probabilities are based on the standard
normal curve.
Related Topics

• What is a control chart?

Aggregation functions
What is arithmetic mean?
The Arithmetic mean (also called average or simple mean) is the sum of the
values divided by the number of values. The arithmetic mean is relevant any
time several quantities add together to produce a total.
It answers the following question: if all the quantities had the same value,
what would that value have to be in order to achieve the same total?
Related Topics

• What is harmonic mean?
• What is geometric mean?

Average functions
• Average: Returns the average by transaction.
• Average by individual: Returns the average by individual for individuals
of a subset.
• Average distinct: Returns the average by transaction of distinct values.
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Count functions
The following count aggregate functions are available:
• Count all: Counts the number of occurrences of all values.
• Count distinct: Counts the number of occurrences of a distinct value.
• Count null: Counts the number of occurrences of null values only.

What is geometric mean?
The Geometric mean is the nth root of the product of the n values. Less often
used than the arithmetic mean, it is appropriate for averaging ratios such as
rates of change, interest rates or inflation rates. More generally, the geometric
mean is relevant any time several quantities multiply together to produce a
product.
The geometric mean answers the question: if all the quantities had the same
value, what would that value have to be in order to achieve the same product?
The formula for Geometric mean is as follows:

Note:

The values must be greater than zero.
Related Topics

• What is harmonic mean?
• What is arithmetic mean?

What is harmonic mean?
The Harmonic mean is the reciprocal of the arithmetic mean of the reciprocals
of the values. It is used to calculate average rates such as distance per time,
or speed. The formula for harmonic mean is:

Related Topics

• What is arithmetic mean?
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• What is geometric mean?

What is a median?
The median is the midpoint of the values after they have been ordered from
the smallest to the largest, or the largest to the smallest. There are as many
values above the median as below it in the data set.
The median is less sensitive to outliers (extreme values or errors) than the
arithmetic mean is. For an odd number of values, the median is the middle
value in the ordered set. For an even number of values, the median is the
arithmetic mean of the two middle values.
One measure related to median is:
Depth of the median = (number of values + 1) / 2
Related Topics

• What is a median & range chart?

What is maximum?
Used as an aggregate function, maximum returns the maximum value of a
set of values.

What is minimum?
Minimum used as an aggregate function returns the lowest value of a set of
values.

What is population kurtosis?
The coefficient of Kurtosis measures the relative peak of the curve defined
by the distribution of the values. Standard normal distribution has a Kurtosis
coefficient of 0. A Kurtosis coefficient of greater than 0 indicates that the
distribution is more peaked than the standard normal distribution. A Kurtosis
coefficient of less than 0 indicates that the distribution is flatter than the
standard normal distribution.
The formula for population coefficient of Kurtosis is:
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What is population skew?
The skew statistic measures the degree to which a variable deviates from
symmetry with the mean at the center. A skew of value zero means that the
distribution is a symmetrical curve. A positive value indicates that the values
are clustered primarily to the left of the mean with most of the extreme values
to the right of the mean. A negative skew indicates clustering to the right.
Distributions with positive skew are more common than distributions with
negative skew.
An example of positive skew is the distribution of income:

The formula for population skew is:

What is population standard deviation?
Returns the square root of the population variance. Standard deviation is
expressed in the same unit as the data. The formula for population standard
deviation is:

What is population variance?
Variance is a sum of the squared deviations from the mean, divided by n-1
or n. The formula for population variance is:
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What is sample kurtosis?
The coefficient of Kurtosis measures the relative peak of the curve defined
by the distribution of the values. Standard normal distribution has a Kurtosis
coefficient of 0. A Kurtosis coefficient of greater than 0 indicates that the
distribution is more peaked than the standard normal distribution. A Kurtosis
coefficient of less than 0 indicates that the distribution is flatter than the
standard normal distribution.
The formula for sample coefficient of Kurtosis is:

What is sample skew?
The skew statistic measures the degree to which a variable deviates from
symmetry with the mean at the center. A skew of value zero means that the
distribution is a symmetrical curve. A positive value indicates that the values
are clustered primarily to the left of the mean with most of the extreme values
to the right of the mean. A negative skew indicates clustering to the right.
Distributions with positive skew are more common than distributions with
negative skew. An example of positive skew is the distribution of income.

The formula for sample skew is:
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What is sample standard deviation?
Returns the square root of the sample variance. Standard deviation is
expressed in the same unit as the data. The formula for sample standard
deviation is:

What is sample variance?
Variance is a sum of the squared deviations from the mean, divided by n-1
or n. The formula for sample variance is:

What is sum?
Sum returns the total of a set of numeric values.

What is sum distinct?
Sum distinct returns the total of a set of distinct numeric values.

What are alarm rules?
Alarm rules are used in Process Analysis control charts to detect and signal
special causes.
The Shewhart control chart is efficient in detecting medium to large shifts.
One possible way to increase the power of Shewhart charts is to use rules
to supplement the ordinary rule governing control limits.
Related Topics

• What are zone rules?
• What is the trend rule?
• What are specification limits?
• What is a Shewhart control chart?
• What is the control limits rule?
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What is an alert?
A Dashboard and Analytics alert informs the user of any major changes
that occur in the business. Alerts are created as a component of a rule in
Performance Manager.

What is an attributes control chart?
In Process Analysis, Attribute control charts plot attribute data. When deciding
the type of control chart to use, refer to the following table.
Data type
Proportion

Percent rejected (p) chart
Large shift size Number rejected (np)

chart
CUSUM or EWMA on the
Percent rejected (p) chart
Small shift size
or Number rejected (np)
chart

Defects count

Defects (c) chart
Defects per unit (u) chart

CUSUM or EWMA on the Defects
(c) chart or Defects per unit (u)
chart

Related Topics

• What is a standardized control chart?
• What is the percent rejected (p) chart?
• What is the number rejected (np) chart?
• What is EWMA?
• What is a defects per unit (u) chart?
• What is a defects (c) chart?
• What is a CUSUM control chart?
• What is attribute data?

What is attribute data?
You can classify and count attribute data, for example the count of rejects
in a process.
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Attribute data often takes the form of counts. If you cannot represent the
quality characteristic numerically, or it is impractical to do so, you can sort
the item that is inspected into two buckets: pass/reject, good/bad, yes/no.
Examples of attribute data are: Number of rejected products, Number of
incomplete orders, and Number of deliveries not on-time.

What is a breakdown?
In Process Analysis, the purpose of breakdown is to create multiple control
charts through a single process. You can break down a control chart by any
relevant categories.
A typical example of breakdown is to define a Percent rejected (p) chart for
each defect type that causes the rejection of a given item.
Related Topics

• What is the percent rejected (p) chart?
• What is a control chart?

What is center-line hugging in a control chart?
In the following Process Analysis control chart example, 15 points in a row
are in zone C.
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This case can arise from improper sampling, or a decrease in process
variability that has not been accounted for when calculating control chart
limits.
Related Topics

• What is a sampling?
• What is a control chart?

What is a control chart?
In Process Analysis, a control chart plots the variation in the output of a
business process over time.
A control chart includes upper and lower limits that show the expected
variation in the process and a center line that shows the mean value of the
points in the chart.
Control charts on dependent (or auto-correlated) data produce too many
false alarms, even for a low level of correlation over time. The simplest
technique is to set the interval between samples large enough to make the
effects of auto-correlation negligible.

What is the control limits rule?
In Process Analysis, the control limits rule states that one point exceeds the
control limits. It is efficient in detecting medium to large shifts.
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What is a CUSUM control chart?
CUSUM stands for cumulative sum. In Process Analysis, the CUSUM control
chart has a long memory and is effective in detecting small shifts in the
process.
A CUSUM control chart can take two forms: tabular or V-mask. The tabular
form is preferred over the V-mask form for defining one-sided CUSUM or
FIR CUSUM (Fast Initial Response). The tabular CUSUM has two statistics,
the one-sided upper cusum and the one-sided lower cusum, that accumulate
the derivations respectively above and below a target value specified by the
user.
Related Topics

• What is the CUSUM target?
• What is slack?
• What is a headstart value?
• What is a decision interval?

What is the CUSUM target?
In Process Analysis, the CUSUM target is a CUSUM value from which the
deviation is calculated.
The tabular value has two statistics, the one-sided, upper cusum and the
one-sided, lower cusum, that accumulate the derivations respectively above
and below the target value.
It is possible to define a tabular CUSUM for monitoring only one side of the
target value or a two-way tabular CUSUM in which the target values differ
on the upper side and the lower side.
Related Topics

• What is a CUSUM control chart?

D to P
What is data distribution?
Data is described by a probability distribution that is used to determine the
theoretical mean (such as center line), theoretical standard deviation (such
as Sigma), and natural variation of the data (such as control limits).
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The most common data distributions are the Normal, Binomial and Poisson
distributions.

What is a decision interval?
In Process Analysis, the decision interval in a CUSUM calculation represents
the level at which the limit must be drawn.
Slack and the decision interval value must be entered as multiples of sigma.
Related Topics

• What is slack?
• What is a CUSUM control chart?

What is a defects (c) chart?
A c chart tracks the number of defects, errors, or accidents per unit of
measurement, where the probability of a defect occurring is low. This chart
is effective if you want to count more than one defect per sample unit.
Its control limits are always flat.

What is a defects per unit (u) chart?
A u chart monitors defects per unit for a variable or constant sample size.

What are discarded samples?
In Process Analysis control charts, discarded samples are points that you
want to exclude from the baseline window because they are out of control.

What is EWMA?
In Process Analysis, an EWMA (exponentially weighted moving average) is
used in control charts to plot the process mean by calculating a weighted
average of previous samples. EWMA charts can be plotted for both attribute
and variable data. EWMA charts are used to spot small shifts in static
processes.
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The EWMA is a compromise between the Shewhart chart and the CUSUM
chart. It uses a moving average which weights recent values more heavily
than older values. Memory is adjustable via the weighting factor. The larger
the weighting factor, the shorter the memory.
Related Topics

• What is weighting factor?
• What is variable data?
• What is a CUSUM control chart?
• What is attribute data?

What is an EWMAo?
In Process Analysis, the EWMAo is the target, or center line, of an EWMA
chart. This is the initial value for the EWMA calculation.

What is a headstart value?
In Process Analysis, a headstart value is used for CUSUM calculations that
improves the sensitivity of the CUSUM at its start.
This parameter is also called the FIR (Fast Initial Response) parameter.
Related Topics

• What is a CUSUM control chart?

What is an individuals & moving range chart?
An Individuals & Moving Range chart monitors individual values with samples
of one value each. A moving span has to be specified.

What is a median?
The median is the midpoint of the values after they have been ordered from
the smallest to the largest, or the largest to the smallest. There are as many
values above the median as below it in the data set.
The median is less sensitive to outliers (extreme values or errors) than the
arithmetic mean is. For an odd number of values, the median is the middle
value in the ordered set. For an even number of values, the median is the
arithmetic mean of the two middle values.
One measure related to median is:
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Depth of the median = (number of values + 1) / 2
Related Topics

• What is a median & range chart?

What is a median & range chart?
In Process Analysis a Median & Range chart monitors a variable with a
constant and relatively small sample size. Median is less sensitive to extreme
values as X-bar.
Related Topics

• What is a variable control chart?
• What is a range?
• What is a median?

Moving averages explained
What is the moving average?
In data analysis, you use the moving average to calculating the average
value of an indicator, over a period of time. In some time series, seasonal
variation is so strong it obscures any trends or cycles, which are very
important for the understanding of the process being observed.
Moving average may be used as a smoothing method that removes
seasonality and makes long-term fluctuations in the series stand out more
clearly. It may also be used for forecasting purposes.

Moving average transformations
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Transformation

Use

MA 2x12

If your time series is monthly, use the MA 2x12 to remove the seasonality.

MA 2x24, MA 2x36

If a stronger "seasonality filter" is required, use MA
2x24 or MA 2x36 for monthly series.
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Transformation

Use

MA 3x3, MA 3x9,
MA 3x5

Also known as a double moving average, this moving
average that is taken of a series of data that already
represents the result of a moving average.

MA exponentially
weighted

A moving average transformation. Henderson’s MA is
another centered symmetric weighted moving average
method. The 5- and 7-point averages are used for
Quarterly series. The 9-, 13-, and 23-point averages
MA henderson 9-pt,
are used for Monthly series.
13-pt, 23-pt

Note:

All the moving average methods are externalized in a
file (Stats.ini) that can be customized.
MA linearly weighted
MA linearly weighted center

MA same months

This same months moving average method uses a
fixed-interval time window but with non-continuous
data points. It is useful on seasonal data for smoothing
or forecasting purposes.

MA spencer 15-pt,
21-pt

The Spencer’s weighted moving average is an approach to computing a moving average that will compensate for a cubic trend in the data. It consists of two
averages, one for 15 periods and the other for 21 periods. Spencer’s weights are centered and symmetric.
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Related Topics

• MA exponentially weighted
• MA linearly weighted
• MA linearly weighted center

MA exponentially weighted
A moving average transformation. An MA exponentially weighted
transformation finds the number of points parameter required. The smoothing
constant parameter is required:
• Less than 1 weights current data more heavily
• Equal to 1 weights every points identically (same as simple MA)
• Greater than 1 weights old data more heavily
The Single exponential smoothing (SES) forecast can be expressed as a
weighted moving average that applies exponentially decreasing weights to
the data, as the observations get older. Thus it is called exponential
smoothing.
The next period forecast is then:
Ft+1 = aYt+a(1 - a)Yt–1 + a(1 - a)²Yt–2 + a(1 - a)³Yt–3
+ … + a(1 - a)^ t–1 Y1+a(1 - a)^ t F1
where a is a constant between 0 and 1, and F1 is the initial value that usually
is given the value of Y1.
As a guide in choosing a, try values close to 0 if the series has a lot of random
variation. If you wish the forecast values to depend strongly on recent
changes in the actual values, try values close to 1.

MA linearly weighted
A moving average transformation. You use a weighted moving average to
give more weight to current data. Weights can be calculated automatically
using a function.
The weight function for a Linearly weighted MA is defined as:
W(p)=(2/n(n+1)) p
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where p is the sequence of the data points in the moving window ranging
from 1 to n. The weights must sum to a value of one.
The weight function for a exponentially weighted MA is defined as:
W(p)=power(a,n-p)
where a is the smoothing constant and p is the sequence of the data points
in the moving window ranging from 1 to n.
Smoothing constants less than 1 weigh recent data more heavily. A smoothing
constant of 1 gives equal weight to each point. If the smoothing constant
exceeds 1, older data are weighted more heavily than recent data.

MA linearly weighted center
A moving average transformation. A centered weighted moving average,
also known as a double moving average, is a moving average that is taken
of a series of data that already represents the result of a moving average.
With a centered weighted moving average, the majority of the weight is
assigned to the middle portion of the data. A centered weighted moving
average is useful to de-seasonalize the data.
If your time series is quarterly, use the MA 2x4. If stronger “seasonality
filters ? are required, use MA 2x8 or MA 2x12 for quarterly series.

MA centered
A moving average transformation.
Related Topics

• What is the moving average?

What is single exponential smoothing?
Single exponential smoothing (SES) is a forecasting method that works best
for data which have no trend, no seasonality, or underlying pattern. It takes
the forecast for the previous period and adjusts it using the forecast error.
If Yt is the actual observation for period t and Ft is the forecast for the same
period, then the forecast for the next period is:
Ft+1 = Ft+a(Yt–Ft)
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where a is a constant between 0 and 1.
An SES analytic is based on the time series system universe. The SES
weight function is built into the universe. The end user can try different values
of the smoothing constant in order to find the best one.
Related Topics

• MA exponentially weighted

What is a moving average & moving range chart?
In Process Analysis, a Moving Average & Moving Range chart monitors
individual values and each sample has one value each. You need to specify
a moving span for this chart.
Related Topics

• What is the moving average?

What is non-statistical control?
In Process Analysis, a process is out of control when the variation of the
process is due to special causes and the process is unpredictable.

What is the number rejected (np) chart?
In Process Analysis, an np chart displays the number (not the proportion) of
items in a constant sample size that possess specific characteristics.

What is over-dispersion in a control chart?
The following example shows eight points in a row on both sides of the center
line, with none in zone C.
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Over-dispersion can occur, for example, in an X-bar chart where samples
from two different machines have been mixed.

What is the percent rejected (p) chart?
In Process Analysis, a p chart monitors the proportion of items that have
special characteristics, especially in the case of nonconforming products or
transactions, or constant or variable sample sizes.

Q to Z
What is a range?
In Dashboard and Analytics, the range of a set of observations is the
difference between the largest and smallest values. It can be greatly
exaggerated when an outlier is present in the data set. It is based solely on
two values, not on the entire data set. Range is a measure of dispersion but
it is not related to the mean.
The range statistic can be easily derived from the max and min SQL
aggregation functions.
Range = Maximum value – Minimum value
Related Topics

• What is a median & range chart?

What is the rules engine?
In the Business Objects Dashboard and Analytics applications, you use
the rules engine to identify, analyze, predict, and act on a specific event. The
rules engine notifies the users when a process is out of control.
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What is a sampling?
A sampling is a group of the population with specified information. Ideally
you want to analyze a large sample frequently to get the most accurate
estimates and the most up-to-date information.
In Process Analysis, larger samples make it easier to detect small shifts and
make the control chart more sensitive in detecting changes without increasing
the rate of false alarms.
Note:

Start the sampling when data is available. If no data exists, the sampling can
take longer than necessary to generate.

What is a Shewhart control chart?
For Shewhart control charts on Rejects, the assumption is that the data
follows a Binomial distribution. For Shewhart control charts on Defects, the
assumption is that the data follows a Poisson distribution.
In Shewhart control charts the normal distribution is used to approximate the
Binomial and Poisson distributions.
Why the Shewhart charts are not always sufficient

The Shewhart-type control charts only use information about the process in
the last plotted point. These charts have no memory; previous observations
do not influence the probability of future, out-of-control signals.
Related Topics

• What is the trend rule?
• What is data distribution?
• What is EWMA?
• What is a CUSUM control chart?

What is slack?
In Process Analysis, the slack value (also called the reference value)
represents the level at which a deviation is taken into account in the CUSUM
computation.
Note:

Slack and the decision interval value must be entered as multiples of sigma.
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Related Topics

• What is a decision interval?
• What is a CUSUM control chart?

What are specification limits?
In Process Analysis, specification limits are limits on the requirements of the
product or service that are based on the desired value of the measure.
Specification limits apply to the individual values.

What is a standardized control chart?
A standardized (normalized) control chart has been scaled and recentered
so that the central line is at zero and the upper and lower control limits are
at 3 and -3 respectively. Standardized control charts ensure that the control
limits become straight lines on the chart.
When applied to the Percent rejected (p) chart or Defects per unit (u) chart,
the standardization transforms the variable-width control limits into
constant-width limits.
Related Topics

• What is an attributes control chart?
• What is a control chart?
• What is a defects per unit (u) chart?
• What is the percent rejected (p) chart?

What is statistical control?
In Process Analysis, a process is in statistical control when the variation of
the process is solely due to common causes.

SAP BusinessObjects Dashboard Builder User Guide

225

3

3

Using analytics for analysis
Analytics that can be created in Dashboard Builder

The process is therefore stable and predictable over time.

What is systematic variation in a control chart?
In the following example, 14 points in a row are alternating up and down.

This pattern may be the result of too many adjustments from the operators.

What is the trend rule?
In Process Analysis, the trend rule detects Run up or Run down and
systematic variation in a Shewhart control chart.
Trend can be used to introduce some "memory", resulting in a quicker
detection of small shifts:
• eight points in a row on same side of center line
• six points in a row increasing or decreasing
Detecting Run up or Run down.
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•

14 points in a row alternating up and down
Systematic variation.

Related Topics

• What are zone rules?
• What is a Shewhart control chart?
• What are alarm rules?

What is an upward trend in a control chart?
In the following example, six points in a row are increasing.

A trend pattern can be due to a gradual deterioration of equipment, or worker
fatigue.

What is a variable?
In Process Analysis and Predictive Analysis, a variable is a measured
characteristic or attribute. It can be "actual data" or data derived using a
look-up, aggregation or other calculation.
A variable can be:
• A dimension defined in a BusinessObjects universe
• A measure
• Derived variables representing a calculation based on measures,
dimensions and/or sets that is defined interactively by a user.

What is a variable control chart?
In Process Analysis, variable control charts plot variable data and monitor
the mean and variability of variables. These charts are based on the normality
assumption: that the underlying distribution of the values is normal.
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A variable control chart consists of two graphs:
• The upper graph controls the mean.
• The bottom graph controls the variability.
When deciding which control chart to use, consult the following table.

Large shift
size

Small shift
size

Sample size n > 1

Sample size n = 1

x-bar & range

Individuals & moving range

X-bar & standard deviation
Median & range

Moving average & moving
range

CUSUM or EWMA on the
mean or median

CUSUM or EWMA on the individuals

The X-bar controls the mean and the range or standard deviation controls
the variability.
Related Topics

• What is an X-bar & standard deviation chart?
• What is an X-bar & range chart?
• What is variable data?
• What is a CUSUM control chart?
• What is EWMA?
• What is a variable?
• What is a median & range chart?
• What is an individuals & moving range chart?
• What is a moving average & moving range chart?

What is variable data?
In Process Analysis, variable data is continuous data that has been acquired
through measurement, for example length, time, strength, temperature and
pressure.
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When the quality characteristic can be measured numerically like Height, it
is referred to as variable data. Examples of variable data are: Length, Cost,
Volume, Temperature, and Net Margin.
Related Topics

• What is a variable?
• What is a variable control chart?

What is weighting factor?
This is an important setting for the EWMA chart. Weighting Factor determines
the weights to be applied to samples.
If the factor=0.2 then 20% of the weight is given to the most current sample
and 80% to the past samples.
In general, a factor between 0.05 and 0.25 works well. Use smaller values
of the weighting factor to detect smaller shifts.
Related Topics

• What is EWMA?

What are the Western Electric rules in control charts?
The Western Electric rules (also called the Western Electric Company or
WECO rules) determine if a process is out of control and subject to
unexpected variation. Each Western Electric rule identifies a situation that
statistically is very unlikely due to random variation only.
In the following example, four out of five points are in zone B or beyond.
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What is an X-bar & range chart?
In Process Analysis an X-bar & Range chart monitors variable constants in
a relatively small sample size (preferably less than 10).
The X-bar controls the mean and the range controls the variability.

What is an X-bar & standard deviation chart?
In Process Analysis, an X-bar & Standard Deviation chart monitors variable
data with a variable or constant sample size preferably greater than 10.
The X-bar controls the mean and the standard deviation controls the
variability.

What are zone rules?
In Process Analysis, zone rules can be used to introduce some memory,
resulting in a quicker detection of small shifts. Alarm rules for Shewhart
control chart, developed by the Western Electric Company in the 1950s, are
based on the ABC zones and used for detecting under-dispersion and
over-dispersion.
Related Topics

• What are ABC zones?
• What are alarm rules?
• What is a Shewhart control chart?
• What is the trend rule?
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Alerts analytic based on Performance Manager rules
An Alerts analytic generates a list of alerts that are generally triggered by
conditions applied to metric values and external processes writing to the
alert table. You create alerts as part of a Performance Manager rule. To learn
more about rules and their alerts, see the Performance Manager
documentation.
An alerts analytic is a perfect addition to a dashboard navigation list that
contains links to the analytics on which the rules are created.

Configuring an Alerts analytic
Note:

The user interface for this analytic has been modified to comply with the
Section 508 guidelines.
1. Select the appropriate alert type for each category.
You create or edit using an Alerts configuration pane that contains a list
of corporate categories and three levels of alerts:
• Informative alerts
• Important alerts
• Critical alerts
2. Choose the appropriate viewing options:
• Sort by
You can sort all alerts based on date and in ascending or descending
order.
•

Freeze header section while scrolling
Activate this option to freeze header information while scrolling through
the alerts for easy readability.

•

Hide alert column header
You use this option to hide the headers for an alerts.

•
•

Display only private alerts
Display alerts with the same title only once

3. Click OK to save the configuration.
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Alerts analytic features
The Do Action list

From the "Do Action" list you can do the following:
Action

Effect

Delete

The alert that you have flagged for deletion is removed.

Snooze

The advantage of snoozing is that you do not need to
delete an alert. You can put it away for reuse at a future date.

Mark as unread

The alert title text becomes bold. You use this option
when you have read an alert but still want to be reminded to take action on it.

Mark as read

The alert title text becomes plain.

Mark attachment as
unread

The alert attachment icon is a plain icon.

Mark attachment as
read

The alert attachment icon contains a check mark.

Select all alerts

All of the alerts in the list are selected. Any further actions you select from the Do Action list will affect all of
the alerts.

Note:

To select more than one item on the alert list, select one alert and then
additional alerts, using Ctrl + click.
The Display list

Use the display list options to filter your alerts list.
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Option

Shows

Default View

All alerts

Critical Alerts

Only critical alerts

Important Alerts

Only important alerts

Informational Alerts

Only informational alerts

Public Alerts

Only public alerts

Private Alerts

Only personal alerts

Read Alerts

Only read alerts

Unread Alerts

Only unread alerts

The list of alerts

You can do the following on the list:
•

•
•
•
•

To change the sort applied to the list, click the heading of any column.
For example, to see all items with attachments, click on the attachement
column heading.
To open an attachement, click on it. It appears in a separate browser
window.
To see the alert's information text, click on the arrow preceeding the Alert
subject .
To refresh the alert list, click the refresh icon to the right of the "Display"
list.
To delete an alert, select it in the list and click the delete icon located in
the lower, left-hand corner of the Alert analytic.
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Predictive Analytics based on predictive models
Selecting a predictive model to analyze in a Predictive analytic
1. In Dashboard Builder > Create New Analytic, select an analytic the
"Predictive Analytics" category.
2. Select the universe on which the model exists.
3. Select the model.
Related Topics

• Model Gains Chart analytic based on predictive models
• Key Influencers analytic based on predictive models
• Influencer Gains Chart analytic based on predictive models
• Influencer Detail analytic based on predictive models
• Goal-based Influencer Detail analytic based on predictive models

Predictive analytic samples in the Analytics Catalog
The analytics included in Predictive Analysis samples in the Analytic Catalog
are based on the following analytics:
• Influencer Analytics
• Goal-Based Influencer Detail
• Influencer Detail
• Influencer Gains Chart
• Key Influencers
• Model Gains Chart
• Variable Profile Box Plot
•

Lists and Forecasts
• Metric Forecaster
• Individual List

For information on working with these analytics, see the Predictive Analysis
documentation.
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Related Topics

• What is Predictive Analysis?
• Goal-based Influencer Detail analytic based on predictive models
• Individual List based on predictive models
• Influencer Detail analytic based on predictive models
• Influencer Gains Chart analytic based on predictive models
• Key Influencers analytic based on predictive models
• Metric Forecaster analytic based on metrics
• Model Gains Chart analytic based on predictive models
• Variable Profile Box Plot based on predictive models

Goal-based Influencer Detail analytic based on predictive models
The Goal-based influencer detail analytic in Predictive Analysis sheds light
on the precise nature of the relationship of a variable with a key outcome or
goal.
The Goal-based influencer detail analytic provides:
•
•

a histogram display of statistics calculated by the same modeling engine
that supports the Key influencers analytic.
a detailed view of the relationship between a single influencer variable
and a single outcome or goal.

You use goal-based influencer detail when you want to:
•
•

identify "hot spots" (areas with unusually high or low statistic values) in
the relationship between a variable and an outcome measure or indicator.
profile variables that show up as important in Key influencers, in terms
of descriptive statistics by bins.

With goal-based influencer detail, you can answer questions like:
•
•
•

Where are the key breaks in the Employee Tenure variable and attrition
rates are highest?
What age groups account for the high importance of age as an influencer
of purchase frequency?
What most influences equipment downtime and throughput? How?
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Note:

The Key influencers analytic (what) and the goal-based influencer detail
analytic (how) answer this question.
Related Topics

• Key Influencers analytic based on predictive models
• What is an influencer variable?

Configuring the Goal-based Influencer Detail analytic
1. Select a predictive model.
2. Select the influencer and goal you want to display.
3. Select a model metric you want to display and click >>.
The metric appears in the Selected Metrics list.
4. Select the display options.
5. Click OK to save your configuration.
Related Topics

• Selecting a predictive model to analyze in a Predictive analytic
• Setting the display options in Goal-based Influencer Detail and Influencer
Detail analytics
• What is a goal?
• What is a metric?
• What is an influencer variable?

Setting the display options in Goal-based Influencer Detail and Influencer Detail
analytics
1. Select the order in which you want the list sorted.
2. Select a binning option.
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Description

Base binning

Select to have the final binning generated after the
model is generated.
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Option

Description

Final binning for
goal

A Predictive model is based on a population, influencers and goals. Under derived variables you can
define user-defined binning for influencers. For example, you can define a binning for Age by dividing Age
into five ranges [0-25], [25-40], [40-60],[60-80],[80100]. This information is used during generation of a
predictive model. If no user-defined binning is provided then one is generated automatically.
Note:
If you are configuring the Influencer Detail analytic
you need to select the goal for which you want final
binning.

Related Topics

• Goal-based Influencer Detail analytic based on predictive models
• Influencer Detail analytic based on predictive models
• What is binning?

Individual List based on predictive models
The Individual list analytic assembles a set of information for a group of
individuals that includes model scores and derived variables.
Use individual list when you want to apply a predictive model to the members
of a set, or to individuals who fulfill specific criteria for targeting, special
handling, and/or integration with external systems.
As with other analytics, an Individual List refresh can be scheduled to occur
at regular intervals. The list can be displayed and stored in XML format.
With individual list, you can answer questions like:
•

Which employees are the best candidates for senior management?

Related Topics

• What is a derived variable?
• What is a predictive model?
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Configuring the Individual List analytic
1. Select a population and filter, if necessary, then click Next.
2. To select an item from the "Available objects" list, click it and then >>.
You can add extra columns, and select to display only a specific amount
of rows.
3. To add a column from another model, click Add extra column, select an
object and click OK.
The object appears in the "Selected objects" list.
Note:

To remove an object from the "Selected objects" list, select the object
and click <<.
4. To restrict the number of rows in the Individual List, activate Only first
and enter the number of rows in the "Rows" text box or navigate to the
number using the + or -.
5. Click OK.

Influencer Detail analytic based on predictive models
The Influencer detail analytic is identical to the Goal-based influencer analytic
detail in that the categories ("bins") can be based on statistical optimization
with respect to a key outcome or "goal." However, it is different from the
Goal-based influencer detail analytic in that it profiles a variable by subrange
(or bin) based on measures defined in a Business Objects universe.
The Influencer detail analytic exposes goal-based, bin-level statistics. The
following deviation measures influence the analytic:
•
•
•

goal deviation
signed goal deviation
weighted goal deviation

The following goal aggregates influence:
•
•
•

goal rate
mean goal value
goal standard deviation

You can profile an influencer based on:
•
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•
•

performance metrics with respect to one or more outcomes (goals)
(Influencer detail analytic)
user-defined binning or model-derived binning, optimized for a selected
goal. Profile performance on Goal A based on subgroups optimized for
Goal B.

Note:

Influencer analytics can display optimal binnings to reveal key breakpoints
in influencer-goal relationships.
Related Topics

• What is a goal?
• What is binning?
• What is an influencer variable?

Configuring the Influencer Detail analytic
1. Select a predictive model.
2. Select the influencer and goal you want to display.
3. Select a model and subject metric you want to display and click >>.
The metric appears in the "Selected Metrics" list.
4. Select the display options.
Related Topics

• Selecting a predictive model to analyze in a Predictive analytic
• Setting the display options in Goal-based Influencer Detail and Influencer
Detail analytics
• What is a goal?
• What is a metric?
• What is an influencer variable?

Influencer Gains Chart analytic based on predictive models
The Influencer gains chart analytic depicts the relationship between an
influencer variable and a binary outcome or goal using a standard cumulative
lift graph.
As with Influencer detail and Goal-based influencer detail, the influencer
gains chart analytic profiles a variable by subrange, or bin, but it does so in
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a manner that takes into account both the outcome variable and bin frequency
or count.
Influencer bins are placed in descending order of response rate along the
horizontal axis. The model line shows the cumulative percent of signals
achievable by targeting an increasing percent of the total population. Signal
or response is assumed to be the least frequent value.
With the influencer gains chart, you can answer questions like:
•

Is the high importance of age as an influencer of monthly email campaign
response based (a) on spikes in one or two specific age bands, (b) on
the differential between two large age bands, or (c) on a gradual increase
or decrease in the response rate with increasing age?

You use the influencer gains chart when you want to:
•

•
•

identify "hot spots" (areas with unusually high or low statistic values) in
the relationship between a variable and an outcome measure or indicator
in a manner that encompasses "percent of population accounted for."
profile variables that show up as important in Key Influencers, in terms
of Cumulative Lift, the basis for "importance" calculation.
identify the best subranges of a key influencer variable to use in segment
creation.

Configuring the Influencer Gains Chart analytic
1. Select a predictive model.
2. Select the influencer and goal.
3. Select a model metric and click >>.
The metric appears in the "Selected Metrics" list.
4. Select metric options:
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Option

Description

Final binning Select this option to have the final binning generated after
for a goal
the model is generated.
Base binning A Predictive model is based on a population, influencers and
goals. Under derived variables you can define user-defined
binning for influencers. For example, you can define a binning
for Age by dividing Age into 5 ranges [0-25], [25-40], [4060],[60-80],[80-100]. This information is used during generation of model. If no user-defined binning is provided then one
will automatically generated.
Best gain

Select this option to display the best maximum lift response
first for each bin.

Model gain

Select this option to organize bins based on the model results.

Related Topics

• Selecting a predictive model to analyze in a Predictive analytic
• What is an influencer variable?
• What is a predictive model?
• What is binning?

Key Influencers analytic based on predictive models
Key influencers graphically displays the importance of different variables as
an influencer, or predictor of one or more key outcomes.
Users can configure key influencers to display either a simple "variable
importance" metric or a "net relevance" metric that nets out the influence of
correlated variables.
You use key influencers when you want to:
•
•

show which measures or dimensions best predict key outcomes.
determine if the same or different variables are driving different types of
outcomes.

The analytic exposes goal-based, influencer-level statistics. The following
measures influence the analytic:
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•

Importance
Importance represents a measurement of how well the variable, taken
alone, anticipates values of the goal. It is displayed in % of maximum
possible value.

•

Obsolescence
Obsolescence is an advanced user metric. It is calculated based on how
much importance has changed since the last time the model was
generated. Values over five suggest that the model needs to be
regenerated to reoptimize the variable goal-based binning.

•

Net relevance
Net relevance is an advanced metric that represents the utility of the
variable for anticipating goal values, net of other influencers in the model
with over-lapping effects.
It is the best metric to use for prioritization when simplifying a model.
However, care must be taken, since a variable with high importance can
show up as having low net relevance if it is highly correlated with another
variable whose power was slightly higher in the most recent refresh
(random variation in a subsequent refresh can cause two such variables
to trade places).

With key influencers, you can answer questions like:
•
•
•
•
•

Which attributes and behavior are most associated with high purchase
volume? Which are most associated with high risk of attrition?
Where are the influencers of risk and revenue outcomes the same and
where are they different?
Which dimensions or measures should I use for high-value, high-potential,
or high-risk segment creation?
What factors determine the success of a sales professional?
What most influences equipment downtime and throughput? How?
Note:

Key influencers (what) and the Goal-based influencer detail analytic (how)
answer this question.
Related Topics

• Goal-based Influencer Detail analytic based on predictive models
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Configuring the Key Influencers analytic
1. In the analytic edit panel, expand Select Model to analyze and select
the universe on which the model exists.
2. Select the predictive model from the "Selected Model" list.
If the model does not appear, click the refresh icon next to "Selected
Model". The influencers and goals attributed to the model appear in the
"Associated influencers" and "Selected Goal(s)" lists.
3. Select an influencer level from the "Metric to display" list.
4. In the "Display Options" section, configure the following options:
• If you do not want influencers that exceed the obsolescence of your
choice visible on the list, activate Hide influencers if obsolescence
more than and type a limit.
• If you want the influencers listed in a particular order, activate Sort in
X order of X for goal X and choose parameters.
• To create a hyperlink from the legend to a document, activate Use
Legend as hyperlink to go to and browse to the document.
5. Click OK to save your changes.
Related Topics

• Key Influencers analytic based on predictive models

Metric Forecaster analytic based on metrics
The Metric forecaster analytic:
•
•
•

graphically displays metric history and forecasts one or more points into
the future.
automatically detects and adjusts for cyclicality, such as recurrent
day-of-week or day-of-month patterns.
uses error bands and retrospective 1-point-forecasts help the user judge
forecast reliability.

You use metric forecaster when you want to:
•
•

without needing any statistical knowledge, create forecast time-series
metrics multiple points into the future that are automatically updated.
gain insight into forecast accuracy via error bands and retrospective
forecast overlay.
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With the metric forecaster analytic, you can answer questions like:
•
•

Is demand likely to reach levels that would exceed planned supply at any
end-of-month peak over the next 90 days?
Are the sales representatives in danger of missing sales targets?

Note:

You can test all combinations of detrending method and cyclicality encoding,
and select the best combination based on the following criteria:
• Eliminate models where Corr (predicted, actual) is not statistically
significant
• Select the model with smallest root mean squared error:
RMSE = sqrt(sum((forecasti-actuali)2)/N)
Keep in mind

•
•

You need at least 18 periods to have a correct projection.
Metric slices cannot be used with this analytic.

Related Topics

• What is a metric forecaster detrended mean?

Configuring the Metric Forecaster analytic
You can use a model-based metric for this analytic. Model-based metrics
are created in Predictive Analysis. For more information see the Predictive
Analysis documentation.
1. In the analytic edit panel, expand Forecast parameter and click Select
Metric.
2. Select a model-based metric.
3. To be able to select a different model-based metric each time the analytic
is refreshed, activate Add a Prompt and type prompt text you want to
appear in the prompt window.
The prompt always defaults to the last model-based metric selected using
the prompt.
4. Specify the number of forecast periods.
5. Expand Display Options and type a title for the analytic.
6. To set a hyperlink to a Central Management Server analytic from the
chart legend, activate Use Legend as hyperlink to go to and click
Browse to locate the analytic.
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The hyperlink text appears in the text box in an openAnalytic text string.
You can edit this text string. For information on openAnalytic, see the
Linking from goal, universe query and metric-based analytics section in
the documentation.
7. Select an error band width:
• Select Liberal to have the error band computed as +1.96 times L2 to
-1.96 times L2.
• Select Conservative to have the error band computed as +3 L2 to -3
L2 where L2 is root mean squared error.
The error band displays the margin of error allowed.
8. Select a sampling data set to divide a population into specific parts to use
in the model generation process.
• Select Complete to use three quarters of the data for estimation and
one quarter of the data for validation.
• Select Optimized to use all of the data for estimation and the last two
thirds of the data for validation.
The default mode, "Complete", works better for smaller data sets and
metrics with trends. "Optimized" mode works better for metric with cycles.

What is a metric forecaster detrended mean?
The Metric forecaster analytic uses the following detrending algorithm
encoding:
Adjacent-point differencing:

xt = xt-1

Double-differencing:

xt = xt-1 + (xt-1 – xt-2) =
2*xt-1 – xt-2

Linear regression:

xt = A + B*t

Generalized regression on time:

xt = A + B*t + C*t² +
D*log(t) + E*sqrt(t)

The encoded value is the detrended mean of the signal across all data points
with the same sequence number. For each detrending algorithm:
•
•

A prediction is made across all values with sequence=1.
Residuals are calculated as (prediction – actual).
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•
•

The mean of these residuals across all values with sequence = 1 is used
as the cyclicality encoding for points corresponding to sequence=1.
The same is applied to data points with other sequence numbers.

Cyclicality encoding on the detrended signal include:
•
•

Standard seasonality variables (for example, day of week or month of
year)
Repetitive sequence encoding of adjacent points in time

Model Gains Chart analytic based on predictive models
The Model gains chart analytic:
•
•

profiles the combined strength of multiple variables for predicting a binary
goal metric in terms of cumulative lift.
depicts the relationship between the combination of ALL influencer
variables in a predictive model and a binary outcome or goal, using a
standard cumulative lift graph (used in database marketing).

Model gains charts shows:
•
•
•

bins of the model score variable placed in descending order of response
rate along the horizontal axis.
a model line that shows the cumulative percent of signals achievable by
targeting an increasing percent of the total population.
a signal or response assumed to be the least frequent value.

You use model gains chart when you want to:
•
•

assess how much predictive power is contained in the sum total of a suite
of variables.
determine the best cut-point to use for targeting based on values of a
model score variable (when used in conjunction with the Individual List
analytic.

Related Topics

• Individual List based on predictive models

Configuring the Model Gains Chart analytic
1. Select a predictive model.
2. Select items from the "Associated influencers" and "Selected Goal" lists
using Ctrl + mouse click.

246

SAP BusinessObjects Dashboard Builder User Guide

Using analytics for analysis
Analytics that can be created in Dashboard Builder

Related Topics

• Selecting a predictive model to analyze in a Predictive analytic

Model Gains Chart tips
The following tips are available to help you configure a model gains chart:
Insight
Scoring
Sample size
Leverage sets
Regenerate on refresh
Cross-sell analysis

Insight
To optimize model gains chart for insight:
•
•

Include as many potentially relevant variables as possible.
Use multi-goal models and Key influencers analytic configurations.

Related Topics

• Key Influencers analytic based on predictive models

Scoring
To optimize model gains chart for scoring:
•
•

Minimize the number of influencers by eliminating influencers with low
net relevance.
Avoid multi-goal models.

Sample size
When selecting sample size:
•
•
•

Use absolute sample size, not sampling %, for reliable trending.
Only use large samples to trend weak (for example low importance)
relationships accurately.
Use single influencer models or the Variable Profile Box Plot analytic to
quantify goal values by bin against 100% samples of large populations.
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•

Increase sample size when regeneration rules trigger too often.

Related Topics

• Variable Profile Box Plot based on predictive models

Leverage sets
Use leverage sets, as needed, to increase performance:
•
•

Restrict population definition to set/subset conditions
Use set/subset membership variables

Regenerate on refresh
Use "Regenerate on Refresh" sparingly, because model regeneration takes
much longer than a simple refresh action.

Cross-sell analysis
To optimize model gains chart for cross-sell analysis, use the same variables
as influencers & goals in multi-goal models.
Note:

Not useful for prediction, which requires known goal values.

Variable Profile Box Plot based on predictive models
The Variable profile box plot analytic profiles the relationship between a
variable (character or numeric) and a numeric measure using a standard
box plot graph.
For each subrange or "bin" of the selected variable, a box plot is displayed
that depicts the minimum, maximum, and quartiles (25th, 50th and 75th
percentiles) of a profile measure's distribution. An alternative configuration
displays box plots based on mean and standard deviations.
You use variable profile box plot to:
•
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understand how the distribution of a profile measure varies by variable
bin, for example range, variability and lopsidedness or "skew." By contrast,
the Influencer detail analytic is used for profiling variables against multiple
measures side-by-side based on a simple aggregation such as mean.
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•

•

analyze how the range and distribution of a Key Performance Indicator
(KPI) varies for different values of a focal attribute to understand and
improve consistency of performance.
summarize the relationship between a focal attribute and profile or
outcome measure in a manner that teases out the influence of extreme
values and lopsided distributions.

With variable profile box plot, you can answer questions like:
•
•

How is "sum of transaction fees" distributed for accounts of different ages?
What is the distribution of account representative performance by region?

Related Topics

• Influencer Detail analytic based on predictive models

Configuring the Variable Profile Box Plot analytic
1. Select the universe on which the population exists.
Click the refresh icon next to "Selected Population" to be sure that you
have the latest list.
2. Select a population.
3. Select the influencer and binning.
For information on creating a binning, see the Predictive Analysis
documentation.
4. Select a metric to use in the plot.
Note:

The metric must contain a binning.
5. Select the display options.
The statistics are selected by choosing from a standard configuration.
The following parameters are the default standard configurations.
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Option
Selected
Variability

Min

Low

Mid

High

Max

Description

Select either Range or Deviation.
• Range: minimum, maximum, 25%, 50%, 75%
• Deviation: mean, mean + -sigma, mean + -3*sigma
For "Range", enter the minimum value of measure for
each bin. For "Deviation", enter -3 sigma.
For "Range", enter the 25% percentile for each bin. For
"Deviation", enter -1 sigma.
For "Range", enter the median value for each bin. For
"Deviation", enter the mean.
For "Range", enter the 75% percentile for each bin. For
"Deviation", enter +1 sigma.
For "Range", enter the maximum value of measure for
each bin. For "Deviation", enter +3 sigma.

6. Click OK.

Predictive Analysis Terms
What is binning?
In Predictive Analysis, binning allows you to compress the range of values
of a variable into a smaller number, for example, binning of age into age
groupings.
Binning can be explicitly defined or statistically derived.
Related Topics

• What is a variable?
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What is a Boolean?
In Predictive Analysis, Boolean is a data type that represents a condition
whose values can only be the logical values of TRUE or FALSE. Internally,
these are represented as 1 and 0 respectively.
Boolean variables are used when a binary goal is desired. Currently only
Boolean variables as goals can be profiled in the Model Gains and Influencer
Gains analytics. Logical operators and the isinpopulation() function are
especially useful for defining Boolean variables.

What is a derived variable?
Derived variables are user-defined data elements that are derived from
universe objects and/or set membership. The universe itself already supports
variable definitions in the form of measures and dimensions calculated from
source data.
Application architects can expand the range of variables available for
Predictive Analysis in a safer and more convenient way than by changing or
adding universes to the installation.
In addition, some of the Predictive Analysis calculations require Boolean
goal variables, which can only be enabled through the use of derived
variables.
Related Topics

• What is a Boolean?
• Predictive Analysis model data types
• What is a variable?

What is a goal?
A goal measures the achievement of a given metric. Goals are either numeric
or Boolean and can be positive or negative, depending on the desired
outcome. It consists of a target value and, optionally, a tolerance zone.
A goal is assigned a goal status based on the performance of its associated
metric. When the metric actual value over-performs the target value beyond
tolerance, then the goal status is green. If the metric actual value falls within
the tolerance range, then the goal status is yellow. If the metric actual value
under-performs the target value beyond the tolerance, then the goal status
is red.
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The status of a goal depends on the trend color of its associated metric: a
Revenue metric that is above tolerance has a green status whereas a Cost
metric that is above tolerance has a red status.
A goal is based on a metric:
•

•

A goal has the same calendar as the metric it is associated with. For
example, a goal based on a monthly metric follows monthly intervals and
a goal based on a fiscal week metric follows fiscal week intervals.
A goal has the same type as its metric. For example, a goal based on a
Revenue metric is typed as “Increase is Good ?.

A metric can have multiple goals associated with it. For example, a metric
can have plan, forecast and benchmark goals.
Related Topics

• What is goal status?
• What is a Boolean?

What is goal status?
The goal status helps interpret the performance of a metric in a simple, visual
way. The position of the metric actual value within a tolerance zone of a
specified period determines the goal status for a given period. Goal status
takes into account the metric's polarity.
The following colors represent goal status:
• Green represents a goal that is meeting a target.
• Yellow represents a goal that is within the tolerance range.
• Red represents a goal that is below the set target.
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•

Gray represents an undetermined status -- either the tolerance or metric
value or both values are missing. A goal can also be grey when the metric
last period is ahead of the goal last period.

The equivalent of the graphical goal status icon exists in the rule engine as
a numerical status.
Related Topics

• What is a goal?

What is goal-based binning?
In Predictive Analysis, goal-based binning is optimized for a goal or outcome.
Goal-based binnings emphasize distinctions in the value range for an
influencer that correspond to significant shifts in the rate or mean value of a
specified goal variable.
For example, the only important distinctions in age that affect response rates
to a marketing campaign are 'under 20, 20-63, and 64+.' The influencer
modeling engine automatically calculates these during model generation.
Related Topics

• What is binning?
• What is a goal?
• What is a variable?

What is a grain?
A grain is the duration of the time periods or slices that make up metrics.
The metric grain can vary in span size, and is dependent on the calendar;
the finer the grain, the shorter the time period between metric value
calculations.
Related Topics

• What is a metric?

What is an influencer variable?
An influencer variable is used as a descriptive or behavioral piece of
information, such as age, state of residence, or calculations.
The primary types of influencer model data types are:
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•
•
•

Continuous
Nominal
Ordinal

Related Topics

• What is a variable?
• Predictive Analysis model data types

Predictive Analysis model data types
Objects influence how the data appears in the model.
Sources

Source data type

Influence data
type

Goal data type

Desktop Intelligence Objects

Character

Nominal

N/A

Numeric

Continuous, OrdiContinuous, N/A
nal

Date

N/A

N/A

Boolean

Nominal

Boolean

Character

Nominal

N/A

Numeric

Continuous, OrdiContinuous, N/A
nal

Date

N/A

Derived Variable

N/A

Continuous data type

The continuous data type is the default data type corresponding to numeric
variables. Do not use this type for variables that represent numeric codes
rather than actual numbers (for example, zip code); treat such variables as
nominal variables.
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Nominal data type

A nominal data type has a value that is not inherently ordered, for example
gender. All character objects from a BusinessObjects universe are treated
as nominal.
Ordinal data type

Ordinal variables are ordered, but lack proportionality, as in the example of
an undefined distance between adjacent values.
Related Topics

• What is a Boolean?

What is a joiner?
In the analysis of sets, a joiner is an individual who was present in a set in
a given period but was not present in the prior period. The period of analysis
here corresponds to the set refresh period. No metrics are required for this
analysis to run.
Related Topics

• What is a metric?

What is a leaver?
A leaver is an individual who was not present in a set in a given period but
was present in the prior period.

What is a metric?
A metric, or KPI, is the measure of actual performance. A metric is defined
using objects in the universe, and is usually made up of the following:
• a measure
• a filter
• a date restriction
You can use metrics to track actual performance and compare it to a goal,
or use it to project a trend.
Metrics can also be created on a set universe. Set metrics allow you to track
a measure over time for a particular subject within a set.
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What is a population?
In Dashboard and Analytics analyses, a population is a named query that
defines a group of interest.

What is a predictive model?
A predictive model is a user-specified configuration of the predictive
calculation engine. To set up a predictive model, the user selects influencers,
goals, and the population within which relationships are quantified.
Related Topics

• What is a population?

What is the root-mean-squared-error?
The root-mean-squared error (RMSE) is often the criterion for assigning an
appropriate smoothing constant. Select the smoothing constant that gives
the smallest RMSE value.

What is the rules engine?
In the Business Objects Dashboard and Analytics applications, you use
the rules engine to identify, analyze, predict, and act on a specific event. The
rules engine notifies the users when a process is out of control.

What is a sampling?
A sampling is a group of the population with specified information. Ideally
you want to analyze a large sample frequently to get the most accurate
estimates and the most up-to-date information.
In Process Analysis, larger samples make it easier to detect small shifts and
make the control chart more sensitive in detecting changes without increasing
the rate of false alarms.
Note:

Start the sampling when data is available. If no data exists, the sampling can
take longer than necessary to generate.

What is a variable?
In Process Analysis and Predictive Analysis, a variable is a measured
characteristic or attribute. It can be "actual data" or data derived using a
look-up, aggregation or other calculation.
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A variable can be:
• A dimension defined in a BusinessObjects universe
• A measure
• Derived variables representing a calculation based on measures,
dimensions and/or sets that is defined interactively by a user.

Set Analytics
Configuring a Membership, Migration or Multi-set Same Time
Events analytic
The Membership, Migration and Multi-set Same Time Events analytics in
Set Analysis study trends in set metrics, however they study different facets
of these trends. The configuration of these analytics is similar in many ways,
with the following differences:
• The Membership analytic works with a set that contains all members in
one or more sets.
• The Migration analytic works with one or more sets that show information
on cross set migrants, for example, joiners.
• The Multi-set Same Time Events analytic works with one or more sets
that track the multiple activities of joiners, leavers, and stayers.
1. In the analytic edit panel, select sets to list in this analytic.
2. In the "Navigation Options" section, to put a hyperlink on the set name
to an analytic on the Central Mangement Server, activate Use set name
as hyperlink to go to and click Browse to navigate to the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
3. To hide the trend chart, activate Do not display an automatic trend
when clicking on a chart component.
When this option is deactivated, you can select an item in the chart list,
and its metric trend chart appears. This option is useful if you want more
space in the list for columns.
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4. To set a hyperlink on data points to an analytic on the Central Mangement
Server, expand the "DataPoint Navigation options" section, and activate
Use data point as hyperlink to go to and click Browse to navigate to
the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
5. In the "Display Mode" section, select a mode.
6. In the "Time Window" section, select a window from the drop-down list.
Related Topics

• Choosing a set metric for the Metrics Overview, Membership, Migration or
Multi-Set Same Time Events analytic

Choosing a set metric for the Metrics Overview, Membership,
Migration or Multi-Set Same Time Events analytic
Note:

If you are configuring a metrics overview analytic, you can also select metrics
without sets.
1. In the analytic edit panel, expand Choose the sets to list in this analytic.
2. Select the set you want to include:
• All available sets
• All sets in these subject areas
If you select this option, choose the subject areas from the pane on
the right.
•

These specific sets
If you select this option, choose sets by selecting them in the left pane
and adding them to the right pane.

3. If you selected These specific sets, add a prompt by clicking Add under
the "Selected Sets" list box.
Related Topics

• Configuring a Metrics Overview analytic
• Configuring a Membership, Migration or Multi-set Same Time Events analytic
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Membership
The Membership analytic, available with Set Analysis, finds trends for sets
and allows you to view a selected set for a specified period.
Set Members reside in the set as of the most recent set refresh. Set Stayers
have resided in the set through more than one refresh.
For example, if the same customer purchases a case of premium wine during
the months of March and April, that customer is included in the Stayer and
Member counts of the Wine Collector set.
Related Topics

• What is a stayer?

Migration
The Migration analytic, available with Set Analysis, shows the movement of
members from one set to another in the form of a graph.
Note:

Use set-based metrics containing cross-set migrants for the Migration analytic.
See the Set Analyis documentation for more information on sets. For more
information on set metrics, see the Performance Manager documentation.

Multi-set Same Time Events
The Multi-set same time events analytic shows concurrent inflows and
outflows over time.
Note:

Use set-based metrics containing the cross set joiner or leaver cross sets.
For more information on sets, see the Set Analysis documentation. For more
information on set metrics, see the Performance Manager documentation.
Set Joiners reside in the set as of, but not prior to, the last refresh.
Related Topics

• What are multi-set metrics?
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• What is a joiner?

What are multi-set metrics?
For a particular set, you can select multiple subsets or measures or
transformations to define multiple metrics. For a particular group, you can
define metrics for each set that belongs to the group.
For a particular level of the tree list, you can refresh or purge all the metrics
under this level. You can use a view by measure, by set, by subset or by
group. Multi-set metrics enable you to track relationships between sets over
time.
Four types of multi-sets metrics are built into the product:
•

"Migrants"
Migrants are individuals who left a given tier to join another given tier.
Migrants in a given period from Set A to Set B are: Set A leavers of the
period that joined Set B in that same period.
Migrant metrics are applicable to temporal sets only. Also they are not
commutative which means that Migrants from A to B are different from
Migrants from B to A.

•

"Overlapping members"
Overlapping Members of Sets A and B are: Set A Members of the period
that are also Members of Set B in that same period.
Overlapping Members are applicable to temporal sets only. They are
commutative which means that Overlapping Members of A and B are
identical to Overlapping Members of B and A.

•

"Same time Joiners"
Same time joiners in a given period of Sets A and B are: Set A Joiners
of the period that joined Set B in that same period.
Same time joiners are applicable to temporal sets only. They are
commutative which means that Same time joiners of A and B are identical
to Same time joiners of B and A.

•

"Same time Leavers"
Same time leavers in a given period of Sets A and B are: Set A leavers
of the period that left Set B in that same period.
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Same time leavers is applicable to temporal sets only. They are
commutative which means that Same time leavers of A and B are identical
to Same time leavers of B and A.

Profiler
The Profiler analytic, available in Set Analysis, analyzes the individual level
information at the membership and metric levels. Use Individual Profiler to
create sets to profile your customers in ways that answer your business
questions.
Individual customers can belong to more than one set, or interest group. For
example, individual customers can belong to a specific age group,
geographical location, or marital status.
Customers can be classified, analyzed and treated in different ways using
set techniques. You can create broad or specific sets to categorize your
customers in ways that are relevant to your business.

Configuring the Profiler analytic
Profiler analyzes the individual level information at the membership and
metric levels.
1. In the profiler edit panel, select the views that you want displayed in the
analytic.
To select or unselect all of the views under "Membership" or "Metrics",
activate or deactivate them at the root level.
2. Select the subjects that you want listed.
You can choose to view all subjects, or select from the list of available
subjects.
3. Enter the ID.
This ID corresponds to the column name in the set dimension table.
4. Click OK to save the configuration.
Related Topics

• What is a subject?
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Visual Data Counts analytic
The Visual Data Counts analytic, available in Set Analysis, counts dimension
objects in a set. You use this analytic to identify the set populations with
significant amounts of members on which you can create analysis scenarios.
Visual data counts help you with set sampling.
You can perform the following functions using visual data counts:
•
•
•

Navigate through the database using the predefined object trees to locate
the categories of data required to fill the current set.
Create your own object trees for data navigation.
View the:
• contents of the database categories in the detail windows. These detail
windows provide information about the content of the categories and
how they relate to other categories.
• components of a category.
• relationship between the upper and lower window categories as
indicated in the object tree.
• number of members currently in the set, shown in the application view
bar.

Using Set Analyzer fast counts in visual data counts

A fast count is an pre-calculated, aggregate action created in Set Analyzer
that summarizes segment counts. Fast counts speed the navigation of object
trees which, in turn, speeds the process of selecting items in a set. If fast
count is defined,the data retrieval is much faster because the data is already
computed and store in set tables.
For more information on creating fast counts and object trees, see the Set
Analyzer Administrator’s Guide. For information on using object trees, see
the Set Analyzer User's Guide.
Related Topics

• What is an object tree?
• What is a fast count?
• What is a sampling?
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Configuring the Visual Data Counts analytic
1. In the visual data counts edit mode, expand the "Specify Visual Data
Definition" section.
2. Select a set subject from the "Subject" dropdown list.
3. Select the source table from the "Source" dropdown list.
The object tree appears in a dimension hierarchy list.
4. Select one or more dimensions and add them to the visual data count by
clicking >.
You can also select dimensions by double-clicking them.
When you add an dimension to the list:
• If you select a measure, the "Added Field Condition" panel appears,
where you can assign a "Yes/No Condition".
Note:

This condition is optional and only available on dimensions that have
a fast count. The condition you set refines the list of counts. If you
want to see the counts for all of the dimension's items, deactivate the
Yes/No Condition and click OK.
When you add a dimension without a fast count, you cannot add a
field condition. Choose to view exact counts.
If the yes/no condition is the same for the measure, click Default to
avoid the necessity of creating the condition more than once.
•

If you select a metric, a panel appears in which you select the type of
count to place on the dimension. If there is a fast count assigned to
the metric, choose Estimates only. If you, however prefer an exact
count or do not have a fast count assigned to the metric, choose Exact
Counts.

5. Click Options to configure the following analytic options:
• Activate Always use Source if required if you do not want estimates
and prefer the source fact tables always queried.
• Activate Always use Estimates if available if you always want
available fast counts used.
• Activate Default Yes/No conditions to Yes.
When you select a dimension for a data count, the dimension defaults
to no, and you select the members of the dimension that you want to
use in the visual data count. Activating the option saves you time if
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you want to use all members for all visual data counts, or have the
assumption of yes, and select the members that should not appear.
6. In the "Display Mode" section, select a mode.

Set analytics in the Analytic Catalog
The Set Analytics samples are based on Web Intelligence queries are
organized in the following categories:
•

Membership Analysis analytics:
• Membership breakdown
• Membership change
• Membership status

•

Set Metrics analytics:
• Multi set scatter
• Percent of group total
• Percent of enterprise
• Set compare
• Set vs enterprise
• Set vs group average
• Set vs group total growth
• Set vs group turnover

•

Migration analytics:
• Migrants compare
• Migration by tier

Membership breakdown
Membership Breakdown is a sample Set Analysis analytic in the Dashboard
Builder Analytic Catalog that shows how the number of members is
decomposed into joiners and stayers rates (positive bars) over time. They
can be compared to the leavers rate represented as negative bars.

Migrants compare
Migrants compare is a sample Set Analytic in the Dashboard Builder Analytic
Catalog that compares metrics based on migrants. The standard net flow
enables the comparison of metrics that are measured in different units. For
this analysis to run, migrants metrics must be defined.
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Migration by tier
Migration by Tier is a sample Set Analyic in the Dashboard Builder Analytic
Catalog that is useful for seeing general migration trends toward high-tier or
low-tier sets. Migration by Tier is a tabular analysis which shows the number
of migrants between sets representing different tiers as well as the amount
of overall up-migration and down-migration.
For this analysis to run, the names of the sets must have an alpha-numeric
ordering that represents their relative positions (for example, Tier 1, Tier 2,
Tier) and migrants metrics must be defined.

Multi set scatter
Multi-set scatter is a sample Set Analytic scatter plot in the Dashboard Builder
Analytic Catalog that compares joiners, leavers and stayers rates with respect
to the current values of the metrics simultaneously, for example, cost and
revenue.
Multi-set scatter shows a snapshot of two or more subsets of a set. Two
metrics define the scatter-plot X-Y axes.
Tip: You can easily page through different periods.
Use this analysis to compare simultaneously current values for differing
subsets with respect to two measures. For example, if you want to know
whether a trend in revenue/cost ratios has emerged among Joiners and
Leavers, you can plot Revenue vs. Cost for Joiners and Leavers and compare
their relative positions.

Percent of group total
Percent of total group is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the total of a
group. It is appropriate for use with mutually exclusive sets.
Percent of total group compares two metrics that are measured in different
units. Applied to a set of mutually exclusive tiers that covers all the individuals,
with a Count metric (for example, Number of individuals) and a Revenue
metric, this analysis is a 80:20 rule chart over time.
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Percent of enterprise
Percent of Enterprise is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the enterprise
total. The formula for Percent of Enterprise is:
Set Metric / Enterprise Metric

Set compare
Set compare is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for comparing sets at a point in time. Set compare
distinguishes the sets that are above the average (blue flat line) from those
that are below.

Set vs enterprise
Set vs Enterprise is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set metric against the enterprise.
Percent of origin makes the two lines start at the same value (100%) in order
to facilitate the comparison.

Set vs group average
Set vs Group average is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking a set raw value against the
average value of a group.
Group average is calculated by averaging the values of the sets within the
group.

Set vs group total growth
Set vs total growth is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set raw value against the group
total growth.
Total Growth solves the scale issue of set raw value versus group total. It
makes the group total trend relative to the starting value of the set trend, so
that the group total growth always starts with the same value as the set trend.
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Set vs group turnover
Set vs Group turnover is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking the turnover of a set against
the turnover of a group.
Set vs Group turnover reveals the amount of change, or churn, that has
occurred in a membership. The period of analysis here corresponds to the
set refresh period.
No metrics are required for this analysis to run.

Individual Set Analysis analytics
Individual analysis delivers detailed historical information describing the
evolution of an individual's relationship to the business. It can be used to
profile customers, products and partners. Individual analysis supports
discovery of pattern that occurs over a period of time, which can lead to new
ideas for segmentation. It delivers not only individual-level attribute data, but
also the information needed to understand relationship history.
For example, high value customer profiling can uncover patterns that foretell
high value behavior within a set. An individual behavior can be a benchmark
to a wider population within the set.
The "Individual" tab in Set Analysis shows samples of analytics that analyze
the behavior of the selected individual in relation with one or more sets:
•
•
•

Profiler
Individual portrait
Membership
• Current membership
• Membership history
• Membership summary

•

Sample metrics analytics for set analysis
• Metric trends
• Metrics summary
• Set vs individual
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Profiler
The Profiler analytic, available in Set Analysis, analyzes the individual level
information at the membership and metric levels. Use Individual Profiler to
create sets to profile your customers in ways that answer your business
questions.
Individual customers can belong to more than one set, or interest group. For
example, individual customers can belong to a specific age group,
geographical location, or marital status.
Customers can be classified, analyzed and treated in different ways using
set techniques. You can create broad or specific sets to categorize your
customers in ways that are relevant to your business.

Individual portrait
Individual portrait is an Individual Set Analysis analytic that displays
descriptive information on a selected individual. Reports and documents that
provide additional details such as transaction history can be linked if they
have been set up during configuration.
This analytic provides an interface to two kinds of information:
•
•

Standard Dimension or Attribute Information
Detail information, such as transaction histories or other contact

Note:

The fields displayed are dependent on the access granted to your profile by
the system administrator.

Current membership
Current membership is a Individual Set Analysis analytic that displays the
summary information of an individual set membership at a point in time. The
point in time defaults to Today, or to the End Date for the selected time
window if the Point Summary is visited after you visit a Period view (Summary
or History).
Current membership helps you better interpret the information in the Summary
View (for example, determining whether the Period information is consistent
with historical behavior or indicative of a change).
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Membership history
Membership history is an Individual Set Analysis analytic that displays the
details of a membership history for a selected individual. Each row displays
the episodes of membership for the selected individual within the selected
time interval. Each line set represents a single episode of membership. The
minimum length of any episode displayed for a given set is determined by
its refresh frequency.
The time window ruler enables selection of a time window within which the
history is displayed. The grain of the ruler determines whether the time ruler
cursors work in days, weeks, months, quarters or years. Zoom buttons widen
and reduce the date range displayed in the ruler. Varying the width of the
time window can change the episode display; wider intervals widen the grain
of the display.
If the interval between adjacent episodes is too short to display adequately
due to the scale of the window width, then the character used to display the
line is changed to signify the missing detail.
Sets are selectable via the standard tree list operation.
Membership history provides information about individual membership history
over a period of time. Broken lines indicate that the individual has moved
within a set.

Membership summary
Membership summary is an Individual Set Analysis analytic that displays the
membership summary for an individual across time windows. This analytic
similar to the Current Membership analytic, except that the time ruler is used
to select an interval instead of a single date. The columns are also similarly
defined but are restricted to the selected time window on the ruler.
Select the set to see membership episodes dates within the selected time
window.
The following information is displayed:
•
•
•

Presence: the total number of days present in the set since the first day
of joining
# Occurrence: total number of times the individual left and came back
into the set in the selected time period
Avg Duration: the average duration for which the individual was part of
the set
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•

Presence %: percentage value of the present days in the set

Related Topics

• Current membership

Sample metrics analytics for set analysis
You can use the following "Individual Set" analytics to provide a powerful
facility for observing the evolution of an individual with respect to one or more
metrics over time:
•
•
•

Metric trends
Metrics summary
Set vs individual

To facilitate meaningful interpretation of individual data, the "Summary" and
"Trend" sub tabs support comparison of individual data with one or more
metrics.
Grain selection in the "Metric" tab is based on the metric selected first.

Metrics summary
Metrics Summary analytic on the Set AnalysisIndividual tab displays the
summary view of an individual's metric values. This analytic presents measure
values for the individual based on a selected period as well as the
closest-in-time metric values.
In Metric Summary, the calculation interval for the individual is the same as
the Observation Time Interval.
The most recent refresh date for the metric value is displayed, as well as the
metric value. The format of the date reveals the metric grain. To ensure that
the individual's values are directly comparable to the metric values, select a
grain and double click the Time Ruler to select a single period of that grain.
Values of the selected metric of that grain are displayed in normal font.
Otherwise, the values are shown in gray and the following criteria are used
to select the best matching metric value:
•
•
•
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Which is the most recent, entirely contained sub-interval of the selected
period?
Which has the larger period (with data) that includes the greatest portion
of the selected period?
Which has the smaller period among the one or more smaller periods
touching the selected interval that is the most recent (with data)?
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A metric value is displayed in regular font if the selected time interval
corresponds to the period for the metric and a value exists for it. Metric
periods are single day, week, month, quarter or year.

Metric trends
Metric Trends analytic on the Set AnalysisIndividual tab is a sample of a
Metric Trends analytic that displays the time series trend of metrics for a
selected individual for a set time period. This analytic displays trends for
Business Objects measures calculated for a selected individual over the
selected time interval. These trends are for the selected individual metrics.
You can also select sets and see the trend of the individual with one or more
sets.
When configuring Metric Trends, choose the metrics to display by selecting
the set from the set tree list and the metric/transformation combinations from
those that are available.
You can first choose which metrics to display and then, in a subsequent step,
set the calculation, and display of the individual's values for the selected
metric.

Set vs individual
Set vs. Individual is a sample Individual Set Analysis analytic that compares
a metric trend line for an individual to that of one or more sets. This analytic
allows you to compare a metric trend line for an individual to that of one or
more sets. Values can be compared directly or trends can be compared
using percentage change from origin.
Set vs. Individual helps you benchmark an individual to set averages over
time, or alternatively, as might be useful in a B2B scenario, how much of set
totals are accounted for by the selected individual.
Note:

Use % change from origin when comparing trends lines for sums or counts,
when an average by individual metric is not available. Alternatively, view the
raw values to analyze trends with respect to proportion of total metric value
accounted for by the selected individual.
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Set Analysis Terms
What is a broken stayer?
In the analysis of sets, a broken stayer is an individual who was present in
a set at the end of the period of analysis and was present just before this
period but who left within the period of analysis.

What is a continuous stayer?
In the analysis of sets, a continuous stayer is an individual who was present
in a set at the end of the period of analysis and was present just before this
period and who did not leave within the period of analysis.

What is a fast count?
A Set Analyzer Administrator creates fast counts in Set Architect. A fast count
is an precalculated, aggregate action created in Set Analyzer that summarizes
segment counts. Fast counts speed the navigation of object trees which, in
turn, speeds the process of selecting items in a set.
The Set Analyzer Administrator can also schedule fast counts in Set Architect
to occur at specified periods for better network performance. For more
information on creating fast counts and object trees, see the Set Analyzer
Administrator’s Guide. For information on using object trees, see the Set
Analyzer User's Guide.
Related Topics

• What is an object tree?

What is a joiner?
In the analysis of sets, a joiner is an individual who was present in a set in
a given period but was not present in the prior period. The period of analysis
here corresponds to the set refresh period. No metrics are required for this
analysis to run.
Related Topics

• What is a metric?
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What is a leaver?
A leaver is an individual who was not present in a set in a given period but
was present in the prior period.

What is migration?
In Set Analysis, migration is movement of individual customers from one set
to another.

What is an object tree?
In set analysis, object trees visualize data in the source database that users
can use to drill down through to locate items to include in a set.
A Set Analyzer Administrator creates object trees in Set Analyzer after
configuring the set repository with the appropriate metadata. It is normal to
create at least one object tree. Set Analyzer users can then use these object
trees to define the contents of their sets in the Set Analyzer VisualData view.
Set Analyzer users can also create their own custom object trees. The rows
in the source tables have relationships, inherent in the data, that point to
values that can be used for categorization. These values are seldom unique
and are common to many records or rows in the table. These values can be
used to group data together and are often related to other values in other
columns in a hierarchical way.
A table can have many inherent hierarchies that indicate how these columns
are related. Defining these hierarchies as object trees is a useful method of
providing access to the table items to the Set Analyzer user who is not familiar
with the structure of the data. In Set Analyzer, the object trees do not have
to relate to a logical hierarchy, but can be constructed from any combination
of suitable objects in the set repository.

What is retention?
In the analysis of sets, retention is the number of stayers as a percentage
of the members at the end of the prior period.
Related Topics

• What is a stayer?
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What is a sampling?
A sampling is a group of the population with specified information. Ideally
you want to analyze a large sample frequently to get the most accurate
estimates and the most up-to-date information.
In Process Analysis, larger samples make it easier to detect small shifts and
make the control chart more sensitive in detecting changes without increasing
the rate of false alarms.
Note:

Start the sampling when data is available. If no data exists, the sampling can
take longer than necessary to generate.

What is segmentation?
In Set Analysis, segmentation is a way of partitioning a group of individuals,
for example customers, prospects, or suppliers, into categories referred to
as sets. Usually the groups are mutually exclusive, but they can overlap.

What is a stayer?
In the analysis of sets, a stayer is an individual who is present in a set in a
given period as well as the prior period.

What is a subject?
In Set Analysis, the subject defines the central theme for the sets which are
based on it. A set can contain data for only one subject; for example,
customers, accounts, products, etc. In the context of a customer subject,
you can define sets that include conditions based on the various tables and
views that describe the customer entity.

What is turnover?
In the analysis of sets, turnover is the number of leavers as a percentage of
the members at the end of the prior period.
Related Topics

• What is a leaver?

274

SAP BusinessObjects Dashboard Builder User Guide

Using analytics for analysis
Analytics that can be created in Dashboard Builder

Tools
Compound analytic
In the Compound analytic you can create one or more of any combination
of analytics in a page. The analytics in it are edited individually. The
Compound analytic is useful when you have content that you wanted repeated
in more than one dashboard tab.
For example, if you want corporate dashboards to have a standard title page
or header that includes the corporate logo and name and confidentiality
information, you can create a compound analytic that contains all of this
information and save it to a public folder.
In another example, if you want to reuse the same analytics in a specific
layout, you can save them in a compound analytic. You can then create other
compound analytics based on this analytic, but reset the data source in each
instance.
The Compound analytic can work with the viewer analytic in a dashboard,
so that when you click a link in an analytic, the destination appears in the
viewer, instead of in a separate browser window.
Related Topics

• The Viewer analytic in dashboards
• Working with a dashboard or Compound analytic in Freeform layout mode

The Viewer analytic in dashboards
By default objects called from an analytic link open to occupy the full
dashboard space. The Viewer analytic offers a way to display, in the size
you determine, objects called from analytics via analytic links that use
openAnalytic variables.
For example, in a dashboard tab that contains a Viewer, when you select in
a Metric Tree a box title that contains a link, the destination analytic appears
in the Viewer. This allows you to see the Metric Tree itself and the destination
analytic side by side.
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In another example, you created a Web Intelligence report and you want to
select linked items in the report, and have the linked document appear in
the Viewer.
The Viewer analytic is particularly useful with the Navigation List analytic.
You use the Navigation List as a 'table of contents' and the Viewer as the
viewing portlet. This saves you dashboard space.
You find the Viewer analytic in the dashboard edit mode, in Toolbox > New
Analytic. To add it to a dashboard, drag Viewer to the dashboard layout
area and resize as necessary using the lower, right-hand corner resize icon.
Related Topics

• Using a Navigation List on a dashboard tab
• OpenAnalytic variables used in goal, metric and universe query analytics
• Configuring the box title in a Metric Tree analytic

Text analytic
You use a text analytic when you want to add a block of text to a dashboard.
The text can be a header, descriptive text, HTML and even an OpenAnalytic
hyperlink that opens in a dashboard viewer a document on the Central
Management Server.
Configuring a text analytic

The best practice when creating HTML code or link text for use in the analytic
is to create the code in an text editor, and then copy and paste the syntax
into the analytic text box.
You can set the following properties for this analytic:
•

Type of text (plain or HTML)

•

Style sheet used

Related Topics

• Sending information to the Viewer analytic in a dashboard using
openAnalytic
• The Viewer analytic in dashboards
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Web Page analytic
The Web Page analytic is available in the "New Category" of the Dashboard
Builder Analytic Toolbox. You use it in dashboards to display web pages or
images.
You can use either a URL or a relative path to an image.
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Scheduling is executing an action at a pre-defined time. You can use
scheduling to avoid using resources at peak working time. On the "Scheduler"
page in Dashboard Builder, you can perform the following actions on existing
tasks:

Viewing scheduled tasks in Scheduler
Scheduler lists the available scheduled tasks.
The following information is displayed in the list of available tasks:
•

"Task"
The name of the object(s) scheduled for refresh.

•

"Frequency"
The frequency of the scheduled refresh (refer to the run object information
in this documentation for a description).

•

"Start Time"
The start time of the scheduled task.

•

"End Time"
The end time of the scheduled task.

To refresh the list of scheduled tasks, click Task List.
Related Topics

• Run object in a scheduled event task

Managing scheduled tasks in Scheduler
You can perform the following actions on existing scheduled tasks in
Dashboard Builder > Scheduler:
•
•
•

Add new task
View scheduled tasks
View the history of a scheduled task

Related Topics

• Viewing scheduled tasks in Scheduler
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• Adding a scheduled task in Scheduler
• The schedule history in Scheduler

The schedule history in Scheduler
To view the history of a scheduled task, click History.
The "History" dialog box displays the execution history for the selected task.
The execution history includes the following information:
•
•
•
•

"Total Instances Returned": the total number of instances of the schedule
that are displayed in the history list
"Status": the status of the schedule: pending (for a task being executed
currently), failed, or success
"Instance Time": the time at which the instance of the schedule was
executed
"Run By": the name of the user account that executed the schedule

Note:

Click Refresh History List to update the list of instances displayed in the
history window.
The "History Details" pane lists the following information about the schedule
and its history:
•
•
•
•
•
•

"Status": the status of the schedule: pending (for a task being executed
currently), failed, or success
"Creation time": the time that the task was created
"Server used": the name of the server that executed the schedule
"External Destination"
"Start Time": the start time of the instance
"End Time": the end time of the instance

Related Topics

• Server
• Setting the destination in a scheduled task in Scheduler

Deleting a schedule history instance in Scheduler
1. In Dashboard Builder > Scheduler, select the instance from the list.
2. Click Delete.
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Viewing detailed information about an instance in Scheduler
1. In Dashboard Builder > Scheduler, select the instance from the list.
2. Click View Detail Information.
The "History Details" window opens.

Deleting a scheduled task in Scheduler
1. In Dashboard Builder > Scheduler select a scheduled task from the
list.
2. Click Delete.
3. Click OK to confirm the task deletion.

Adding a scheduled task in Scheduler
Before scheduling automatic tasks, configure the "Scheduler Parameters"
in Dashboard and Analytics Setup > Parameters > Options.
In Dashboard Builder > Scheduler, schedule the automatic refresh of the
following objects:
• metrics
• sets
• models
• analytics
• control charts

Scheduling a metric refresh in Scheduler
1. In Dashboard Builder > Scheduler, above the list of scheduled tasks,
click Add > Metric Refresh.
The "New Schedule" dialog box opens.
2. Click Choose to launch the "Metric Selection" window.
3. Select the metric(s) you want to schedule for refresh and click OK.
4. In the "New Schedule" dialog box, select the "Purge" option to apply to
the metric refresh:
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•
•
•

No purge is required: the metric is not purged before refresh
Purge all periods: data for all periods in the metric calendar is purged
before refresh
Select previous periods to purge: select the number of previous
periods for which data will be purged before refresh

5. Click Next.
The "AFScheduleProgram" dialog box opens.
Related Topics

• Adding a scheduled task in Scheduler
• Creating a scheduled task in Scheduler

Scheduling a set refresh in Scheduler
You need to have a valid license for the Set Analysis module to be able to
schedule a set refresh.
1. In Dashboard Builder > Scheduler, above the list of scheduled tasks,
click Add > Set Refresh.
The "New Schedule" dialog box opens.
2. Click Choose to launch the set selection window.
3. Select the set you want to schedule for refresh and click OK.
4. In the "New Schedule" dialog box, select the Set Option to apply to the
set refresh:
• Rebuild: the set data is rebuilt before refresh
• Finish: the last step of the set is built, while counts from previous
steps are maintained
• Number of builds: determines the number of builds before the set is
refreshed
5. Click Next.
The "AFScheduleProgram" dialog box opens.
Related Topics

• Creating a scheduled task in Scheduler
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Scheduling a Predictive model refresh in Scheduler
1. In Dashboard Builder > Scheduler, above the list of scheduled tasks,
click Add > Model Refresh.
The "New Schedule" dialog box opens.
2. Select the subject area containing the model.
3. Select the model you want to schedule for refresh.
4. Optionally, check Public to make the model available to all users.
The model name, population, influencers, goals and refresh date of the
selected model are displayed.
5. Click OK.
The "AFScheduleProgram" dialog box opens.
Related Topics

• Creating a scheduled task in Scheduler

Scheduling an analytic refresh in Scheduler
1. In Dashboard Builder > Scheduler, click Add > Analytic Refresh.
The "New Schedule" dialog box opens.
2. Click Choose to locate the analytic you want to refresh.
The "Document List" dialog box opens.
3. Select the analytic you want to refresh from the list of available documents.
Optionally, click Document list to refresh the list of available documents.
4. Click OK.
The "AFScheduleProgram" dialog box opens.
Related Topics

• Creating a scheduled task in Scheduler
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Scheduling a control chart refresh in Scheduler
You need to have a valid license for the Process Analysis module, if you
want to schedule a control chart refresh.
1. In Dashboard Builder > Scheduler, above the list of scheduled tasks,
click Add > Control Chart Refresh.
The "New Schedule" dialog box opens.
2. Click Choose to select a control chart.
3. Optionally, activate Purge before Refresh to purge the data in the control
chart.
4. Click Next.
The "AFScheduleProgram" dialog box opens.
Related Topics

• Creating a scheduled task in Scheduler

Creating a scheduled task in Scheduler
1. In Dashboard Builder > Scheduler, select a scheduled event task from
the task list.
2. If you selected an analytic refresh as the scheduled task, select a
destination for the schedule. This option is not available for the other task
types.
3. Select a server for the schedule.
4. Optionally, associate available events to the schedule.
5. Click Schedule.
Related Topics

• Run object in a scheduled event task
• Setting the destination in a scheduled task in Scheduler
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Run object in a scheduled event task
Depending on the time frame you choose for a scheduled event in Scheduler,
additional fields are displayed:
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Field

Description

Now

The schedule is executed as soon as you apply the
rule.

Once

The schedule is executed once. Select the start date
and time and end date and time for execution.

Hourly

The schedule is executed every N hours and X minutes.
Select the hour(N) and the minute(X) on which to execute the schedule, the start date and time and the end
date and time.

Daily

The schedule is executed once every N days. Select
the Day(N) on which to execute the schedule, the start
date and time and the end date and time.

Weekly

The schedule is executed every week on the days you
select. Select the days of the week on which to execute
the schedule, the start date and time and the end date
and time.

Monthly

The schedule is executed every N months. Select the
month on which to execute the schedule (where N is
a calendar month from 1 through 12), the start date and
time and the end date and time.

Nth day of month

The schedule is executed on the Nth day of each
month. Select the Day(N) on which to execute the
schedule, the start date and time and the end date and
time.

1st Monday of Month

The schedule is executed on the first Monday of each
month. Select the start date and time and the end date
and time.
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Field

Description

Last Day of Month

The schedule is executed on the last day of each
month. Select the start date and time and the end date
and time.

X day of Nth Week of
the Month

The schedule is executed on the X day of Nth week of
the month. Select the Week(N) and the Day(X) on which
to execute the schedule, the start date and time and
the end date and time.

Calendar

The schedule is executed based on a calendar defined
and stored in the CMC.

Related Topics

• Setting the destination in a scheduled task in Scheduler
• Creating a scheduled task in Scheduler

Setting the destination in a scheduled task in
Scheduler
The "Destination" option is available only for an analytic refresh.
1. In Dashboard Builder > Scheduler, select one of the following
destinations:
• Default Enterprise location
The analytic is refreshed and sent to the default location.
•
•

Default inbox
Specific inbox

2. Click Schedule.
Related Topics

• Scheduling an analytic refresh in Scheduler
• Scheduling a task to an Inbox in Scheduler
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Scheduling a task to an Inbox in Scheduler
To use this feature, you must first configure the email options in Dashboard
and Analytics Setup > Parameters. Refer to the Dashboard and Analytics
Setup documentation for details.
1.
2.
3.
4.

Create and save an analytic as a corporate document in the "Public".
In Dashboard Builder > Scheduler, click Add > Analytic refresh.
Click Choose and select the analytic from the appropriate folder.
Click Next.
The "AFScheduleProgram" dialog box opens.

5. In the Destination section, select Specific Inbox.
6. Select Users or Groups from the "Choose" list to indicate the recipient(s)
of the email.
7. Use the search feature to look for users or groups.
8. Select users or groups from the list of "Available Recipients" and add
them to "Selected Recipients" using the arrows.
9. Click Schedule.
Related Topics

• Creating a scheduled task in Scheduler

Sending personalized data in analytics to individual
recipients
You can also send personalized data to individual recipients by defining
restrictions on the data you schedule. This ensures that only the data that
is relevant to each user appears in the analytic each user receives via the
inbox.
You set these restrictions in Designer and apply them in Dashboard Builder
(refer to the Designer documentation for more details on the Designer portion
of the workflow).
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Setting a restriction on a universe in Designer
1. In Designer, open the universe on which you want to set a restriction and
select the class or object on which you want to create the restriction.
2. Select Tools > Manage Security > Manage Security Restrictions .
3. In the Manage Access Restrictions window, under Available Restriction
sets, click New.
4. Name the new Restriction set.
5. In the Edit Restriction set window, click the Rows tab.
6. Click Add to choose the table on which you want to set a restriction.
7. In the New Row Restriction window, click the arrow to list available tables.
8. In the Table Browser, select the table on which you want to set the
restriction and click OK.
9. In the New Row Restriction window, click the arrow next to the Where
Clause pane to launch the Where Clause Definition window.
10. In the Where Clause window, construct the where clause to apply to the
table and click OK.
11. Click OK to close the Edit Restriction set window.
12. In the Manage Access Restrictions window, click Add Users or Groups.
13. In the Select Users and Groups window, add the users or groups to which
you want to apply the access restriction and click OK.
14. In the Manage Access Restrictions window, select the restriction set in
the left pane and the users/groups to which you want to apply it in the
right pane, click Apply then OK.

Applying a universe restriction to an analytic
1. In Dashboard Builder, open the analytic to which you want to apply the
security restrictions.
2. In the analytic edit panel, define a universe query on which you defined
the restriction.
3. Save the resulting analytic.
4. Create a new dashboard using the analytic.
5. Under "Document Retrieval Properties", select Check dashboard's user
inbox and click OK.
6. Click Apply & Close.
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7. In Dashboard Builder > Scheduler, schedule the source analytic.
8. Under "Destination", select Specific Inbox, then choose users or groups
to whom to schedule the analytic.
9. Click Schedule.
Recipients receive personalized versions of the analytic based on their
rights.
Related Topics

• Creating a scheduled task in Scheduler

Server
Under "Server Group" you set the default server to use for scheduling the
object. You can also set the default to servers belonging to a particular group
or use only servers belonging to the selected group.
Configure the server options in in Dashboard and Analytics Setup >
Parameters > Options > Scheduler Parameters. Refer to the Dashboard
and Analytics Setup documentation for information.

Events
From the available events, select the following:
•
•

Events to wait for: events that whose execution will launch the scheduled
task
Events to trigger on completion: events that will be triggered once the
schedule is executed

Events are created by an administrator in the Central Management Console.
For more information on creating events, refer to the BusinessObjects
Enterprise administrator documentation.
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What is Dashboard Builder?

BusinessObjects Dashboard and Analytics connects goals, metrics, and
people in order to drive improved management, analysis, and action across
the organization. Metrics offer up-to-the-minute snapshots of your key process
indicators (KPIs) and tracking goals allows you to monitor day-to-day activity
results.
Business Objects offers the following tools to help you mine your data for
trends:
•
•
•
•
•

Dashboard Builder
Performance Manager
Set Analysis
Predictive Analysis
Process Analysis

What is Dashboard Builder?
Dashboard Builder is a BusinessObjects Dashboard and Analytics application
that helps you manage and track your company's performance using analytics
and dashboards, as well as schedule the refresh of metrics, sets, control
charts, Predictive models and analytics.

What is Performance Manager?
BusinessObjects Performance Manager helps organizations align actions
with strategy. Through setting goals and tracking performance in scorecards,
people can focus their efforts, collaborate with others, and follow
recommended actions to improve organizational performance.

What is Predictive Analysis?
BusinessObjects Predictive Analysis quickly uncovers key business drivers
from your data and forecasts future business conditions. It helps people
make proactive decisions more easily by providing insights via easy-to-use
dashboards across the organization.
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What is Process Analysis?
BusinessObjects Process Analysis can be used for several purposes.
•
•
•

It helps you automate the mechanics of quality control.
It enables organizations to support quality improvement initiatives by
automatically tracking quality variables throughout the enterprise.
It helps uncover specific business processes where there is variation and
identify opportunities for improvement, by providing powerful web-based
quality management and automated control charts and alarms.

What is Set Analysis?
BusinessObjects Set Analysis helps organizations define, track and analyze
segments that drive the success of business activities.
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Analytics in the Analytic Catalog

Analytics in the Analytic Catalog
Dashboard Builder offers you many sample analytics that provide you with
ideas of the kinds of analytics you can use with your own data. You can
customize some of the sample analytics with your own data.

Metric analytics in the Analytic Catalog
You can create a new analytic based on pre-defined analytics in the Metric
Analytics tab of the Dashboard Builder Analytic Catalog.
Related Topics

• Creating an analytic based on an existing analytic
• Creating an analytic

Sample trend analysis analytics
The following sample analytics are available in the Metric Analytics section
of the Dashboard Builder Analytic Catalog:
•
•
•
•
•

Annual growth
Dual metric comparison
Overview
Raw versus smoothed
Year-to-year change

Annual growth
Annual growth is a sample Metric analytic in the Dashboard Builder Analytic
Catalog. It is based on a Web Intelligence query and shows the annual growth
rate of a given metric.
Annual growth is calculated using a "% change" metric with an Annual
difference.
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Dual metric comparison
Dual metric comparison is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares and contrasts two metrics or subsets that
require different scales. This analysis permits comparisons either of two
metrics for the same subset or, alternatively, of two subsets with respect to
the same metric.
For example, you can compare the count and average purchase last quarter
for members of a particular set, or you can compare the average purchases
last quarter of a set's Joiners and Leavers.
Note:

•

Use either of the following:
• two metrics with one subset
• one metric with two subsets

•

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Overview
The Overview analytic in the Metric analytic samples of the Dashboard Builder
Analytic Catalog provides you an example of a Web Intelligence query that
contains a current snapshot on the list of available sets.
In addition to the membership of each metric that has been defined for the
set or group, this analytic also provides data for Joiners, Stayers, and Leavers
in the Metric Status List. It also provides important metadata associated with
the chosen set. The data available in the Overview is a good starting point
for acquainting yourself with the status of sets, groups, metrics as well as
for making decisions regarding which metrics to add.
You can display the following details:
•
•
•
•

Name
Description
Creation date
Frequency of the refresh
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Once you have selected a set to review, familiarize yourself with the refresh
period and the date of the last refresh. This gives you a context for interpreting
the data displayed in the Metric Status List. The Metric Status List displays
the most recent refresh period of each metric for various subsets - Members,
Joiners, Stayers, and Leavers.
A drop-down allows you to view the metrics which are cross set: migrating
from, migrating to, overlapping members, same time leaver and same time
joiners.
The set list is displayed and the metrics for the selected set are displayed.
Click Metric Details to display a graphical representation. You can view the
graph in different ways - line, bar, percent of origin or percentage change of
origin. You can either view set details based on measures or based on a
subset.

Raw versus smoothed
Raw Versus Smoothed is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that reveals hidden trends within the naturally fluctuating
values of a metric. Raw versus Smoothed shows metric values versus
smoothed values for a given smoothing method selected from a list.
Smoothing can be used to remove seasonality and makes long-term
fluctuations stand out more clearly.
Note:

•
•

Make sure the smoothing methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Year-to-year change
Year-to-Year change is a sample Metric analytic in the Dashboard Builder
Analytic Catalog and is applicable to additive metrics only (unless the metric
is yearly). It shows periods of growth with caps.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.
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Sample comparison analytics
The following sample comparison analytics are available in the Metric
Analytics section of the Dashboard Builder Analytic Catalog:
•
•
•
•
•
•
•
•
•

Change compare
Kiviat diagram
Pareto chart
Percent compare
Profile compare
Radar diagram
Range compare
Rollup compare
Top slices

Change compare
Change compare is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that compares sets at a point in time. It distinguishes which
sets are above the average from those that are below.
Change compare provides a common base of comparison of change for
different metrics. It is useful especially when metrics are measured in different
kinds of units (for example, Number of customers vs Total revenue).
You can select the lag you want. If you choose lag 1, the change is calculated
from adjacent period. If you choose lag 12 for monthly metrics, the change
is the annual change.
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Kiviat diagram
The Kiviat diagram in the Metric Analytics tab of the Dashboard Builder
Analytic Catalog assesses your organization or product.
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Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Pareto chart
The Pareto chart on the Metrics analytics sample tab in the Dashboard Builder
Analytic Catalog is a type of histogram in which bars are arranged in
descending order, from left to right. It includes a cumulative curve that
represents the added contribution of each category.
Related Topics

• Pareto Chart

Percent compare
Percent compare in the sample Metric analytics in the Dashboard Builder
Analytic Catalog compares metrics to a Benchmark metric.
A Percent compare graph displays a benchmark metric as a flat line of value
zero. If a compared-metric line rises above zero, it is out-performing the
benchmark metric. If it declines below zero, the compared-metric is
under-performing the benchmark metric.
The Benchmark metric can be an Index or a best-in-class performance metric.
The formula for Percent compare is:
(Compared Metric/Benchmark Metric) - 1
Note:

This analytic is based on a Web Intelligence query on the sample Business
Objects universes.

Profile compare
Profile compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that is useful to compare two sliced metrics at a given point in time.
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Note:

This analytic is based on a Desktop Intelligence report.

Radar diagram
The Radar diagram is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that is useful to visually benchmark your company or product
against the industry or the competition.
Note:

This analytic is based on a Web Intelligence query.

Range compare
Range compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows range by slice. The gray thin bar represents the range.
The red/black mark represents the average value.
Sliced metrics with minimum, maximum and average values are required for
this analysis to run.
Note:

This analytic is based on a Desktop Intelligence report.

Rollup compare
Rollup compare is a sample Metric analytic in the Dashboard Builder Analytic
Catalog that shows a Year Versus Previous year matrix by slice at a given
point in time. The light gray figures are totals by filter.
The user can choose the time rollup.
Note:

•
•

Make sure the time rollup methods have been set up for all calendars.
This analytic is based on a Web Intelligence query on the sample Business
Objects universes.
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Top slices
Top slices, a sample Metric analytic in the Dashboard Builder Analytic
Catalog, shows the best and worst performers among the slices of a given
metric in the current period. It points out the slices that reach the top for the
first time as well as those that have just fallen out. Beyond the current status,
it gives the number of times a slice has been on top and what was its last
rank (for example, its rank in the previous period).
Note:

This analytic is based on a Desktop Intelligence report.

Sample deviation analytics
The following samples are available in the Metric Analytics tab of the
Dashboard Builder Analytic Catalog:
•
•
•
•
•
•
•

Deviation from annual change
Deviation from moving average
Deviation from same months average
Deviation from specified target
Deviation trend
Moving average bands
Shewhart u chart

Deviation from annual change
Deviation from Annual Change is a sample Metric analytic in the Dashboard
Builder Analytic Catalog that shows how much a metric deviates from the
year-to-year relative change (for example, the target). This analytic tracks
the progress of sales for the current year compared to the previous year
sales.
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
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Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Deviation from same months average
Deviation from Same Months Average is a sample Metric analytic in the
Dashboard Builder Analytic Catalog that shows how much a metric deviates
from the Same Months Average (for example, the target).
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Deviation from specified target
Deviation from Specified Target is a sample Metric analytic in the Dashboard
Builder Analytic Catalog that shows how much a metric deviates from a target
which is another metric.
Each bar represents the deviation of a given period. The line represents the
cumulative deviation. If the line rises above zero, the metric is out-performing
the target. If it declines below zero, the compared-metric is under-performing
the target.
Note:

•
•

Use the Deviation Trend analytic, also in the Dashboard Builder Analytic
Catalog, to track the cumulative deviation for large time series.
This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
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Deviation trend
The Deviation Trend is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that is useful for tracking the deviation from a target and
predict whether or not the total target can be. The Deviation Trend is suitable
for seasonal data and large time series.
The plain line represents the cumulative deviation indexed on the total target.
The user can select the trend start date.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Moving average bands
The Moving average bands is a sample Metrics analytic in the Dashboard
Builder Analytic Catalog that shows the raw values of a given Metric (black
line) within moving average bands (green lines). You can create an alert that
notifies you when the raw data line hits the lower band or the upper band.
Moving average bands can also be used to find the proper thresholds for
alerts.
The moving average bands also represents the distance in standard
deviations between the raw values and the moving average. Length and
offset are two parameters entered by the user when running the analysis
and they define the moving time window.
Higher and lower band size represent the distance in standard deviation
between the raw values and the moving average.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Shewhart u chart
The Shewhart u Chart is a sample Metric control chart in the Dashboard
Builder Analytic Catalog that is used in quality management. It is suitable to
measure average defects per unit when sample sizes vary.
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UCL Level and LCL Level are two parameters entered by the user when
running the analysis.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
Related Topics

• What is a Shewhart control chart?
• What is a defects per unit (u) chart?

Statistical analytics in the Analytic
Catalog
Statistical analytics are based on Web Intelligence and Desktop Intelligence
queries on the sample Business Objects universes. You may customize them
by populating them with data to create your analytics.
Related Topics

• Creating an analytic based on an existing analytic
• Creating an analytic

Sample forecast analytics
The following analytics are available in the Statistical Analytics section of
the Dashboard Builder Analytic Catalog:
•
•
•
•
•
•
•
•

Forecast Annual Change
Moving Average - Moving Regression
S-Shaped Trend
Same Days Moving Average
Same Months Moving Average
Same Quarter Moving Average
Single Exponential Smoothing
Standard Time Trends

Note:

These analytics are based on Desktop Intelligence documents.
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Forecast annual change
Forecast Annual Change is a sample Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful to forecast one year ahead. You need
at least two years of data to be able to forecast. This forecasting method
applies the year-to-year relative change to the raw data and projects the
result one year ahead.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

S-shaped trend
The S-shaped trend is a sample Metric analytic in the Dashboard Builder
Analytic Catalog that shows the s-shaped trend that fits your metric series.
Two models are proposed:
•
•

Logistic curve
Gompertz curve

Try different values of L (upper limit of the curve) to find out the limit that has
the lowest MAPE error in the table. This analysis allows you to forecast your
metric data by the method of Trend Extrapolation. You can choose the
number of periods to forecast when running the analysis.
Often, when plotted over time, the sales of a product follow an s-shaped
curve. This is the case if sales start by increasing slowly, then increase
sharply and finally level off at some upper limit L. A sales pattern of this type
is likely to occur for a product that follows the product life cycle. Often the
diffusion over time of the number of companies producing a product also
follows an s-shaped curve.
Fitting an s-shaped curve to the first few months or years of data is important
because it enables a company to estimate L, the maximum sales level for
the product. Fitting the s-shaped curve also enables us to estimate the length
of time passed before sales start to level off. Such information can be useful
in capacity planning and strategic planning.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.
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Related Topics

• What is the Gompertz curve?
• What is the logistic curve?

Same days moving average
Same Days Moving Average is a sample Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful for forecasting daily metrics one week
ahead. You can choose how many weeks you want to include in the
calculation of the forecast. If you choose three weeks, the forecast will be
the average of the last three same days values.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Same months moving average
Same Months Moving Average is an example of a Statistical analytic in the
Dashboard Builder Analytic Catalog that is useful for forecasting monthly
metrics one year ahead. You can choose how many years you want to include
in the calculation of the forecast. If you choose three years, the forecast will
be the average of the last three same months values.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Same quarter moving average
Same Quarters Moving Average is a Statistical analytic in the Dashboard
Builder Analytic Catalog that is useful for forecasting quarterly metrics one
year ahead. It is suitable for seasonal data.
You can choose how many years you want to include in the calculation of
the forecast. If you choose three years, the forecast will be the average of
the last three same quarters values.
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Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Single exponential smoothing
Single Exponential Smoothing (SES) is a sample Statistical analytic in the
Dashboard Builder Analytic Catalog that provides forecasts using the
weighted moving average of past values of the data. As opposed to a moving
average that gives equal weight to the past values, SES gives weights that
decline geometrically as you go back in time. Recent data is given more
weight.
SES is suitable for data with no trend or seasonal patterns.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Sample correlation analytics
The following comparison analytics are available in the Statistical Analytics
tab of the Dashboard Builder Analytic Catalog:
•
•
•
•

ACF plot
Correlation bars
Correlation plot
Lag plot

Note:

The data source for these analytics is based on the sample data shipped
with Business Objects. You can edit the query to create an analytic. The
process to edit queries is available in the documentation for Web Intelligence,
Crystal Reports, or Desktop Intelligence.

ACF plot
The ACF (auto-correlation function) plot is a Statistical sample analytic in
the Dashboard Builder Analytic Catalog that shows the auto-correlation within
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a single time series at each lag. On the X axis are the different lags. On the
Y axis are the correlation coefficients.
The ACF plot is useful for identifying seasonal or cyclical patterns in a time
series. It can be used also to check that observations are independent.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Correlation bars
Correlation bars analytic is a Statistical sample in the Dashboard Builder
Analytic Catalog that indicates the relationship between two metrics. The
bars are ranked by size of the upper metric. If the lower metric pattern mirrors
the lower metric pattern, there is correlation between the two metrics. If the
mirror effect is reversed, the correlation is negative.
Note:

The metrics must have the same calculation interval and this analytic requires
that all of the metric's history periods are available. This analytic is based
on a Web Intelligence query on the sample Business Objects universes.

Correlation plot
A correlation plot analytic in the Statistical samples in the Dashboard Builder
Analytic Catalog indicates the relationship between two metrics. It measures
the linear association between two metrics' time series.
The correlation coefficient (r) can range from an extreme value of –1 (perfect
negative correlation) through zero to an extreme value of +1 (perfect positive
correlation).
The sign of the correlation coefficient indicates the direction of the relationship
between the two metrics. If the correlation coefficient is positive, the metrics
tend to increase and decrease together. If the correlation coefficient is
negative, one metric increases while the other metric decreases. If the
correlation coefficient is close to zero, the metrics move in relatively unrelated
directions.
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The magnitude of the correlation coefficient is a measure of the strength of
the association, meaning that as the absolute value of the correlation moves
away from zero, the association between the two metrics is strengthened.
However the graph needs to confirm this.
Note:

Use all periods available in the metrics history. The metrics must have the
same calculation interval. This analytic is based on a Desktop Intelligence
report using the sample Business Objects universes.

Lag plot
The ACF plot is a sample Process Control analytic in the Dashboard Builder
Analytic Catalog that shows see multiple lags at a glance. The lag plot shows
metric values versus lagged values for a particular lag.
It can help identify seasonal or cyclical patterns in a time series.
Lag plot can also be used to check that observations are independent, which
is an important assumption of statistical process control charts.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Sample projection and distribution analytics
The following comparison analytics are available in the Statistical Analytics
tab in the Dashboard Builder Analytic Catalog:
•
•

Distance from target
Stem and leaf

Note:

These analytics are based on Desktop Intelligence documents.
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Distance from target
Distance from Target is a sample Statistical analytic in the Dashboard Builder
Analytic Catalog that is useful for seeing how long it takes to reach a given
target value.
You can use Distance from Target to help you define a realistic target based
on past data trend.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Stem and leaf
Stem and Leaf, the sample Statistical analytics in the Dashboard Builder
Analytic Catalog, gives a quick picture of the shape of the distribution for a
given metric.
It looks like a histogram turned on its side. Its main advantage over the
histogram is that it preserves the original data values.
Data values are split into stem and leaf components. Stem and leaf works
well with a relatively small number of observations (not much more than
100). Unit and stem intervals are two parameters entered by the user.
Note:

This analytic is based on a Desktop Intelligence report using the sample
Business Objects universes.

Set analytics in the Analytic Catalog
The Set Analytics samples are based on Web Intelligence queries are
organized in the following categories:
•

Membership Analysis analytics:
• Membership breakdown
• Membership change
• Membership status

•

Set Metrics analytics:
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•
•
•
•
•
•
•
•
•

Multi set scatter
Percent of group total
Percent of enterprise
Set compare
Set vs enterprise
Set vs group average
Set vs group total growth
Set vs group turnover

Migration analytics:
• Migrants compare
• Migration by tier

Membership breakdown
Membership Breakdown is a sample Set Analysis analytic in the Dashboard
Builder Analytic Catalog that shows how the number of members is
decomposed into joiners and stayers rates (positive bars) over time. They
can be compared to the leavers rate represented as negative bars.

Migrants compare
Migrants compare is a sample Set Analytic in the Dashboard Builder Analytic
Catalog that compares metrics based on migrants. The standard net flow
enables the comparison of metrics that are measured in different units. For
this analysis to run, migrants metrics must be defined.

Migration by tier
Migration by Tier is a sample Set Analyic in the Dashboard Builder Analytic
Catalog that is useful for seeing general migration trends toward high-tier or
low-tier sets. Migration by Tier is a tabular analysis which shows the number
of migrants between sets representing different tiers as well as the amount
of overall up-migration and down-migration.
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For this analysis to run, the names of the sets must have an alpha-numeric
ordering that represents their relative positions (for example, Tier 1, Tier 2,
Tier) and migrants metrics must be defined.

Multi set scatter
Multi-set scatter is a sample Set Analytic scatter plot in the Dashboard Builder
Analytic Catalog that compares joiners, leavers and stayers rates with respect
to the current values of the metrics simultaneously, for example, cost and
revenue.
Multi-set scatter shows a snapshot of two or more subsets of a set. Two
metrics define the scatter-plot X-Y axes.
Tip: You can easily page through different periods.
Use this analysis to compare simultaneously current values for differing
subsets with respect to two measures. For example, if you want to know
whether a trend in revenue/cost ratios has emerged among Joiners and
Leavers, you can plot Revenue vs. Cost for Joiners and Leavers and compare
their relative positions.

Percent of group total
Percent of total group is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the total of a
group. It is appropriate for use with mutually exclusive sets.
Percent of total group compares two metrics that are measured in different
units. Applied to a set of mutually exclusive tiers that covers all the individuals,
with a Count metric (for example, Number of individuals) and a Revenue
metric, this analysis is a 80:20 rule chart over time.
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Percent of enterprise
Percent of Enterprise is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the enterprise
total. The formula for Percent of Enterprise is:
Set Metric / Enterprise Metric

Set compare
Set compare is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for comparing sets at a point in time. Set compare
distinguishes the sets that are above the average (blue flat line) from those
that are below.

Set vs enterprise
Set vs Enterprise is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set metric against the enterprise.
Percent of origin makes the two lines start at the same value (100%) in order
to facilitate the comparison.

Set vs group average
Set vs Group average is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking a set raw value against the
average value of a group.
Group average is calculated by averaging the values of the sets within the
group.
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Set vs group total growth
Set vs total growth is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set raw value against the group
total growth.
Total Growth solves the scale issue of set raw value versus group total. It
makes the group total trend relative to the starting value of the set trend, so
that the group total growth always starts with the same value as the set trend.

Set vs group turnover
Set vs Group turnover is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking the turnover of a set against
the turnover of a group.
Set vs Group turnover reveals the amount of change, or churn, that has
occurred in a membership. The period of analysis here corresponds to the
set refresh period.
No metrics are required for this analysis to run.

Predictive analytic samples in the
Analytics Catalog
The analytics included in Predictive Analysis samples in the Analytic Catalog
are based on the following analytics:
• Influencer Analytics
• Goal-Based Influencer Detail
• Influencer Detail
• Influencer Gains Chart
• Key Influencers
• Model Gains Chart
• Variable Profile Box Plot
•

Lists and Forecasts
• Metric Forecaster
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•

Individual List

For information on working with these analytics, see the Predictive Analysis
documentation.
Related Topics

• What is Predictive Analysis?
• Goal-based Influencer Detail analytic based on predictive models
• Individual List based on predictive models
• Influencer Detail analytic based on predictive models
• Influencer Gains Chart analytic based on predictive models
• Key Influencers analytic based on predictive models
• Metric Forecaster analytic based on metrics
• Model Gains Chart analytic based on predictive models
• Variable Profile Box Plot based on predictive models

Process control analytics in the Analytic
Catalog
The following sample Process Control control charts are available in the
Analytic Catalog:
•
•

Process Control Analytics (Samples)
Process Control Analytics

Related Topics

• Control Chart analytic based on a Process Analysis Control Chart
• Process Control Analytics
• Process Control Analytics (Samples)

Process Control Analytics (Samples)
The following samples based on the Control Chart analytic.
These samples are available at Dashboard Builder > Analytic Catalog >
Process Control Analytics Samples:
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Shewhart charts for Attribute data
•
•
•
•
•
•

c chart
u chart
u chart standardized
np chart
p chart
p chart standardized

Shewhart charts for Variable data
•
•
•
•
•

X-bar & range
X-bar & standard deviation
Median and range
Individuals & moving range
Moving average and moving range

CUSUM and EWMA charts
•
•
•
•
•
•

Cusum on defects
Cusum on individuals
Cusum on x-bar
EWMA on rejects
EWMA on individuals
EWMA on x-bar

Related Topics

• Control Chart analytic based on a Process Analysis Control Chart

c chart
The c chart on the Process Control Analytics tab in the Dashboard Builder
Analytic Catalog is an example of a Defects (c) control chart. It monitors the
number of defects, errors and accidents with a constant sample size.
Related Topics

• What is a defects (c) chart?
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Cusum on defects
The Cusum on defects chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a cumulative sum. This chart is a prevention tool as it gives signals
when defects are likely to happen.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

Cusum on individuals
The Cusum on individuals chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a cumulative sum where the Individual data option is activated.
This chart signals small changes on the individual chart.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

Cusum on x-bar
The Cusum on x-bar chart analytic in the Process Control Analytics tab of
the Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing a CUSUM. It signals small changes on x-bar chart data.
Related Topics

• What is a CUSUM control chart?
• What is a defects (c) chart?

EWMA on individuals
The EWMA on individuals chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
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containing an EWMA where the Individual data option is activated. You can
use this chart when the data is not independent or is auto-correlated.
Related Topics

• What is EWMA?
• What is a defects (c) chart?

EWMA on rejects
The EWMA on Rejects chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Percent rejected (p)
chart with the EWMA configured, and made into Standardized control charts.
It signals small shifts in a p chart or standardized p chart.
Related Topics

• What is EWMA?
• What is the percent rejected (p) chart?
• What is a standardized control chart?

EWMA on x-bar
The EWMA on x-bar chart in the Process Control Analytics page of the
Dashboard Builder Analytic Catalog is an example of a Defects (c) chart
containing an EWMA. It shows small changes on x-bar data.
Related Topics

• What is EWMA?
• What is a defects (c) chart?

Individuals & moving range
The Individuals & Moving Range chart on the Process Control Analytics
sample analytics tab in the Dashboard Builder Analytic Catalog shows how
you can monitor individual values.
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Median and range
The Median and Range chart in the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is a sample of an analytic that monitors
variables with a constant and relatively small sample size.
Related Topics

• What is a median?
• What is a range?

Moving average and moving range
The Moving Average and Moving Range chart on the Process Control
Analytics tab in the Dashboard Builder Analytic Catalog monitors individual
values where each sample has one value.
Related Topics

• What is a moving average & moving range chart?
• What is the moving average?
• What is a range?

np chart
The np chart on the Process Control Analytics tab of the Dashboard Builder
Analytic Catalog is an example of a Number rejected (np) chart.
Related Topics

• What is the number rejected (np) chart?

p chart
The p chart on the Process Control Analytics tab of the Dashboard Builder
Analytic Catalog is an example of a Percent rejected (p) chart.
Related Topics

• What is the percent rejected (p) chart?
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p chart standardized
The p chart standardized on the Process Control Analytics tab of the
Dashboard Builder Analytic Catalog is an example of a Percent rejected (p)
chart made into a standardized control chart. This chart is useful for short-run
production.
Related Topics

• What is a standardized control chart?
• What is the percent rejected (p) chart?

u chart
The u chart on the Process Control Analytics tab in the Dashboard Builder
Analytic Catalog is an example of a Defects per unit (u) chart.
Related Topics

• What is a defects per unit (u) chart?

u chart standardized
The u chart standardized on the Process Control Analytics tab in the
Dashboard Builder Analytic Catalog is an example of a Defects per unit (u)
chart made into a standardized control chart. This chart flattens the u chart
limits. It is useful for short run production.
Related Topics

• What is a standardized control chart?
• What is a defects per unit (u) chart?

X-bar & range
The X-bar & Range chart on the Process Control Analytics tab in the
Dashboard Builder Analytic Catalog monitors a variable with a constant and
relatively small sample size.
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Related Topics

• What is an X-bar & range chart?

X-bar & standard deviation
The sample X-bar & standard deviation chart on the Process Control Analytics
tab in the Dashboard Builder Analytic Catalog monitors variable data with a
variable or constant sample size.
Related Topics

• What is an X-bar & standard deviation chart?

Process Control Analytics
The following sample Desktop Intelligence control charts are available at
Dashboard Builder > Analytic Catalog > Process Control Analytics:
•
•

SPC ACF plot
SPC lag plot

Note:

These analytics are based on Desktop Intelligence reports using the sample
Business Objects universes. You can modify them to some extent using
Desktop Intelligence or Web Intelligence reports.

SPC ACF plot
The SPC ACE plot chart in the Process Control Analytics tab in the Dashboard
Builder Analytic Catalog is an example of a control chart that shows
auto-correlation within a single time series at each lag. On the X axis are the
different lags. On the Y axis are the correlation coefficients.
The ACF plot is useful to identify seasonal or cyclical patterns in a time series.
You can also use this chart to check that observations are independent.
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SPC lag plot
The SPC lag plot chart on the Process Control Analytics tab in the Dashboard
Builder Analytic Catalog is an example of a control chart that shows metric
values versus lagged values for a particular lag. It can help identify seasonal
or cyclical patterns in a time series.
The lag plot can also be used to check that observations are independent,
which is an important assumption of Process Analysis charts. To see multiple
lags at a glance use the SPC ACF plot.
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Aggregation functions
What is arithmetic mean?
The Arithmetic mean (also called average or simple mean) is the sum of the
values divided by the number of values. The arithmetic mean is relevant any
time several quantities add together to produce a total.
It answers the following question: if all the quantities had the same value,
what would that value have to be in order to achieve the same total?
Related Topics

• What is harmonic mean?
• What is geometric mean?

Average functions
•
•
•

Average: Returns the average by transaction.
Average by individual: Returns the average by individual for individuals
of a subset.
Average distinct: Returns the average by transaction of distinct values.

Count functions
The following count aggregate functions are available:
• Count all: Counts the number of occurrences of all values.
• Count distinct: Counts the number of occurrences of a distinct value.
• Count null: Counts the number of occurrences of null values only.

What is geometric mean?
The Geometric mean is the nth root of the product of the n values. Less often
used than the arithmetic mean, it is appropriate for averaging ratios such as
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rates of change, interest rates or inflation rates. More generally, the geometric
mean is relevant any time several quantities multiply together to produce a
product.
The geometric mean answers the question: if all the quantities had the same
value, what would that value have to be in order to achieve the same product?
The formula for Geometric mean is as follows:

Note:

The values must be greater than zero.
Related Topics

• What is harmonic mean?
• What is arithmetic mean?

What is harmonic mean?
The Harmonic mean is the reciprocal of the arithmetic mean of the reciprocals
of the values. It is used to calculate average rates such as distance per time,
or speed. The formula for harmonic mean is:

Related Topics

• What is arithmetic mean?
• What is geometric mean?

What is a median?
The median is the midpoint of the values after they have been ordered from
the smallest to the largest, or the largest to the smallest. There are as many
values above the median as below it in the data set.
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The median is less sensitive to outliers (extreme values or errors) than the
arithmetic mean is. For an odd number of values, the median is the middle
value in the ordered set. For an even number of values, the median is the
arithmetic mean of the two middle values.
One measure related to median is:
Depth of the median = (number of values + 1) / 2
Related Topics

• What is a median & range chart?

What is maximum?
Used as an aggregate function, maximum returns the maximum value of a
set of values.

What is minimum?
Minimum used as an aggregate function returns the lowest value of a set of
values.

What is population kurtosis?
The coefficient of Kurtosis measures the relative peak of the curve defined
by the distribution of the values. Standard normal distribution has a Kurtosis
coefficient of 0. A Kurtosis coefficient of greater than 0 indicates that the
distribution is more peaked than the standard normal distribution. A Kurtosis
coefficient of less than 0 indicates that the distribution is flatter than the
standard normal distribution.
The formula for population coefficient of Kurtosis is:
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What is population skew?
The skew statistic measures the degree to which a variable deviates from
symmetry with the mean at the center. A skew of value zero means that the
distribution is a symmetrical curve. A positive value indicates that the values
are clustered primarily to the left of the mean with most of the extreme values
to the right of the mean. A negative skew indicates clustering to the right.
Distributions with positive skew are more common than distributions with
negative skew.
An example of positive skew is the distribution of income:

The formula for population skew is:

What is population standard deviation?
Returns the square root of the population variance. Standard deviation is
expressed in the same unit as the data. The formula for population standard
deviation is:
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What is population variance?
Variance is a sum of the squared deviations from the mean, divided by n-1
or n. The formula for population variance is:

What is sample kurtosis?
The coefficient of Kurtosis measures the relative peak of the curve defined
by the distribution of the values. Standard normal distribution has a Kurtosis
coefficient of 0. A Kurtosis coefficient of greater than 0 indicates that the
distribution is more peaked than the standard normal distribution. A Kurtosis
coefficient of less than 0 indicates that the distribution is flatter than the
standard normal distribution.
The formula for sample coefficient of Kurtosis is:

What is sample skew?
The skew statistic measures the degree to which a variable deviates from
symmetry with the mean at the center. A skew of value zero means that the
distribution is a symmetrical curve. A positive value indicates that the values
are clustered primarily to the left of the mean with most of the extreme values
to the right of the mean. A negative skew indicates clustering to the right.
Distributions with positive skew are more common than distributions with
negative skew. An example of positive skew is the distribution of income.
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The formula for sample skew is:

What is sample standard deviation?
Returns the square root of the sample variance. Standard deviation is
expressed in the same unit as the data. The formula for sample standard
deviation is:

What is sample variance?
Variance is a sum of the squared deviations from the mean, divided by n-1
or n. The formula for sample variance is:

What is sum?
Sum returns the total of a set of numeric values.
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What is sum distinct?
Sum distinct returns the total of a set of distinct numeric values.

What is an alert?
A Dashboard and Analytics alert informs the user of any major changes
that occur in the business. Alerts are created as a component of a rule in
Performance Manager.

What is an analytic?
An analytic is a pre-built analysis technique for extracting business insight
from data and creating alerts, lists, and interactive data visualization applets.
Add analytics to dashboards to display data in a meaningful and efficient
manner.

What is a metric?
A metric, or KPI, is the measure of actual performance. A metric is defined
using objects in the universe, and is usually made up of the following:
• a measure
• a filter
• a date restriction
You can use metrics to track actual performance and compare it to a goal,
or use it to project a trend.
Metrics can also be created on a set universe. Set metrics allow you to track
a measure over time for a particular subject within a set.
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Moving averages explained
What is the moving average?
In data analysis, you use the moving average to calculating the average
value of an indicator, over a period of time. In some time series, seasonal
variation is so strong it obscures any trends or cycles, which are very
important for the understanding of the process being observed.
Moving average may be used as a smoothing method that removes
seasonality and makes long-term fluctuations in the series stand out more
clearly. It may also be used for forecasting purposes.

Moving average transformations
Transformation

Use

MA 2x12

If your time series is monthly, use the MA 2x12 to remove the seasonality.

MA 2x24, MA 2x36

If a stronger "seasonality filter" is required, use MA
2x24 or MA 2x36 for monthly series.

MA 3x3, MA 3x9,
MA 3x5

Also known as a double moving average, this moving
average that is taken of a series of data that already
represents the result of a moving average.

MA exponentially
weighted
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Transformation

Use

A moving average transformation. Henderson’s MA is
another centered symmetric weighted moving average
method. The 5- and 7-point averages are used for
Quarterly series. The 9-, 13-, and 23-point averages
MA henderson 9-pt,
are used for Monthly series.
13-pt, 23-pt

Note:

All the moving average methods are externalized in a
file (Stats.ini) that can be customized.
MA linearly weighted
MA linearly weighted center

MA same months

This same months moving average method uses a
fixed-interval time window but with non-continuous
data points. It is useful on seasonal data for smoothing
or forecasting purposes.

MA spencer 15-pt,
21-pt

The Spencer’s weighted moving average is an approach to computing a moving average that will compensate for a cubic trend in the data. It consists of two
averages, one for 15 periods and the other for 21 periods. Spencer’s weights are centered and symmetric.

Related Topics

• MA exponentially weighted
• MA linearly weighted
• MA linearly weighted center
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MA exponentially weighted
A moving average transformation. An MA exponentially weighted
transformation finds the number of points parameter required. The smoothing
constant parameter is required:
• Less than 1 weights current data more heavily
• Equal to 1 weights every points identically (same as simple MA)
• Greater than 1 weights old data more heavily
The Single exponential smoothing (SES) forecast can be expressed as a
weighted moving average that applies exponentially decreasing weights to
the data, as the observations get older. Thus it is called exponential
smoothing.
The next period forecast is then:
Ft+1 = aYt+a(1 - a)Yt–1 + a(1 - a)²Yt–2 + a(1 - a)³Yt–3
+ … + a(1 - a)^ t–1 Y1+a(1 - a)^ t F1
where a is a constant between 0 and 1, and F1 is the initial value that usually
is given the value of Y1.
As a guide in choosing a, try values close to 0 if the series has a lot of random
variation. If you wish the forecast values to depend strongly on recent
changes in the actual values, try values close to 1.

MA linearly weighted
A moving average transformation. You use a weighted moving average to
give more weight to current data. Weights can be calculated automatically
using a function.
The weight function for a Linearly weighted MA is defined as:
W(p)=(2/n(n+1)) p
where p is the sequence of the data points in the moving window ranging
from 1 to n. The weights must sum to a value of one.
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The weight function for a exponentially weighted MA is defined as:
W(p)=power(a,n-p)
where a is the smoothing constant and p is the sequence of the data points
in the moving window ranging from 1 to n.
Smoothing constants less than 1 weigh recent data more heavily. A smoothing
constant of 1 gives equal weight to each point. If the smoothing constant
exceeds 1, older data are weighted more heavily than recent data.

MA linearly weighted center
A moving average transformation. A centered weighted moving average,
also known as a double moving average, is a moving average that is taken
of a series of data that already represents the result of a moving average.
With a centered weighted moving average, the majority of the weight is
assigned to the middle portion of the data. A centered weighted moving
average is useful to de-seasonalize the data.
If your time series is quarterly, use the MA 2x4. If stronger “seasonality
filters ? are required, use MA 2x8 or MA 2x12 for quarterly series.

MA centered
A moving average transformation.
Related Topics

• What is the moving average?

What is single exponential smoothing?
Single exponential smoothing (SES) is a forecasting method that works best
for data which have no trend, no seasonality, or underlying pattern. It takes
the forecast for the previous period and adjusts it using the forecast error.

336

SAP BusinessObjects Dashboard Builder User Guide

Dashboard Builder Terms
Moving averages explained

If Yt is the actual observation for period t and Ft is the forecast for the same
period, then the forecast for the next period is:
Ft+1 = Ft+a(Yt–Ft)
where a is a constant between 0 and 1.
An SES analytic is based on the time series system universe. The SES
weight function is built into the universe. The end user can try different values
of the smoothing constant in order to find the best one.
Related Topics

• MA exponentially weighted
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Information Resource

Location

SAP BusinessObjects product
http://www.sap.com
information

Select http://help.sap.com > SAP BusinessObjects.
You can access the most up-to-date documentation covering all SAP BusinessObjects products and their deployment
at the SAP Help Portal. You can download PDF versions
or installable HTML libraries.
SAP Help Portal

Certain guides are stored on the SAP Service Marketplace
and are not available from the SAP Help Portal. These
guides are listed on the Help Portal accompanied by a link
to the SAP Service Marketplace. Customers with a maintenance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support
representative.
http://service.sap.com/bosap-support > Documentation
•
•

SAP Service Marketplace

Installation guides: https://service.sap.com/bosap-inst
guides
Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation
guides, upgrade and migration guides, deployment guides,
release notes and Supported Platforms documents. Customers with a maintenance agreement have an authorized
user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the
SAP Service Marketplace from the SAP Help Portal, use
the menu in the navigation pane on the left to locate the
category containing the documentation you want to access.
https://boc.sdn.sap.com/

Developer resources

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
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Information Resource

Location

SAP BusinessObjects articles https://www.sdn.sap.com/irj/boc/businessobjects-articles
on the SAP Community NetThese articles were formerly known as technical papers.
work

https://service.sap.com/notes
Notes

These notes were formerly known as Knowledge Base articles.

Forums on the SAP Communihttps://www.sdn.sap.com/irj/scn/forums
ty Network

http://www.sap.com/services/education
Training

From traditional classroom learning to targeted e-learning
seminars, we can offer a training package to suit your
learning needs and preferred learning style.
http://service.sap.com/bosap-support

Online customer support

The SAP Support Portal contains information about Customer Support programs and services. It also has links to
a wide range of technical information and downloads.
Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact
your customer support representative.
http://www.sap.com/services/bysubject/businessobjectscon
sulting

Consulting

Consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise
is available in topics such as relational and multidimensional
databases, connectivity, database design tools, and cus
tomized embedding technology.
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in control charts 191, 193
Alerts analytic
configuring 231
description 231
using 232
analytic
creating from an existing 45, 163
universe restrictions 289
analytic toolbox 24
analytics
adding to dashboards 26
and dashboards 25
binning display options 236
creating 43
creating in Dashboard Builder 44
creating in InfoView 44
data sources 45
display modes 41, 160
downloading 94
editing 46
filters 39
linking 47
linking from a goal, metric or universe query
analytic 49
linking to multiple documents 47
linking using variables 50
linking with nbPrompts 65
navigation list 31
removing 95
saving 95
saving as a document 96
scheduling the refresh 284
sending by email 93

analytics (continued)
single metric or goal 38
toolbar actions 27
viewer 31
visual data counts 263
auto-calculation in control charts 190

B
barometer gauge 106
based on a universe query 39
configuring 107
graph options 110
graph properties 108
links from 109
tooltips 105, 142
breakdown in control charts 187
Bubble Chart analytic
configuring 111
defining the data display 40
description 111
navigation options 115
OpenAnalytic variables 64

C
c chart
sample analytic 201, 202, 318, 319
sample chart 201, 318
calendar-based sampling 189
Centered Moving Average analytic
configuring 114
data exploration analytics 114
graph options 116
metric prompts 116
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Centered Moving Average analytic (continued)
navigation options 115
chart types
Interactive Metric Trend analytic 104
columns
Interactive Metric Trend analytic 104, 141
Metric List analytic 104, 141
Compound analytic
analytic toolbox 24
description 275
content linking
setting 34
Control Chart analytic 181
configuring 182
creating control charts 184
in dashboards 198
sample 201, 202, 318, 319
sample analytic 202, 203, 204, 320, 321,
322
sample analytics 203, 321
sample c chart 200, 201, 317, 318
samples 200, 316
troubleshooting control charts 195
control charts
as Control Chart analytics 181
breakdown values 197
center-line hugging 213
configuring limits 190
configuring the EWMA 186
configuring the EWMAo 186
creating in Process Analysis 184
data collection settings 187
decimals in charts 198
Desktop Intelligence sample 205, 322, 323
editing 184
ewma 216
ewmao target 217
from a Web Intelligence report 194
lag and interval samples 204, 322
named event 191
over-dispersion 222
panning 195
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control charts (continued)
printing 195
Process Analysis alerts 197
refreshing 199
run line 196
samples 200, 316
sampling 189
sampling list 196
scheduling a refresh 285
setting alarms 191, 193
setting control limits 190
setting specification limits 191
setting the chart type 185
setting the cumulative sum 187
setting the filter 188
setting the weighting factor 186
specification limits 199
systematic variation 226
time periods 199
troubleshooting 195, 198
troubleshooting chart lines 196
troubleshooting numbers 198
troubleshooting the graph 195
upward trend 227
using standardization with EWMA 186
western electric rules 229
zooming 195
corporate dashboards 13
Crystal Reports
in dashboards 28
cumulative sum
configuring in a control chart 187
Curve Fitting analytic 122
configuring 114
custom parameters 124
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
OpenAnalytic variables 64
s-shaped curves 123
simple trend curves 123
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cusum
sample analytic 201, 318
sample c chart 201, 318

D
dashboard and analytics
applications 292
dashboard builder
description 292
dashboard properties menu 25
dashboards 12
adding analytics 26
adding tabs and sub tabs 17
analytic toolbox 24
and analytics 25
content linking 34
control charts 198
copying 22
corporate 13
creating 14
Crystal Report options 28
customizing 15, 17
dashboard analytic display options 21
deleting 23
freeform layout mode 18
moving 22
My Dashboard 13
navigation list 31
personal 13
printing 13
properties menu 25
renaming 22
setting a content link 34
template layout mode 19
using the analytic toolbar 27
viewer 31
Web Intelligence report options 30
data collection
in control charts 187
data exploration analytics
configuring 114

data exploration analytics (continued)
description 114
metric prompts 116
data types
continuous 254
nominal 254
ordinal 254
Desktop Intelligence
sample analytic 169, 170, 171, 172, 173,
176, 177, 178, 179, 181, 300, 301, 302,
303, 304, 306, 307, 308, 310, 311
sample control chart 170, 304
sample deviation analytic 168, 169, 302,
303, 304
sample forecast analytic 180, 308
sample metric relationship analytic 176, 309
sample target analytic 180, 311
sample trend analytic 178, 306
detrended mean 245
display modes
analytics 41, 160
display options
binning 236

E
events
in control charts 191
ewma 216
EWMA
sample analytic 201, 202, 318, 319
setting 186
using with standardized control charts 186
ewmao 217

F
filters
for universe query analytics 39
in control charts 187, 188
Frequency Histogram analytic 117
configuring 114
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Frequency Histogram analytic (continued)
custom parameters 117
data exploration analytics 114
graph options 116
histogram case study 118
metric prompts 116
navigation options 115
OpenAnalytic variables 64

G
Gauge analytic 106
configuring 107
graph options 110
graph properties 108
links from 109
metric prompts 116
OpenAnalytic variables 62
tooltips 105, 142
Goal analytic
configuring 133
description 133
OpenAnalytic variance variables 53
Goal Subscriptions analytic
configuring 134
description 134
Goal-based Influencer Detail analytic 235
binning 236
configuring 236
display options 236
goals
status 252
graph metric types in Interactive Metric Trend
analytics 102
graph options
data exploration analytics 116
gauges 110
graph properties
gauges 108
Pareto Chart 155
Strategy Map analytics 158
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graphs
Interactive Metric Trend analytic 101, 106

I
iDocID 73
Individual List analytic 237
configuring 238
Individual Profiler analytic
description 261, 268
Influencer Detail analytic 238
binning 236
configuring 239
display options 236
Influencer Gains Chart analytic 239
configuring 240
Interactive Metric Trend analytic
chart types 104
configuring 97
customizing columns 104, 141
description 97
display mode 100
graph metric types 102
graph options 106
graphs and legends 101
linking 99
OpenAnalytic variables 60
tooltips 105, 142
view formats 100

K
Key Influencers analytic
configuring 243
description 241
OpenAnalytic variables 60

L
Lag Plot analytic 125
configuring 114
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Lag Plot analytic (continued)
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
OpenAnalytic variables 64
legends
Interactive Metric Trend analytic 101
limits
configuring in control charts 190
linking
analytics in dashboards 34
displaying in gauges a link Metric Tree
analytics 109
openDocument 66
to a document or analytic 49
to multiple documents 47
Local Regression Smoother analytic
configuring 114
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
lsC 78
lsM 79
lsR 80
lsS 81

M
Map analytic
configuring 136
configuring graph properties 138
description 135
navigation properties 139
OpenAnalytic variables 54
selecting universe objects 137
sliced metrics 137
time window 139
Membership analytic
choosing a set 151, 258
configuring 257

Membership analytic (continued)
description 259
OpenAnalytic variables 58
Metric Forecaster analytic
configuring 244
description 243
detrended mean 245
OpenAnalytic variables 60
Metric List analytic
configuring 140
customizing columns 104, 141
description 140
OpenAnalytic variables 55
tooltips 105, 142
metric prompts 116
Metric Tree analytic
box information fields 146
configuring 143
configuring the box title 144
configuring the graph properties 145
description 142
metric tree box explained 143
OpenAnalytic variables 57
Metric Trends analytic
sample trend analytic 271
metrics
based on multiple sets 260
scheduling refresh 282
set joiners 260
set leavers 260
set migrants 260
set overlapping 260
Metrics Overview analytic
choosing a set 151, 258
configuring 150
description 149
OpenAnalytic variables 57
metrics summary analytic 270
Migration analytic
choosing a set 151, 258
configuring 257
description 259
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Migration analytic (continued)
OpenAnalytic variables 62
sample analytic 264, 312
sample trend analytic 265, 312
Model Gains Chart analytic 246
configuring 246
optimize for cross-sell analysis 248
optimize for insight 247
optimize for scoring 247
regenerate on refresh 248
sample size 247
tips 247
using leverage sets 248
models
data types 254
scheduling a refresh 284
most volatile metric analytics
OpenAnalytic variables 58
Moving Average Smoother analytic
configuring 114
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
moving averages
MA exponentially weighted 130, 220, 335
MA linearly weighted 131, 220, 335
MA linearly weighted center 131, 221, 336
transformations 129, 130, 131, 218, 220,
221, 333, 335, 336
Multi-set Same Time Events analytic
choosing a set 151, 258
configuring 257
description 259

N
NAII 86
named events
in control charts 191
Navigation List analytic
in dashboards 31
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navigation options
bubble chart 115
data exploration analytics 115
pie chart 115
radar chart 115
nbPrompts 65
goal and metric-based analytics 65
Normal Probability Plot analytic 125
configuring 114
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
OpenAnalytic variables 64
used with histograms 118

O
OpenAnalytic 49
with the Viewer analytic 32, 92
OpenAnalytic variables
data exploration analytics 64
for linking analytics 50
gauges 62
goal variance 53
in goal, metric and universe query analytics
51
interactive metric trend analytic 60
key influencers analytic 60
map analytics 54
metric forecaster 60
metric list 55
metric overview 57
metric tree 57
migration analytic 62
pie, bubble and radar charts 64
speedometer 62
strategy map 55
volatile metrics and set membership 58
openDocument 66
in analytics 66
in dashboards 66
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openDocument (continued)
input parameters 77
output parameters 85
parameter overview 70
platform parameters 73
syntax 67

R

P
p chart
sample analytic 202, 319
Pareto analytic
OpenAnalytic variance variables 53
sample analytic 172, 300
Pareto Chart analytic
configuring 153
configuring with universe objects 154
description 151
graph properties 155
sliced metrics 137, 154
performance manager
description 292
Pie Chart analytic
configuring 112
defining the data display 40
description 112
metric prompts 116
navigation options 115
OpenAnalytic variables 64
predictive analysis
description 292
predictive models
selecting 234
process analysis
description 293
Profiler analytic
configuring 261
description 261, 268

Radar Chart analytic
configuring 113
defining the data display 40
description 113
navigation options 115
OpenAnalytic variables 64
Resistant Smoother analytic
configuring 114
data exploration analytics 114
graph options 116
metric prompts 116
navigation options 115
rules
alerts 232
in control charts 193

S
sampling
calendar-based 189
in control charts 187
systematic 189
time-based 189
scheduled tasks
adding 282
analytic refresh 284
control chart refresh 285
creating 285
deleting 282
deleting instances 281
emails to an inbox 288
instance information 282
instances 281
managing 280
metric refresh 282
predictive model refresh 284
schedule history 281
set refresh 283
setting the destination 287
viewing 280
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scheduler 280
selecting events 290
setting the default server 290
sDocName 74
Set analytics
individual portrait sample analytic 268
sample current member analytic 268
sample membership analytic 269
sample migration trend analytic 265, 312
sample scatter plot 265, 313
sample trend analytic 271
sample turnover analytic 267, 315
sample Web Intelligence queries 264, 311
Set Analytics
sample analytic 264, 265, 266, 269, 270,
271, 312, 313, 314, 315
sets
metrics based on 260
scheduling the refresh 283
sheduled tasks
run object schedules 286
sending personalized data 288
universe restrictions for personalized data
289
sIDType 75
sInstance 82
sKind 75
Smoothing analytic 126
Centered moving average 126
graph options 116
local regression smoother 127
metric prompts 116
moving average smoother 127
navigation options 115
OpenAnalytic variables 64
resistant smoother 127
Smoothing analytics 114
configuring 114
sOutputFormat 87
sPartContext 82
sPath 76
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specification limits
control charts 199
specification limits in control charts 191
speedometer gauge 106
based on a universe query 39
configuring 107
graph options 110
graph properties 108
links from 109
openanalytic variables 62
tooltips 105, 142
sRefresh 83
sReportMode 84
sReportName 84
sReportPart 85
Strategy Map analytic
box information fields 146
configuring 156
description 156
graph properties 158
linking items 159
OpenAnalytic variables 55
panning 160
text items 159
zooming 160
sType 77
sViewer 88
sWindow 89
syntax
openDocument 67
systematic sampling 189

T
Text analytic
description 276
thermometer gauge 106
based on a universe query 39
configuring 107
graph options 110
graph properties 108
links from 109
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thermometer gauge (continued)
tooltips 105, 142
time-based sampling 189
token 77
tooltips
Gauge analytic 105, 142
Interactive Metric Trend analytic 105, 142
Metric List analytic 105, 142
traffic light gauge 106
based on a universe query 39
configuring 107
graph options 110
graph properties 108
links from 109
tooltips 105, 142
troubleshooting
control chart alarms 197
control charts 195, 196, 197, 198, 199

U
universe queries 38
defining 39
definition 38
universe restrictions
applying 289

V
Variable Profile Box Plot analytic 248
configuring 249
Viewer analytic
description 32, 275
having information sent to 32, 92
using openAnalytic 32, 92
with navigation list 31
Visual Data Counts analytic
configuring 263
description 262

W
Web Intelligence
sample analytic 164, 165, 166, 167, 171,
172, 173, 174, 175, 176, 296, 297, 298,
299, 300, 301, 309
set snapshot analytic 165, 297
Web Intelligence queries
sample analytics 264, 311
Web Intelligence reports
in dashboards 30
Web Page analytic 277

X
Xcelsius analytics
setting a content link 34
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